
 
 

NIST SPECIAL PUBLICATION 1800-25 
 

Data Integrity 
Identifying and Protecting Assets 
Against Ransomware and Other 
Destructive Events 
 
 
 
Includes Executive Summary (A); Approach, Architecture, and Security Characteristics (B);  
and How-To Guides (C) 
 
 
 
 
Jennifer Cawthra 
Michael Ekstrom 
Lauren Lusty 
Julian Sexton 
John Sweetnam 
 
 
 
DRAFT 
 
This publication is available free of charge from https://www.nccoe.nist.gov/projects/building-
blocks/data-integrity/identify-protect. 
 
 
 
 
 

 

https://www.nccoe.nist.gov/projects/building-blocks/data-integrity/identify-protect
https://www.nccoe.nist.gov/projects/building-blocks/data-integrity/identify-protect


 
 

NIST SPECIAL PUBLICATION 1800-25 
 

Data Integrity: Identifying and Protecting Assets 
Against Ransomware and Other Destructive Events 

 
Includes Executive Summary (A); Approach, Architecture, and Security Characteristics (B); 

and How-To Guides (C) 
 
 
 
 

Jennifer Cawthra 
National Cybersecurity Center of Excellence 

NIST 
 

Michael Ekstrom 
Lauren Lusty 
Julian Sexton 

John Sweetnam 
The MITRE Corporation 

McLean, Virginia 
 
 

DRAFT 
 
 

January 2020 
 
 

 
 
 
 
 
 

U.S. Department of Commerce 
Wilbur Ross, Secretary 

 
National Institute of Standards and Technology 

Walter Copan, NIST Director and Undersecretary of Commerce for Standards and Technology 
 



 
 

NIST SPECIAL PUBLICATION 1800-25A 

Data Integrity 
Identifying and Protecting Assets Against Ransomware 
and Other Destructive Events 
 
 
Volume A: 
Executive Summary 
 
 
Jennifer Cawthra 
National Cybersecurity Center of Excellence 
NIST 
 
Michael Ekstrom 
Lauren Lusty 
Julian Sexton 
John Sweetnam 
Anne Townsend 
The MITRE Corporation 
McLean, Virginia 
 
 
January 2020 
 
 
DRAFT 
 
This publication is available free of charge from https://www.nccoe.nist.gov/projects/building-
blocks/data-integrity/identify-protect. 
 
 
 
 
 
 
 

 

https://www.nccoe.nist.gov/projects/building-blocks/data-integrity/identify-protect
https://www.nccoe.nist.gov/projects/building-blocks/data-integrity/identify-protect


DRAFT 

 
NIST SP 1800-25A: Data Integrity: Identifying and Protecting Assets Against Ransomware and Other Destructive Events   1 

Executive Summary 1 

The CIA triad represents the three pillars of information security: confidentiality, integrity, and 2 
availability, as follows: 3 

 Confidentiality – preserving authorized restrictions on 4 
information access and disclosure, including means for 5 
protecting personal privacy and proprietary 6 
information 7 

 Integrity — guarding against improper information 8 
modification or destruction and ensuring information 9 
non-repudiation and authenticity 10 

 Availability – ensuring timely and reliable access to and 11 
use of information 12 

This series of practice guides focuses on data integrity: the property that data has not been altered in an 13 
unauthorized manner. Data integrity covers data in storage, during processing, and while in transit. 14 
(Note: These definitions are from National Institute of Standards and Technology (NIST) Special 15 
Publication (SP) 800-12 Rev 1, An Introduction to Information Security.) 16 

 Destructive malware, ransomware, malicious insider activity, and even honest mistakes all set 17 
the stage for why organizations need to properly identify and protect against events that impact 18 
data integrity. Businesses must be confident that data is protected and safe.  19 

 Attacks against an organization’s data can compromise emails, 20 
employee records, financial records, and customer 21 
information—impacting business operations, revenue, and 22 
reputation.  23 

 Examples of data integrity attacks include unauthorized 24 
insertion, deletion, or modification of data to corporate 25 
information such as emails, employee records, financial 26 
records, and customer data. 27 

 The National Cybersecurity Center of Excellence (NCCoE) at the 28 
National Institute of Standards and Technology (NIST) built a 29 
laboratory environment to explore methods to effectively 30 
identify and protect against data integrity attacks in various 31 
information technology (IT) enterprise environments to prevent impacts to business operations.  32 

 This NIST Cybersecurity Practice Guide demonstrates how organizations can develop and 33 
implement appropriate actions before a detected data integrity cybersecurity event. 34 

CHALLENGE 35 

Some organizations have experienced systemic attacks that force operations to cease. One variant of a 36 
data integrity attack–ransomware–encrypts data, rendering it unusable. This type of impact to data 37 
affects business operations and often leads them to shut down. Other variants of data integrity attacks 38 
can steer organizations to make decisions that can impact the bottom line or execute ill-fated decisions. 39 

https://csrc.nist.gov/publications/detail/sp/800-12/rev-1/final
https://csrc.nist.gov/publications/detail/sp/800-12/rev-1/final
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For example, adversarial actors could create backdoor accounts in company login systems, change 40 
payroll information to their benefit, or expose the company with unsafe software updates for their own 41 
benefit. 42 

SOLUTION 43 

NIST published version 1.1 of the Cybersecurity Framework in April 2018 to provide guidance on 44 
protecting and developing resiliency for critical infrastructure and other sectors. The framework core 45 
contains five functions, listed below.  46 

 Identify – develop an organizational understanding 47 
to manage cybersecurity risk to systems, people, 48 
assets, data, and capabilities 49 

 Protect – develop and implement appropriate 50 
safeguards to ensure delivery of critical services  51 

 Detect – develop and implement appropriate 52 
activities to identify the occurrence of a 53 
cybersecurity event  54 

 Respond – develop and implement appropriate 55 
activities to take action regarding a detected 56 
cybersecurity incident 57 

 Recover – develop and implement appropriate 58 
activities to maintain plans for resilience and to restore any capabilities or services that were 59 
impaired due to a cybersecurity incident  60 

For more information, see the Framework for Improving Critical Infrastructure Cybersecurity.  61 

Applying the Cybersecurity Framework to data integrity, this practice guide informs organizations of 62 
how to identify and protect against a data integrity attack, and in turn understand how to manage data 63 
integrity risks and implement the appropriate safeguards.  64 

The NCCoE developed and implemented a solution that incorporates multiple systems working in 65 
concert to identify and protect against detected data integrity cybersecurity events. The solution 66 
isolates the opportunities that would allow for the cybersecurity events to occur and implements 67 
strategies to remediate the opportunities. Also, the solution applies additional protections from 68 
cybersecurity events to IT infrastructure. 69 

In developing this solution, the NCCoE sought existing technologies that provided the following 70 
capabilities: 71 

 backups 72 

 integrity monitoring 73 

 inventory 74 

 logging 75 

 maintenance 76 

https://nvlpubs.nist.gov/nistpubs/CSWP/NIST.CSWP.04162018.pdf
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 secure storage 77 

 vulnerability management  78 

While the NCCoE used a suite of commercial products to address this challenge, this guide does not 79 
endorse these particular products, nor does it guarantee compliance with any regulatory initiatives. Your 80 
organization’s information security experts should identify the products that will best integrate with 81 
your existing tools and IT system infrastructure. Your organization can adopt this solution or one that 82 
adheres to these guidelines in whole, or you can use this guide as a starting point for tailoring and 83 
implementing parts of a solution. 84 

BENEFITS  85 

This practice guide can help your organization:  86 

 develop a strategy for identifying and protecting against a data integrity cybersecurity event  87 

 facilitate comprehensive protection from adverse events to maintain operations and ensure the 88 
integrity of data critical to supporting business operations and revenue-generating activities  89 

 manage enterprise risk (consistent with foundations of the NIST Framework for Improving 90 
Critical Infrastructure Cybersecurity)  91 

SHARE YOUR FEEDBACK 92 

You can view or download the guide at https://www.nccoe.nist.gov/projects/building-blocks/data-93 
integrity/identify-protect. Help the NCCoE make this guide better by sharing your thoughts with us as 94 
you read the guide. If you adopt this solution for your own organization, please share your experience 95 
and advice with us. We recognize that technical solutions alone will not fully enable the benefits of our 96 
solution, so we encourage organizations to share lessons learned and best practices for transforming the 97 
processes associated with implementing this guide.  98 

To provide comments or to learn more by arranging a demonstration of this example implementation, 99 
contact the NCCoE at ds-nccoe@nist.gov.  100 

 

TECHNOLOGY PARTNERS/COLLABORATORS 101 

Organizations participating in this project submitted their capabilities in response to an open call in the 102 
Federal Register for all sources of relevant security capabilities from academia and industry (vendors 103 
and integrators). The following respondents with relevant capabilities or product components (identified 104 
as “Technology Partners/Collaborators” herein) signed a Cooperative Research and Development 105 
Agreement (CRADA) to collaborate with NIST in a consortium to build this example solution.  106 

 107 

Certain commercial entities, equipment, products, or materials may be identified by name or company 108 
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 109 
experimental procedure or concept adequately. Such identification is not intended to imply special 110 
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it 111 

https://www.nccoe.nist.gov/projects/building-blocks/data-integrity/identify-protect
https://www.nccoe.nist.gov/projects/building-blocks/data-integrity/identify-protect
mailto:ds-nccoe@nist.gov
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intended to imply that the entities, equipment, products, or materials are necessarily the best available 112 
for the purpose. 113 

  

  

The National Cybersecurity Center of Excellence (NCCoE), a part of the 
National Institute of Standards and Technology (NIST), is a 
collaborative hub where industry organizations, government 
agencies, and academic institutions work together to address 
businesses’ most pressing cybersecurity challenges. Through this 
collaboration, the NCCoE develops modular, easily adaptable example 
cybersecurity solutions demonstrating how to apply standards and 
best practices using commercially available technology. 

 LEARN MORE  
Visit https://www.nccoe.nist.gov  
nccoe@nist.gov  
301-975-0200 
 

 

https://www.nccoe.nist.gov/
mailto:nccoe@nist.gov
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DISCLAIMER 1 

Certain commercial entities, equipment, products, or materials may be identified by name or company 2 
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 3 
experimental procedure or concept adequately. Such identification is not intended to imply special sta-4 
tus or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it in-5 
tended to imply that the entities, equipment, products, or materials are necessarily the best available 6 
for the purpose. 7 

 

 

National Institute of Standards and Technology Special Publication 1800-25B, Natl. Inst. Stand. Technol. 8 
Spec. Publ. 1800-25B, 50 pages, (January 2020), CODEN: NSPUE2 9 

 

 

 

FEEDBACK 10 

You can improve this guide by contributing feedback. As you review and adopt this solution for your 11 
own organization, we ask you and your colleagues to share your experience and advice with us.  12 

Comments on this publication may be submitted to: ds-nccoe@nist.gov. 13 

Public comment period: January 27, 2020 through February 25, 2020 14 

All comments are subject to release under the Freedom of Information Act. 15 

 

 

 

National Cybersecurity Center of Excellence 16 
National Institute of Standards and Technology 17 

100 Bureau Drive 18 
Mailstop 2002 19 

Gaithersburg, MD 20899 20 
Email: nccoe@nist.gov   21 

mailto:ds-nccoe@nist.gov
mailto:nccoe@nist.gov
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 22 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 23 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 24 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 25 
public-private partnership enables the creation of practical cybersecurity solutions for specific 26 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 27 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 28 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 29 
NCCoE applies standards and best practices to develop modular, easily adaptable example cybersecurity 30 
solutions using commercially available technology. The NCCoE documents these example solutions in 31 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 32 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 33 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 34 
Maryland. 35 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 36 
https://www.nist.gov. 37 

NIST CYBERSECURITY PRACTICE GUIDES 38 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 39 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 40 
adoption of standards-based approaches to cybersecurity. They show members of the information 41 
security community how to implement example solutions that help them align more easily with relevant 42 
standards and best practices, and provide users with the materials lists, configuration files, and other 43 
information they need to implement a similar approach. 44 

The documents in this series describe example implementations of cybersecurity practices that 45 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 46 
or mandatory practices, nor do they carry statutory authority.  47 

ABSTRACT 48 

Ransomware, destructive malware, insider threats, and even honest user mistakes present ongoing 49 
threats to organizations. Organizations’ data, such as database records, system files, configurations, user 50 
files, applications, and customer data, are all potential targets of data corruption, modification, and 51 
destruction. Formulating a defense against these threats requires two things: a thorough knowledge of 52 
the assets within the enterprise, and the protection of these assets against the threat of data corruption 53 
and destruction. The NCCoE, in collaboration with members of the business community and vendors of 54 
cybersecurity solutions, has built an example solution to address these data integrity challenges. 55 

https://www.nccoe.nist.gov/
https://www.nist.gov/
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Multiple systems need to work together to identify and protect an organization’s assets against the 56 
threat of corruption, modification, and destruction. This project explores methods to effectively identify 57 
assets (devices, data, and applications) that may become targets of data integrity attacks, as well as the 58 
vulnerabilities in the organization’s system that facilitate these attacks. It also explores methods to 59 
protect these assets against data integrity attacks using backups, secure storage, integrity checking 60 
mechanisms, audit logs, vulnerability management, maintenance, and other potential solutions 61 

KEYWORDS 62 

attack vector; asset awareness; data integrity; data protection; malicious actor; malware; ransomware. 63 
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1 Summary 131 

Businesses face a near-constant threat of destructive malware, ransomware, malicious insider activities, 132 
and even honest mistakes that can alter or destroy critical data. These types of adverse events 133 
ultimately impact data integrity (DI). It is imperative for organizations to be able to identify assets that 134 
may be impacted by a DI attack and to protect their enterprise against such attacks. 135 

The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards and 136 
Technology (NIST) built a laboratory environment to explore methods to identify and protect assets 137 
from a data corruption event in various information technology (IT) enterprise environments. The 138 
example solution outlined in this guide describes the solution built in the NCCoE lab. It encourages 139 
identification of vulnerabilities and assets that may be present in the enterprise, as well as several 140 
protections that can significantly mitigate the effects of DI attacks before they occur. 141 

The goals of this NIST Cybersecurity Practice Guide are to help organizations confidently: 142 

 identify systems, users, data, applications, and entities on the network 143 

 identify vulnerabilities in enterprise components and clients 144 

 baseline the integrity and activity of enterprise systems, in preparation for an attack 145 

 create backups of enterprise data in advance of an attack 146 

 protect these backups and other potentially important data against alteration 147 

 manage enterprise health by assessing machine posture 148 

For ease of use, a short description of the different sections of this volume follows. 149 

 Section 1: Summary presents the challenge addressed by the NCCoE project, with an in-depth 150 
look at our approach, the architecture, and the security characteristics we used; the solution 151 
demonstrated to address the challenge; benefits of the solution; and technology partners that 152 
participated in building, demonstrating, and documenting the solution. The Summary also 153 
explains how to provide feedback on this guide. 154 

 Section 2: How to Use This Guide explains how readers—business decision makers, program 155 
managers, and IT professionals (e.g., systems administrators)—might use each volume of the 156 
guide. 157 

 Section 3: Approach offers a detailed treatment of the scope of the project and describes the 158 
assumptions on which the security platform development was based, the risk assessment that 159 
informed platform development, and the technologies and components that industry 160 
collaborators gave us to enable platform development. 161 

 Section 4: Architecture describes the usage scenarios supported by project security platforms, 162 
including Cybersecurity Framework [1] functions supported by each component contributed by 163 
our collaborators. 164 
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 Section 5: Security Characteristics Analysis provides details about the tools and techniques we 165 
used to perform risk assessments. 166 

 Section 6: Future Build Considerations is a brief treatment of other Data Security 167 
implementations NIST considers consistent with Framework Core Functions: Identify, Protect, 168 
Detect and Respond, and Recovery. 169 

1.1 Challenge 170 

Thorough collection of quantitative and qualitative data is important to organizations of all types and 171 
sizes. It can impact all aspects of a business, including decision-making, transactions, research, 172 
performance, and profitability. When these data collections sustain a DI attack caused by unauthorized 173 
insertion, deletion, or modification of information, the attack can affect emails, employee records, 174 
financial records, and customer data, rendering them unusable or unreliable. Some organizations have 175 
experienced systemic attacks that caused a temporary cessation of operations. One variant of a DI 176 
attack—ransomware—encrypts data and holds it hostage while the attacker demands payment for the 177 
decryption keys. 178 

Before DI events occur, organizations should identify their assets and vulnerabilities and have defenses 179 
and preparations in place to preemptively mitigate the events. This reduces the workload of actions to 180 
take during and after an attack occurs, as well as the enterprise’s data loss and number of successful 181 
attacks.  182 

1.2 Solution 183 

The NCCoE implemented a solution that incorporates appropriate actions before the start of a DI event. 184 
The solution comprises systems working together to identify and protect assets against a data 185 
corruption event in standard enterprise components. These components include mail servers, 186 
databases, end user machines, virtual infrastructure, and file share servers. Essential to protection of 187 
assets is understanding of what those assets are and what vulnerabilities they have. 188 

The NCCoE sought existing technologies that provided the following capabilities: 189 

 Inventory 190 

 Policy Enforcement 191 

 Logging 192 

 Backups 193 

 Vulnerability Management 194 

 Secure Storage 195 

 Integrity Monitoring 196 
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In developing our solution, we used standards and guidance from the following sources, which can also 197 
provide your organization with relevant standards and best practices: 198 

 NIST Framework for Improving Critical Infrastructure Cybersecurity (commonly known as the 199 
NIST Cybersecurity Framework) [1] 200 

 NIST Interagency or Internal Report (NISTIR) 8050: Executive Technical Workshop on Improving 201 
Cybersecurity and Consumer Privacy [2] 202 

 NIST Special Publication (SP) 800-30 Rev. 1: Guide for Conducting Risk Assessments [3] 203 

 NIST SP 800-37 Rev. 1: Guide for Applying the Risk Management Framework to Federal 204 
Information Systems: A Security Life Cycle Approach [4] 205 

 NIST SP 800-39: Managing Information Security Risk [5] 206 

 NIST SP 800-40 Rev. 3: Guide to Enterprise Patch Management Technologies [6] 207 

 NIST SP 800-53 Rev. 4: Security and Privacy Controls for Federal Information Systems and 208 
Organizations [7] 209 

 Federal Information Processing Standard 140-3: Security Requirements for Cryptographic 210 
Modules [8] 211 

 NIST SP 800-86: Guide to Integrating Forensic Techniques into Incident Response [9] 212 

 NIST SP 800-92: Guide to Computer Security Log Management [10] 213 

 NIST SP 800-100: Information Security Handbook: A Guide for Managers [11] 214 

 NIST SP 800-34 Rev. 1: Contingency Planning Guide for Federal Information Systems [12] 215 

 Office of Management and Budget, Circular Number A-130: Managing Information as a Strategic 216 
Resource [13] 217 

 NIST SP 800-61 Rev. 2: Computer Security Incident Handling Guide [14] 218 

 NIST SP 800-83 Rev. 1: Guide to Malware Incident Prevention and Handling for Desktops and 219 
Laptops [15] 220 

 NIST SP 800-150: Guide to Cyber Threat Information Sharing [16] 221 

 NIST SP 800-184: Guide for Cybersecurity Event Recovery [17] 222 

1.3 Benefits 223 

The NCCoE’s practice guide can help your organization: 224 

 develop a plan for identifying assets and vulnerabilities and protecting these assets from a 225 
cybersecurity event 226 

 facilitate easier detection, response, and recovery from a DI event by collecting information 227 
about the enterprise before an attack occurs 228 
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 maintain integrity and availability of data critical to supporting business operations and 229 
revenue-generating activities 230 

 manage enterprise risk (consistent with the foundations of the NIST Cybersecurity Framework) 231 

2 How to Use This Guide 232 

This NIST Cybersecurity Practice Guide demonstrates a standards-based reference design and provides 233 
users with the information they need to replicate the DI identify-and-protect solution. This reference 234 
design is modular and can be deployed in whole or in part. 235 

This guide contains three volumes: 236 

 NIST SP 1800-25A: Executive Summary 237 

 NIST SP 1800-25B: Approach, Architecture, and Security Characteristics – what we built and why 238 
(you are here) 239 

 NIST SP 1800-25C: How-To Guides – instructions for building the example solution 240 

Depending on your role in your organization, you might use this guide in different ways: 241 

Business decision makers, including chief security and technology officers, will be interested in the 242 
Executive Summary, NIST SP 1800-25A, which describes the following topics: 243 

 challenges that enterprises face in identifying assets and protecting them from DI events 244 

 example solution built at the NCCoE 245 

 benefits of adopting the example solution 246 

Technology or security program managers who are concerned with how to identify, understand, assess, 247 
and mitigate risk will be interested in this part of the guide, NIST SP 1800-25B, which describes what we 248 
did and why. The following sections will be of particular interest: 249 

 Section 3.4.1, Risk, provides a description of the risk analysis we performed. 250 

 Section 3.4.2, Security Control Map, maps the security characteristics of this example solution to 251 
cybersecurity standards and best practices. 252 

You might share the Executive Summary, NIST SP 1800-25A, with your leadership team members to help 253 
them understand the importance of adopting a standards-based solution to identify and protect assets 254 
from DI attacks. 255 

IT professionals who want to implement such an approach will find the whole practice guide useful. You 256 
can use the how-to portion of the guide, NIST SP 1800-25C, to replicate all or parts of the build created 257 
in our lab. The how-to portion of the guide provides specific product installation, configuration, and 258 
integration instructions for implementing the example solution. We do not re-create the product 259 



DRAFT 

NIST SP 1800-25B: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 5 

 

manufacturers’ documentation, which is generally widely available. Rather, we show how we 260 
incorporated the products together in our environment to create an example solution. 261 

This guide assumes that IT professionals have experience implementing security products within the 262 
enterprise. While we have used a suite of commercial products to address this challenge, this guide does 263 
not endorse these particular products. Your organization can adopt this solution or one that adheres to 264 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 265 
parts of a DI identify-and-protect solution. Your organization’s security experts should identify the 266 
products that will best integrate with your existing tools and IT system infrastructure. We hope you will 267 
seek products that are congruent with applicable standards and best practices. Section 3.5, 268 
Technologies, lists the products we used and maps them to the cybersecurity controls provided by this 269 
reference solution. 270 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 271 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 272 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to ds-273 
nccoe@nist.gov. 274 

Acronyms used in figures can be found in the Acronyms appendix. 275 

2.1 Typographic Conventions 276 

The following table presents typographic conventions used in this volume. 277 

Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For language use and style guidance, 
see the NCCoE Style Guide. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, 
onscreen computer output, 
sample code examples, and 
status codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

mailto:ds-nccoe@nist.gov
mailto:ds-nccoe@nist.gov
https://www.nccoe.nist.gov/
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3 Approach 278 

Based on key points expressed in NISTIR 8050, Executive Technical Workshop on Improving Cybersecurity 279 
and Consumer Privacy (2015), the NCCoE is pursuing a series of DI projects to map the Core Functions of 280 
the NIST Cybersecurity Framework. This project is centered on the Core Functions of Identify and 281 
Protect, which consist of identifying and protecting assets from DI attacks. For instance, the first step in 282 
building a strategy requires an organization to inventory its assets. This involves identifying systems, 283 
applications, data sources, users, and other relevant entities that may be targets or facilitators of DI 284 
attacks. Once this exercise is complete, an organization can then create a customized strategy to protect 285 
the identified assets against the possibility of data corruption, modification, and destruction. NCCoE 286 
engineers working with a community of interest (COI) defined the requirements for this DI project.  287 

Members of the COI, which include participating vendors referenced in this document, contributed to 288 
development of the architecture and reference design, providing technologies that meet the project 289 
requirements and assisting in installation and configuration of those technologies. The practice guide 290 
highlights the approach used to develop the NCCoE reference solution. Elements include risk assessment 291 
and analysis, logical design, build development, test and evaluation, and security control mapping. This 292 
guide aims to provide practical guidance to any organization interested in implementing a solution for 293 
identifying and protecting assets against a cybersecurity event. 294 

3.1 Audience 295 

This guide is intended for individuals responsible for implementing security solutions in organizations’ IT 296 
support activities. Current IT systems, particularly in the private sector, often lack the ability to 297 
comprehensively identify enterprise assets that need protection from integrity attacks, as well as the 298 
protections themselves. The platforms demonstrated by this project, and the implementation 299 
information provided in these practice guides, permit integration of products to implement a data 300 
identification and protection system. The technical components will appeal to system administrators, IT 301 
managers, IT security managers, and others directly involved in the secure and safe operation of 302 
business IT networks. 303 

3.2 Scope 304 

The guide provides practical, real-world guidance on developing and implementing a DI solution 305 
consistent with the principles in the NIST Framework for Improving Critical Infrastructure Cybersecurity, 306 
Volume 1 [1], specifically the Core Functions of Identify and Protect. The Identify Function emphasizes 307 
the development and implementation of the appropriate activities to discover and manage an 308 
organization’s assets, services, and the threats to these assets and services. The Protect Function 309 
emphasizes development and implementation of activities that protect these assets and services from 310 
cybersecurity events. Examples of outcomes within these Functions include asset inventory, logging, 311 
backups, vulnerability management, policy enforcement, and file/system integrity management. 312 
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3.3 Assumptions 313 

This project is guided by the following assumptions: 314 

 The solution was developed in a lab environment. The environment is based on a generic 315 
organization’s IT enterprise—it uses services found commonly across typical enterprises, such as 316 
a database, a domain controller, a mail/web server, etc. It does not reflect the complexity of a 317 
production environment, for example, building across numerous physical locations, 318 
accommodating for extreme working conditions, or configuring systems to meet specific 319 
network/user needs. These demands can all increase the level of complexity needed to 320 
implement a DI solution. 321 

 An organization has access to the skills and resources required to implement an asset 322 
identification and protection system. 323 

 An organization is seeking to preemptively mitigate the damage a DI event would cause.  324 

3.4 Risk Assessment 325 

NIST SP 800-30 Revision 1, Guide for Conducting Risk Assessments states that risk is “a measure of the 326 
extent to which an entity is threatened by a potential circumstance or event, and typically a function of: 327 
(i) the adverse impacts that would arise if the circumstance or event occurs; and (ii) the likelihood of 328 
occurrence.” The guide further defines risk assessment as “the process of identifying, estimating, and 329 
prioritizing risks to organizational operations (including mission, functions, image, reputation), 330 
organizational assets, individuals, other organizations, and the Nation, resulting from the operation of 331 
an information system. Part of risk management incorporates threat and vulnerability analyses, and 332 
considers mitigations provided by security controls planned or in place.” 333 

The NCCoE recommends that any discussion of risk management, particularly at the enterprise level, 334 
begins with a comprehensive review of NIST SP 800-37 Revision 2, Risk Management Framework for 335 
Information Systems and Organizations—material available to the public. The Risk Management 336 
Framework (RMF) guidance, as a whole, proved to be invaluable in giving us a baseline to assess risks, 337 
from which we developed the project, the security characteristics of the build, and this guide. 338 

We performed two types of risk assessments: 339 

 Initial analysis of the risk factors discussed with financial, retail, and hospitality institutions: this 340 
analysis led to creation of the DI project and desired security posture. See NISTIR 8050, 341 
Executive Technical Workshop on Improving Cybersecurity and Consumer Privacy, for additional 342 
participant information. 343 

 Analysis of how to secure the components within the solution and minimize any vulnerabilities 344 
they might introduce: see Section 5, Security Characteristic Analysis. 345 

https://nvlpubs.nist.gov/nistpubs/Legacy/SP/nistspecialpublication800-30r1.pdf
https://nvlpubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-37r2.pdf
https://nvlpubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-37r2.pdf
http://csrc.nist.gov/groups/SMA/fisma/Risk-Management-Framework/
http://csrc.nist.gov/groups/SMA/fisma/Risk-Management-Framework/
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3.4.1 Risk 346 

Using the guidance in NIST’s series of publications concerning risk, we worked with financial institutions 347 
and the Financial Sector Information Sharing and Analysis Center to identify the most compelling risk 348 
factors encountered by this business group. We participated in conferences and met with members of 349 
the financial sector to define the main security risks to business operations. From these discussions 350 
came identification of an area of concern—DI. We produced the practice guide Data Integrity: 351 
Recovering from Ransomware and Other Destructive Events, which primarily focused on the recovery 352 
aspect of DI. From responses to the recovery project, we also identified a need for guidance in 353 
identifying and protecting assets from DI attacks. 354 

When considering risk from the perspective of identifying and protecting assets prior to a cybersecurity 355 
event, we must consider not only the impact of an event on an organization’s assets but also the threats 356 
to those assets and the potential vulnerabilities these threats could exploit. 357 

When discussing threats to an organization's assets from the perspective of DI, we consider the 358 
following factors: 359 

 malware 360 

 insider threats 361 

 accidents caused by human error 362 

 compromise of trusted systems 363 

Types of vulnerabilities we consider in relation to these threats are: 364 

 zero-day vulnerabilities 365 

 vulnerabilities due to outdated or unpatched systems 366 

 custom software vulnerabilities/errors 367 

 social engineering and user-driven events 368 

 poor access control 369 

Finally, we consider the potential impact on an organization from a DI event: 370 

 systems incapacitated 371 

 modification/deletion of organization’s assets 372 

 negative impact on the organization’s reputation 373 

Analyses of the threats, vulnerabilities, and potential impact to an organization give us an understanding 374 
of the risk to an organization with respect to DI. NIST SP 800-39, Managing Information Security Risk, 375 
focuses on the business aspect of risk, namely at the enterprise level. This understanding is essential for 376 
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any further risk analysis, risk response/mitigation, and risk monitoring activities. The following summary 377 
lists the strategic risk areas we identified and their mitigations: 378 

 Impact on system function: ensuring the availability of accurate data or sustaining an acceptable 379 
level of DI reduces the risk of systems’ availability being compromised. 380 

 Cost of implementation: implementing asset identification and protection from DI events once 381 
and using it across all systems may reduce system continuity costs. 382 

 Compliance with existing industry standards contributes to the industry requirement to 383 
maintain a continuity of operations plan. 384 

 Maintenance of reputation and public image helps reduce level and likelihood of impact as well 385 
as facilitates the information required for impact reduction.  386 

 Increased focus on DI includes not just loss of confidentiality but also harm from unauthorized 387 
alteration of data (per NISTIR 8050). 388 

We subsequently translated the risk factors identified to security Functions and Subcategories within 389 
the NIST Cybersecurity Framework. In Table 3-1, we mapped the categories to NIST SP 800-53 Rev. 4 390 
controls. 391 

3.4.2 Security Control Map 392 

As explained in Section 3.4.1, we identified the Cybersecurity Framework Functions and Subcategories 393 
that we wanted the reference design to support, through a risk analysis process. This was a critical first 394 
step in designing the reference design and example implementation to mitigate the risk factors. Table 3-395 
1 lists the addressed Cybersecurity Framework Functions and Subcategories and maps them to relevant 396 
NIST standards, industry standards, and controls and best practices. The references provide solution 397 
validation points in that they list specific security capabilities that a solution addressing the 398 
Cybersecurity Framework Subcategories would be expected to exhibit. Organizations can use Table 3-1 399 
to identify the Cybersecurity Framework Subcategories and NIST SP 800-53 Rev. 4 controls they are 400 
interested in addressing. 401 

When cross-referencing Functions of the Cybersecurity Framework with product capabilities used in this 402 
practice guide, it is important to consider: 403 

 This practice guide, though primarily focused on Identify/Protect Functions also uses DE.CM-8 404 
and RS.MI-3, Detect and Respond Subcategories respectively. This is primarily because these 405 
two Subcategories deal with vulnerability discovery and mitigation, which are techniques used 406 
to prevent future damage and are not as useful for preventing attacks previously exploited a 407 
given vulnerability. Often, it is unlikely that an organization will be able to resolve a newly 408 
discovered vulnerability during an attack; for attacks where patches are available, it can be 409 
dangerous to allow updates on a compromised system. 410 
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 Not all the guidance of Cybersecurity Framework Subcategories can be implemented using 411 
technology. Any organization executing a DI solution would need to adopt processes and 412 
organizational policies that support the reference design. For example, some of the 413 
Subcategories within the Cybersecurity Framework Function known as Identify are processes 414 
and policies that should be developed prior to implementing recommendations. 415 

Table 3-1 DI Reference Design Cybersecurity Framework Core Components Map 416 

Cybersecurity Framework v1.1 Standards and Best Practices 

Func-
tion Category Subcategory NIST SP 800-

53 R4 
ISO/IEC 
27001:2013 

NIST SP 800-
181 

IDEN-
TIFY (ID) 

Asset Man-
agement 
(ID.AM) 

ID.AM-1: Physical devices 
and systems within the or-
ganization are inventoried. 

CM-8, PM-5 A.8.1.1, 
A.8.1.2 OM-STS-001 

ID.AM-2: Software plat-
forms and applications 
within the organization are 
inventoried. 

CM-8, PM-5 
A.8.1.1, 
A.8.1.2, 
A.12.5.1 

OM-STS-001 

Risk Assess-
ment 
(ID.RA) 

ID.RA-1: Asset vulnerabili-
ties are identified and doc-
umented. 

CA-2, CA-7, 
CA-8, RA-3, 
RA-5, SA-5, SA-
11, SI-2, SI-4, 
SI-5 

A.12.6.1, 
A.18.2.3 PR-VAM-001 

ID.RA-2: Cyber threat intel-
ligence is received from in-
formation sharing forums 
and sources.  

SI-5, PM-15, 
PM-16 A.6.1.4 CO-OPL-002 

ID.RA-5: Threats, vulnera-
bilities, likelihoods, and 
impacts are used to deter-
mine risk. 

RA-2, RA-3, 
PM-16 A.12.6.1 SP-SYS-001 
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Cybersecurity Framework v1.1 Standards and Best Practices 

Func-
tion Category Subcategory NIST SP 800-

53 R4 
ISO/IEC 
27001:2013 

NIST SP 800-
181 

PRO-
TECT 
(PR) 

Access 
Control 
(PR.AC) 

PR.AC-1: Identities and 
credentials are issued, 
managed, verified, re-
voked, and audited for au-
thorized devices, users, 
and processes. 

AC-1, AC-2, IA-
1, IA-2, IA-3, 
IA-4, IA-5, IA-
6, IA-7, IA-8, 
IA-9, IA-10, IA-
11 

A.9.2.1, 
A.9.2.2, 
A.9.2.3, 
A.9.2.4, 
A.9.2.6, 
A.9.3.1, 
A.9.4.2, 
A.9.4.3 

SP-DEV-001, 
OV-PMA-003 

PR.AC-3: Remote access is 
managed. 

AC-1, AC-17, 
AC-19, AC-20, 
SC-15 

A.6.2.1, 
A.6.2.2, 
A.11.2.6, 
A.13.1.1, 
A.13.2.1 

SP-SYS-001, 
OM-ADM-
001 

PR.AC-4: Access permis-
sions and authorizations 
are managed, incorporat-
ing the principles of least 
privilege and separation of 
duties. 

AC-1, AC-2, 
AC-3, AC-5, 
AC-6, AC-14, 
AC-16, AC-24 

A.6.1.2, 
A.9.1.2, 
A.9.2.3, 
A.9.4.1, 
A.9.4.4, 
A.9.4.5 

OM-STS-001 

PR.AC-5: Network integrity 
is protected (e.g., network 
segregation, network seg-
mentation). 

AC-4, AC-10, 
SC-7 

A.13.1.1, 
A.13.1.3, 
A.13.2.1, 
A.14.1.2, 
A.14.1.3 

OM-NET-001 

Data Secu-
rity (PR.DS) 

PR.DS-1: Data-at-rest is 
protected. 

MP-8, SC-12, 
SC-28 A.8.2.3 OM-DTA-002 

PR.DS-2: Data-in-transit is 
protected. 

SC-8, SC-11, 
SC-12 

A.8.2.3, 
A.13.1.1, 
A.13.2.1, 
A.13.2.3, 
A.14.1.2, 
A.14.1.3 

OM-DTA-
002, PR-
CDA-001 
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Cybersecurity Framework v1.1 Standards and Best Practices 

Func-
tion Category Subcategory NIST SP 800-

53 R4 
ISO/IEC 
27001:2013 

NIST SP 800-
181 

PR.DS-6: Integrity checking 
mechanisms are used to 
verify software, firmware, 
and information integrity. 

SC-16, SI-7 

A.12.2.1, 
A.12.5.1, 
A.14.1.2, 
A.14.1.3, 
A.14.2.4 

OM-DTA-001 

Infor-
mation 
Protection 
Processes 
and Proce-
dures 
(PR.IP) 

PR.IP-1: A baseline config-
uration of information 
technology/industrial con-
trol systems is created and 
maintained, incorporating 
security principles (e.g., 
concept of least function-
ality). 

CM-2, CM-3, 
CM-4, CM-5, 
CM-6, CM-7, 
CM-9, SA-10 

A.12.1.2, 
A.12.5.1, 
A.12.6.2, 
A.14.2.2, 
A.14.2.3, 
A.14.2.4 

SP-ARC-001 

PR.IP-3: Configuration 
change control processes 
are in place. 

CM-3, CM-4, 
SA-10 

A.12.1.2, 
A.12.5.1, 
A.12.6.2, 
A.14.2.2, 
A.14.2.3, 
A.14.2.4 

SP-DEV-001, 
OM-ANA-
001 

PR.IP-4: Backups of infor-
mation are conducted, 
maintained, and tested.  

CP-4, CP-6, CP-
9 

A.12.3.1, 
A.17.1.2, 
A.17.1.3, 
A.18.1.3 

SP-SYS-001 

PR.IP-9: Response plans 
(Incident Response and 
Business Continuity) and 
recovery plans (Incident 
Recovery and Disaster Re-
covery) are in place and 
managed. 

CP-2, CP-7, CP-
12, CP-13, IR-
7, IR-8, IR-9, 
PE-17 

A.16.1.1, 
A.17.1.1, 
A.17.1.2, 
A.17.1.3 

PR-CIR-001 

PR.IP-10: Response and re-
covery plans are tested. 

CP-4, IR-3, 
PM-14 A.17.1.3 SP-SYS-001 
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Cybersecurity Framework v1.1 Standards and Best Practices 

Func-
tion Category Subcategory NIST SP 800-

53 R4 
ISO/IEC 
27001:2013 

NIST SP 800-
181 

PR.IP-12: A vulnerability 
management plan is devel-
oped and implemented. 

RA-3, RA-5, SI-
2 

A.12.6.1, 
A.14.2.3, 
A.16.1.3, 
A.18.2.2, 
A.18.2.3 

SP-RSK-002 

Mainte-
nance 
(PR.MA) 

PR.MA-1: Maintenance 
and repair of organiza-
tional assets are per-
formed and logged, with 
approved and controlled 
tools. 

MA-2, MA-3, 
MA-5, MA-6 

A.11.1.2, 
A.11.2.4, 
A.11.2.5, 
A.11.2.6 

OM-ADM-
001 

PR.MA-2: Remote mainte-
nance of organizational as-
sets is approved, logged, 
and performed in a man-
ner that prevents unau-
thorized access. 

MA-4 
A.11.2.4, 
A.15.1.1, 
A.15.2.1 

SP-TRD-001 

Protective 
Technology 
(PR.PT) 

PR.PT-1: Audit/log records 
are determined, docu-
mented, implemented, 
and reviewed in accord-
ance with policy. 

AU Family 

A.12.4.1, 
A.12.4.2, 
A.12.4.3, 
A.12.4.4, 
A.12.7.1 

OV-LGA-002 

PR.PT-3: The principle of 
least functionality is incor-
porated by configuring sys-
tems to provide only es-
sential capabilities. 

AC-3, CM-7 A.9.1.2 
PR-CDA-001, 
OM-ANA-
001 
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Cybersecurity Framework v1.1 Standards and Best Practices 

Func-
tion Category Subcategory NIST SP 800-

53 R4 
ISO/IEC 
27001:2013 

NIST SP 800-
181 

PR.PT-4: Communications 
and control networks are 
protected. 

AC-4, AC-17, 
AC-18, CP-8, 
SC-7, SC-19, 
SC-20, SC-21, 
SC-22, SC-23, 
SC-24, SC-25, 
SC-29, SC-32, 
SC-36, SC-37, 
SC-38, SC-39, 
SC-40, SC-41, 
SC-43 

A.13.1.1, 
A.13.2.1, 
A.14.1.3 

SP-ARC-002 

DETECT 
(DE) 

Security 
Continuous 
Monitoring 
(DE.CM) 

DE.CM-8: Vulnerability 
scans are performed. RA-5 A.12.6.1 SP-TRD-001 

RE-
SPOND 
(RS) 

Mitigation 
(RS.MI) 

RS.MI-3: Newly identified 
vulnerabilities are miti-
gated or documented as 
accepted risks. 

CA-7, RA-3, 
RA-5 A.12.6.1 PR-CIR-001 

3.5 Technologies 417 

Table 3-2 lists all the technologies used in this project and provides a mapping among the generic 418 
application term, the specific product used, and the security control(s) the product provides. Refer to 419 
Table 3-1 for an explanation of the NIST Cybersecurity Framework Subcategory codes. 420 

Please note that PR.AC-4 is not included in this table. Access controls are detailed more thoroughly in 421 
other NCCoE practice guides [18], [19]. For the purposes of this practice guide, we assume a minimal 422 
Active Directory setup with an administrator and several users. 423 
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Table 3-2 Products and Technologies 424 

Component Product Function Cybersecurity Frame-
work Subcategories 

Inventory Cisco ISE v2.4 • Identification and status information for users 
• Identification and status information for devices 
• Identification and status information for software 
• Identification and status information for data assets 

ID.AM-1, ID.AM-2, 
PR.AC-1, PR.PT-2 Symantec Data Loss Pre-

vention (DLP) v15.1 

Vulnerability 
Management 

Tripwire IP360 v9.0.1 • Identification for vulnerabilities on various systems in the enter-
prise 

• An interface for managing/prioritizing vulnerabilities, based on 
organizational needs 

ID.RA-1, ID.RA-5, 
PR.IP-12, DE.CM-8, 
RS.MI-3 

Policy En-
forcement 

Cisco ISE v2.4 • Enforce machine posture across an enterprise 
• Quarantine machines that do not comply with organizational 

policy 

ID.RA-1, PR.AC-3, 
PR.MA-1, PR.MA-2, 
RS.MI-3 

Integrity 
Monitoring 

Tripwire Enterprise v8.7 • Baselines integrity activity for data 
• Baselines integrity activity for Active Directory 
• Provides file hashes and integrity baselines for files and soft-

ware, regardless of file type 

PR.DS-6, PR.IP-3, 
PR.PT-1 Semperis Directory Ser-

vices Protector (DSP) 
v2.7 

Logging Micro Focus ArcSight 
Enterprise Security 
Manager (ESM) v7.0 
Patch 2 

• Provides auditing and logging capabilities configurable to corpo-
rate policy 

• Provides logs of baseline network operations 

PR.IP-1, PR.IP-3, 
PR.PT-1 
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Component Product Function Cybersecurity Frame-
work Subcategories 

Tripwire Log Center 
v7.3.1 

• Provides logs of database activity and database backup opera-
tions 

• Provides logs of integrity changes 
• Provides logs of some user activity of monitored systems 

Backups Semperis Active Direc-
tory Forest Recovery 
(ADFR) v2.5 

• Backs up Active Directory information 
• Backs up systems 
• Backs up configurations 
• Backs up organizational data 

PR.DS-1, PR.IP-3, 
PR.IP-4, PR.IP-9, 
PR.IP-10 

FileZilla v0.9.60.2 OPEN 
SOURCE 

Duplicati v2.0.3.3 OPEN 
SOURCE 

Secure Stor-
age 

GreenTec WORMdisk 
v151228 

• Provides immutable storage 
• Provides configurable prevention of backup modification 

PR.DS-1, PR.IP-4 

Network Pro-
tection 

CryptoniteNXT v2.9.1 • Prevents unapproved network communication 
• Prevents malicious reconnaissance 
• Quarantines unauthorized machines on the network 

ID.AM-1, PR.AC-1, 
PR.AC-3, PR.AC-5, 
PR.DS-2, PR.PT-4 

Blacklisting Cisco Web Security Ap-
pliance v10.1 

• Provides capability to blacklist websites 
• Provides capability to blacklist communication with malicious or 

disallowed IP addresses 

PR.AC-3, PR.AC-5, 
PR.DS-2, PR.PT-4 
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4 Architecture 425 

This section presents the high-level architecture used for implementation of a DI solution that identifies 426 
and protects assets from ransomware and other destructive events.  427 

4.1 Architecture Description 428 

4.1.1 High-Level Architecture 429 
The DI solution is designed to address the security Functions and Subcategories described in Table 3-1 430 
and is composed of the capabilities illustrated in Figure 4-1. 431 

Figure 4-1 DI Identify and Protect High-Level Architecture 432 

 

 Inventory allows discovering and keeping track of devices connected to the enterprise. 433 

 Vulnerability Management provides a mechanism for analyzing various system and network 434 
components, for a better understanding of resolved and unresolved vulnerabilities in the 435 
enterprise. 436 

 Policy Enforcement uses feedback from logs and vulnerability management to target machines 437 
with unresolved vulnerabilities and maintain overall enterprise health. 438 
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 Integrity Monitoring establishes baselines of file/system integrity. 439 

 Logging records and stores all the log files produced by the components within the enterprise. 440 

 Backups allow components within the enterprise to produce backups. 441 

 Secure Storage allows data storage with additional data protection measures, such as Write 442 
Once Read Many (WORM) technologies. Data encryption can also be used, but this will not 443 
inherently protect data against corruption. 444 

 Network Protection can defend an enterprise network against both intrusion and lateral 445 
movement of malicious actors and programs.  446 

 Blacklisting can filter allowed programs or network communications. Often, this may be 447 
provided in the form of a firewall or even a white list, but products exist that allow finer-grained 448 
control over these filters. 449 

These capabilities work together to provide the Functions of Identify and Protect for the reference 450 
architecture. The Inventory capability allows accurate and complete discovery and status reporting of all 451 
network assets. The Inventory capability feeds into Vulnerability Management, which analyzes the 452 
assets and network for vulnerabilities. Vulnerability Management feeds its information into Logging, 453 
which aggregates and collects logs from various sources for use as a baseline of normal system 454 
operations. Policy Enforcement uses information from Logging and Vulnerability Management, to repair 455 
vulnerabilities found in the enterprise and maintain the system with up-to-date patches. Integrity 456 
Monitoring records normal file/system integrity information to be used as a baseline in the event of an 457 
attack and forwards this information to the Logging capability as part of the organization’s baseline. 458 
Backups create periodic backups of organizational data to be used in a cybersecurity event. Secure 459 
Storage allows storing files—such as backups, gold images, logs, or configuration files—in a format that 460 
cannot be corrupted, because files cannot be altered or changed while in storage. 461 

4.1.2 Architecture Components 462 

4.1.2.1 Inventory 463 

The Inventory capability allows discovering and visualizing the enterprise’s network as well as the 464 
present network devices. This component also informs the other components in the enterprise, 465 
providing information such as what systems to monitor, back up, and scan for vulnerabilities. This 466 
component provides the basic knowledge of what assets there are to protect. 467 

For the Inventory capability, we use a combination of two products: Cisco ISE and Symantec DLP. Cisco 468 
ISE provides inventory capabilities for machines, devices, and users on its network and can use that 469 
information in tandem with other capabilities. Symantec DLP provides data asset inventory, allowing 470 
organizations to identify potentially sensitive data. 471 
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4.1.2.2 Vulnerability Management 472 

The Vulnerability Management capability allows scanning and managing vulnerabilities across the 473 
enterprise. It provides a priority system for these vulnerabilities, as well as logs on existing 474 
vulnerabilities and potentially resolved vulnerabilities. The information produced by this capability 475 
informs the Policy Enforcement capability, which aims to fix the discovered vulnerabilities or quarantine 476 
the machine until they are fixed. 477 

For the Vulnerability Management capability, we use Tripwire IP360. Tripwire IP360 is a vulnerability 478 
scanner and management tool, which can scan a variety of hosts for known vulnerabilities and report on 479 
the results. Furthermore, the tool can manage and assign risk levels to these vulnerabilities, allowing 480 
security teams to effectively manage vulnerabilities throughout the enterprise. 481 

4.1.2.3 Policy Enforcement 482 

Through various mechanisms, the Policy Enforcement capability maintains the health of the enterprise. 483 
Policy Enforcement acts on log information provided by the Inventory and Vulnerability Management 484 
capabilities, often with the help of a security team, to ensure the health and compliance of enterprise 485 
systems. This can include mechanisms such as pushing software updates, resolving vulnerabilities, or 486 
quarantining noncompliant machines, but the capabilities of policy enforcement tools vary from product 487 
to product. 488 

For Policy Enforcement, we use Cisco ISE. Cisco ISE can identify machines on its network and perform a 489 
posture check on these machines. This can entail checking that certain services are enabled, that anti-490 
malware is installed, or that certain files are present. Using this information, Cisco ISE can then disable 491 
network access to noncompliant machines. 492 

4.1.2.4 Integrity Monitoring 493 

Integrity monitoring provides the ability to test, understand, and measure attacks that occur on files and 494 
components within the enterprise. When considering DI from the perspective of protecting assets prior 495 
to an attack, it is important to establish an integrity baseline for files and systems across the enterprise, 496 
to be used in comparison with daily operations. The value of integrity monitoring becomes clear both 497 
during and after an attack. Alerts can be set to notify the security team to act when abnormal changes 498 
are detected to a file or system, such as changes made at abnormal times or by users who typically do 499 
not make changes to these assets. Furthermore, the information produced by integrity monitoring 500 
systems can be used to inform a recovery process; they provide information about what changes 501 
happened, when changes began to take place, as well as what programs were involved in the changes. 502 

For Integrity Monitoring, we use a combination of two tools: Tripwire Enterprise and Semperis Directory 503 
Services Protector. Tripwire Enterprise is a file integrity monitoring tool that establishes a baseline for 504 
integrity activity within the enterprise. This baseline is used in the event of an attack, to detect and alert 505 
on changes within the enterprise as well as aid recovery should it be necessary. Semperis Directory 506 
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Services Protector also provides integrity monitoring, but for Active Directory it allows granular rollbacks 507 
of Active Directory changes and provides a baseline for any attacks on the enterprise account 508 
configuration. 509 

4.1.2.5 Logging 510 

Logging from each enterprise component serves several functions in an architecture that aims to 511 
identify and protect assets. Logs are produced through Integrity Monitoring, which aids in establishing a 512 
baseline for the enterprise’s daily activity. Logs are also produced through vulnerability scanning and 513 
asset inventory, which inform Policy Enforcement: maintaining up-to-date systems requires information 514 
about what systems exist in the enterprise and their status. 515 

For Logging, we use a combination of two tools: Micro Focus ArcSight and Tripwire Log Center (TLC). 516 
While TLC’s purpose in this build is primarily to collect, transform, and forward logs from Tripwire IP360 517 
and Tripwire Enterprise to ArcSight, ArcSight performs a wider function. ArcSight collects logs from 518 
various sources in the enterprise, such as Vulnerability Management, Backups, Network Protection, 519 
Blacklisting, Inventory, Integrity Monitoring, as well as Windows event logs and Ubuntu syslogs. This 520 
widespread collection aims to provide a baseline for activity throughout the enterprise. ArcSight can 521 
analyze and alert, which can be used in the event of an attack, but it requires thorough log collection 522 
from all components of the enterprise. 523 

4.1.2.6 Backups 524 

The Backups capability backs up both the organization’s data and data from other components, such as 525 
logs and integrity information. These backups are most often used as part of the Recover Function as 526 
part of the restoration process. Backups must be taken prior to an event to be useful, though; the 527 
restoration process requires backups from before the event to adequately restore a system. 528 

The configuration of this capability needs to align with the tempo of the enterprise. For example, if an 529 
enterprise performs thousands of transactions per hour per day, then a backup solution that performs a 530 
backup only once a day would not adequately provide for the enterprise. This type of configuration 531 
would allow a potentially large data loss. If backups occur every morning and a loss of DI happened at 532 
the end of the day, then a full day’s worth of transactions would be lost. The decision for the correct 533 
configuration of backups is determined by an organization’s risk tolerance. 534 

For the Backups capability, we use a combination of two open-source tools: FileZilla and Duplicati. 535 
FileZilla is a user-based File Transfer Protocol (FTP) server with the option to force FTP over TLS. It allows 536 
control over where individual users/groups store files, and its primary purpose in this build is as a 537 
receptacle for backups produced by Duplicati. Duplicati is a client-based backup system configured on 538 
individual hosts to back up to a provided FTP server. It packages and encrypts backups before sending 539 
them to the FTP server, potentially on a schedule. 540 
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We also use Semperis ADFR to provide more fine-grained backups for Active Directory. As Active 541 
Directory is often critical to enterprise operations, Semperis ADFR is designed to work off-site in the 542 
event of a disaster. 543 

4.1.2.7 Secure Storage 544 

Secure Storage stores the most critical files for an enterprise. These include backup data, configuration 545 
files, logs, golden images, and other files critical to both system operation and the organization’s 546 
mission. Additional measures need to be applied to provide increased security to these files so they are 547 
not subject to attacks or corruption. 548 

For Secure Storage, we use GreenTec’s WORMdisk, a transparent hard disk that can prevent any data 549 
deletion and modification at a firmware level. WORMdisks provide an easy-to-use graphical user 550 
interface and a command line interface for automating locking and disk rotation. In this architecture 551 
they are used primarily to store backups to prevent any damage to the backups, but they can be used at 552 
the discretion of the organization to store other critical files. 553 

4.1.2.8 Network Protection 554 

Network Protection defends the network against threats that require network movement. This should 555 
preemptively protect against lateral movement, in which malware or a malicious actor attempts to 556 
spread across machines in the network. Furthermore, it should also protect against external threats 557 
attempting to gain access to the network. 558 

For Network Protection, we use CryptoniteNXT. CryptoniteNXT provides zero-trust moving-target 559 
defense for the network it protects. This means that all enterprise communication goes through the 560 
CryptoniteNXT device, which provides granular access control for allowed types of communication. This 561 
allows defense against lateral propagation. Furthermore, as internet protocol (IP) addresses are dynamic 562 
and managed by CryptoniteNXT, reconnaissance is significantly more difficult for attackers on and 563 
outside the network. 564 

4.1.2.9 Blacklisting 565 

Blacklisting enables control of allowed communications and applications within an enterprise. This may 566 
include restricting installed software on enterprise machines to a predefined list or specifically 567 
disallowing software. Furthermore, it should restrict network communication with websites, servers, or 568 
external actors as well as restrict based on protocol or port usage. Some of these capabilities are 569 
covered by firewalls, but further control can allow more complex policies based on the organization’s 570 
needs. 571 

For the Blacklisting capability we use Cisco Web Security Appliance (WSA). Cisco WSA enables 572 
enterprises to blacklist web traffic through a proxy. This allows for prevention of malware downloads 573 
from known malicious websites as identified by site reputation updates from Cisco Talos threat 574 
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intelligence. These websites can also be identified through the implementation of a Detect and Respond 575 
build and can also be provided by an integration with other information sharing services. 576 

5 Security Characteristic Analysis 577 

The purpose of the security characteristic analysis is to understand the extent to which the project 578 
meets its objective of demonstrating a DI identify-and-protect solution. In addition, it seeks to 579 
understand the security benefits and drawbacks of the example solution. 580 

5.1 Assumptions and Limitations 581 

The security characteristic analysis has the following limitations: 582 

 It is neither a comprehensive test of all security components nor a red-team exercise. 583 

 It cannot identify all weaknesses. 584 

 It does not include the lab infrastructure. It is assumed that devices are hardened. Testing these 585 
devices would reveal only weaknesses in implementation that would not be relevant to those 586 
adopting this reference architecture. 587 

5.2 Build Testing 588 

The purpose of the security characteristic analysis is to understand the extent to which the building 589 
block meets its objective of identifying enterprise assets and vulnerabilities. Furthermore, the project 590 
aims to protect these assets prior to the start of an attack. In addition, it seeks to understand the 591 
security benefits and drawbacks of the reference design. To accomplish this, we created a set of use 592 
cases—each an individual attack on DI with different aspects to test various parts of the build. 593 

When doing this, we aim not to test individual components for their capabilities but rather for the ability 594 
of the architecture to deal with these use cases. Furthermore, as this architecture is focused on 595 
defending against attacks before they happen, the resolutions to these use cases are primarily 596 
preventative rather than responsive. 597 

5.3 Scenarios and Findings 598 

One aspect of our security evaluation involved assessing how well the reference design addresses the 599 
security characteristics it was intended to support. The Cybersecurity Framework Subcategories were 600 
used to provide structure to the security assessment by consulting the specific sections of each standard 601 
that are cited in reference to a Subcategory. The cited sections provide validation points that the 602 
example solution would be expected to exhibit. Using the Cybersecurity Framework Subcategories as a 603 
basis for organizing our analysis allowed us to systematically consider how well the reference design 604 
supports the intended security characteristics. 605 
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Below is a list of the scenarios created to test various aspects of this architecture. More detailed 606 
resolutions and mappings of these scenarios’ requirements to the Cybersecurity Framework can be 607 
found in Appendix D. 608 

5.3.1 Ransomware via Web Vector and Self-Propagation 609 

5.3.1.1 Scenario 610 

The following scenario was simulated to test the architecture’s defense against ransomware. 611 

A user mistakenly downloads ransomware from an external web server. When the user executes this 612 
malicious software, it generates a cryptographic key, which is sent back to the external web server. The 613 
malware then utilizes a privilege escalation exploit to propagate across the network. The malicious 614 
software encrypts files on the machines it propagated to, and it demands payment in exchange for 615 
decrypting these files. 616 

5.3.1.2 Resolution 617 

This build provides a significant defense in depth against this use case to prevent the majority of its 618 
functions from taking place. 619 

The Blacklisting capability is used to prevent the user from reaching the malicious site that hosts the 620 
ransomware, preventing the download before it happens. 621 

The Vulnerability Management capability is used to detect the vulnerability exploited by the 622 
ransomware to propagate, allowing resolution before the attack occurs. 623 

The Network Protection capability is used to prevent the ransomware’s propagation by disallowing 624 
network traffic between computers on the network, through a traffic white-list policy. 625 

The Inventory capability is used to identify the enterprise’s assets for backup and monitoring. 626 

The Backups capability is used to take backups of potential ransomware targets before the attack hits, 627 
nullifying the effects of potential attacks on files. 628 

The Integrity Monitoring capability, in tandem with the Logging capability, is used to take a baseline of 629 
the file system, so that an attack on the file system is detected and the scope can be identified. 630 

5.3.1.3 Other Considerations 631 

Malware comes in many forms and from many places, and as a result, requires a defense in depth 632 
against it. For example, though preventing a piece of malware from getting on enterprise systems may 633 
be as simple as blacklisting a website, it is often impossible to have full knowledge of all malicious 634 
websites before an attack happens. Because of this, other tools are necessary to prevent the effects of 635 
malware at every step of its potential execution, and preparation is necessary to mitigate effects. 636 
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It is important to improve upon these capabilities over time by learning from attacks on the enterprise 637 
and from attacks on other enterprises. Both information-sharing technologies and after-the-fact analysis 638 
of attacks can inform capabilities to prevent future attacks. 639 

5.3.2 Destructive Malware via USB Vector 640 

5.3.2.1 Scenario 641 

The following scenario was simulated to test the architecture’s defense against destructive malware. 642 

A user finds an unmarked Universal Serial Bus (USB) device and inserts it into his or her system. The USB 643 
device contains malicious software that may run automatically or with user interaction. The malicious 644 
software modifies and deletes the user’s files, removing text from text files and entirely deleting any 645 
media files it finds. The software does not offer a recovery mechanism as ransomware might, aiming 646 
only to corrupt files. 647 

5.3.2.2 Resolution 648 

This build provides two main layers of defense against this scenario: Backups and Integrity baselining. 649 

The Integrity Monitoring capability provides a baseline for file system activity as a point of comparison 650 
post-modification/deletion. 651 

The Logging capability provides a baseline for events across the enterprise, including typical USB and file 652 
modification activity. 653 

The Backups capability provides the ability to take backups of the file system, allowing restoration of 654 
files after the incident is resolved. 655 

5.3.2.3 Other Considerations 656 

A use case involving USBs is often best prevented through organizational training. In some cases, just 657 
the action of inserting the USB is enough to destroy an entire system on a physical level. Furthermore, 658 
not all malicious USBs will be simple file systems with auto-run malware on them—they can come 659 
disguised as keyboards or use lower-level attacks. Because of this, it is important for organizations to 660 
educate members on the dangers of unknown USB insertion, while also preparing if the attack occurs 661 
anyway. 662 

5.3.3 Accidental VM Deletion via Maintenance Script 663 

5.3.3.1 Scenario 664 

The following scenario was simulated to test the architecture’s defense against DI events that occur on 665 
virtual machines (VMs). 666 
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A routine maintenance script on the system causes an error. During a move operation in the Hyper-V 667 
system, the script deletes an important VM. A maintenance script with an error of this type could be a 668 
side effect of a normal system function or an error made by a member of the organization. The build is 669 
expected to mitigate the damage caused to VMs in such an incident. 670 

5.3.3.2 Resolution 671 

This build provides two main layers of defense against this scenario: Backups and Integrity baselining. 672 

The Integrity Monitoring capability provides a baseline for virtual machine activity, as a point of 673 
comparison post-deletion. 674 

The Logging capability provides a baseline for events across the enterprise, including typical Hyper-V 675 
activity. 676 

The Backups capability enables backups of entire VMs. In the event of a deletion, these backups can be 677 
used to restore the VMs. 678 

5.3.3.3 Other Considerations 679 

The Backups capability can also be installed on individual VMs, given proper networking, to back up the 680 
contents of VMs if desired. This will likely depend on the needs of the organization. 681 

5.3.4 Backdoor Creation via Email Vector 682 

5.3.4.1 Scenario 683 

The following scenario was simulated to test the architecture’s defense against malicious email 684 
attachments. 685 

A user unknowingly opens a malicious attachment they received in an email. When opened, the 686 
attachment quietly fetches files from an external web server. It then creates several unapproved 687 
backdoor accounts on the authentication server. The build is expected to mitigate the impacts of such 688 
an incident. 689 

5.3.4.2 Resolution 690 

The build provides several layers of defense against this use case. The Integrity Monitoring capability 691 
provides a baseline for Active Directory as a point of comparison against a compromised system. 692 
Furthermore, it also provides a baseline of the file system, to aid in identifying the malicious file during 693 
and after the attack has happened. 694 

The Logging capability provides a baseline for activity across the enterprise, including the name of the 695 
account used to create the backdoors. 696 
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Lastly, the Blacklisting capability is used to prevent web requests to the malicious web server. This 697 
capability is informed by capabilities in the Respond Category of the Cybersecurity Framework. 698 

5.3.4.3 Other Considerations 699 

Note that for this scenario, prevention of the downloads before an attack happens requires 700 
organizations to know what web servers are “known bad.” Organizations can acquire this knowledge in 701 
two ways: through threat-sharing services and through self-information as part of the Respond Category 702 
of the Cybersecurity Framework. The former refers to services that collect the names of malicious 703 
domains and share them with customers. The latter refers to the addition of known-bad websites to the 704 
blacklist after they are detected as malicious through the organization’s own logs and analytics during or 705 
after an event. This build allows protecting against attacks given this knowledge, but the knowledge 706 
must be gained in some way first. 707 

Another defense that can partially prevent this use case is simply blacklisting the sender of the phishing 708 
email or sorting it into spam. However, as this is typically a function of the email provider and not a 709 
separate security solution, it is out of scope for this build. 710 

5.3.5 Database Modification via Malicious Insider 711 

5.3.5.1 Scenario 712 

The following scenario was simulated to test the architecture’s defense against unwanted database 713 
modification. 714 

A malicious insider has access to an enterprise database through a web page. The insider leverages a 715 
vulnerability in the web page to delete a large portion of the database. Though this scenario deals with a 716 
web vulnerability, other vulnerabilities could be used to modify the database undesirably. The build is 717 
expected to mitigate a user’s potential impact on the database. 718 

5.3.5.2 Resolution 719 

This build provides two main layers of defense against this scenario: Backups and Integrity baselining. 720 

The Integrity Monitoring capability provides a baseline for database activity as a point of comparison 721 
post-deletion. 722 

The Logging capability provides a baseline for events across the enterprise, including typical database 723 
activity. 724 

The Backup capability enables backups of the entire database. In the event of a deletion, these backups 725 
can be used to restore the database. 726 
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5.3.5.3 Other Considerations 727 

Creating backups of the entire database may, in some cases, be undesirable, particularly for enterprises 728 
that heavily use the database. For these cases, we recommend built-in database backups. Microsoft 729 
Structured Query Language databases have built-in backups that can be more granular than a full 730 
database backup. 731 

For many applications, though, a periodic backup of the entire database is sufficient and potentially can 732 
be used in tandem with built-in database backups. 733 

5.3.6 File Modification via Malicious Insider 734 

5.3.6.1 Scenario 735 

The following scenario was simulated to test the architecture’s defense against malicious file and backup 736 
modification. 737 

A malicious insider is assumed to have stolen administrator-level credentials through nontechnical 738 
means. The insider, using these credentials, uses remote Windows PowerShell sessions to uniformly 739 
modify employee stock information across several machines, to the insider’s benefit. This attack will also 740 
target the enterprise's backups system, to modify all records of the previous stock information. The 741 
aspects of the build described above are expected to mitigate the ability of the user to target and 742 
modify enterprise data and backups. The method of securing administrator credentials will be 743 
considered out of scope for this solution. 744 

5.3.6.2 Resolution 745 

The build provides several layers of defense against this use case. Because this use case specifically 746 
targets the backups, the solution includes mechanisms for protecting and monitoring the backups. 747 

The Inventory capability is used to identify potentially sensitive information across the enterprise. 748 

The Integrity Monitoring capability is used to baseline file activity, both for backups and for 749 
organizational files. 750 

This information is forwarded to the Logging capability for analysis. 751 

The Backups capability is used to take encrypted backups of the file system, preventing targeted attacks 752 
against information in the backups. 753 

The Secure Storage capability is used to prevent write-access to the backups once taken, allowing a 754 
guarantee of modification/deletion protection for backups stored on the disk. 755 
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5.3.6.3 Other Considerations 756 

A significant trade-off between memory and frequency of backups occurs when implementing a secure 757 
storage solution for backups. As WORM space may be limited by the number of disks purchased or by a 758 
cloud service’s limitations, it is important for organizations to consider the cost of storing all backups in 759 
secure storage, especially for organizations that frequently take backups to reduce the loss of data. 760 

5.3.7 Backdoor Creation via Compromised Update Server 761 

5.3.7.1 Scenario 762 

The following scenario was simulated to test the architecture’s defense against compromised update 763 
servers. 764 

An update server that services an enterprise machine is compromised and provides an update to the 765 
enterprise machine that contains a backdoor. The update contains a vulnerable version of vsftpd, 766 
allowing a malicious actor root access into the machine updated by the compromised server. The build is 767 
expected to mitigate the impact of a compromised update server. 768 

5.3.7.2 Resolution 769 

The build provides several layers of defense against this use case. The Integrity Monitoring capability is 770 
used to baseline the integrity of both files and programs, as an intrusion via compromised update server 771 
can potentially affect both. This aids in early detection and recovery. 772 

The Backups capability is used to back up the file system, to preemptively mitigate the damage done by 773 
the intrusion. 774 

The Blacklisting capability is used to blacklist the compromised update server, to prevent use of the 775 
update server by other machines. 776 

5.3.7.3 Other Considerations 777 

To prevent updates through Blacklisting, organizations should either use their blacklisting capability as a 778 
transparent proxy or ensure that the update mechanism uses the proxy; the process for configuring this 779 
will differ between update mechanisms. The Blacklisting and Network Protection capabilities are 780 
especially important in the event of a breach, as these two can help prevent the spread of the intrusion. 781 

5.3.8 New Employee 782 

5.3.8.1 Scenario 783 

The following scenario was simulated to test the architecture’s identification capabilities with respect to 784 
machines and vulnerabilities. 785 
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A new employee joins the organization and connects his or her machine to the network. The machine, 786 
however, is not up-to-date on its patches and poses a security risk to the organization. The build is 787 
expected to be able to identify the machine and its noncompliance with organizational maintenance 788 
policy. 789 

5.3.8.2 Resolution 790 

The build provides several layers of defense against this use case. The Inventory capability provides logs 791 
and information about newly connected machines, including operating system, MAC address, IP 792 
address, and date of login. It also generates logs for the Logging capability to collect and use for 793 
comparison against a baseline in the event of an incident. 794 

The Policy Enforcement capability provides the ability to grant or deny network access based on the 795 
machine’s posture—essentially, this verifies existence of security software and machine update status 796 
before the machine is ever allowed to use the network. 797 

Lastly, the Vulnerability Management capability detects and keeps track of vulnerabilities on the newly 798 
discovered machine, allowing better understanding of the machine’s vulnerabilities before and after it is 799 
allowed onto the network. 800 

5.3.8.3 Other Considerations 801 

Though this use case primarily targets desktops, similar considerations should be taken for enterprises 802 
that aim to include employee-owned mobile devices. These devices should be inventoried and scanned 803 
for relevant security posture, before being allowed to join the network. 804 

6 Future Build Considerations 805 

The NCCoE is creating an overarching guide to combining the architectures of the various DI projects: 806 
Identify and Protect, Detect and Respond, and Recover. These architectures have some commonalities, 807 
such as integrity monitoring, as well as some potential integrations and cycles that could not be 808 
expressed in just one of the practice guides. The different functions of the Cybersecurity Framework are 809 
intended to prepare and inform one another, and the overarching guide addresses those issues. 810 

The NCCoE is also considering additional data security projects that map to the Cybersecurity 811 
Framework Core Functions of Identify, Protect, Detect, Respond, and Recover. These projects will focus 812 
on data confidentiality—the defense of enterprise systems from attacks that would compromise the 813 
secrecy of data. 814 
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Appendix A List of Acronyms 815 

COI  community of interest 

DI data integrity 

DSP Directory Services Protector 

ESM Enterprise Security Manager 

IT Information Technology 

ISO/IEC International Organization for Standardization/International 
Electrotechnical Commission 

NCCoE National Cybersecurity Center of Excellence 

NIST National Institute of Standards and Technology 

NIST IR NIST Interagency Report 

RMF Risk Management Framework 

SP Special Publication 

TLC Tripwire Log Center 

USB Universal Serial Bus 

VM Virtual Machine 

vsftpd Very Secure File Transfer Protocol Daemon 

WORM Write Once Read Many 

WSA Web Security Appliance 
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Appendix B Glossary 816 

Access Control The process of granting or denying specific requests to: 1) obtain and use 
information and related information processing services; and 2) enter specific 
physical facilities (e.g., federal buildings, military establishments, border crossing 
entrances)  

SOURCE: Federal Information Processing Standard (FIPS) 201; CNSSI-4009 

Architecture A highly structured specification of an acceptable approach within a framework 
for solving a specific problem. An architecture contains descriptions of all the 
components of a selected, acceptable solution while allowing certain details of 
specific components to be variable to satisfy related constraints (e.g., costs, local 
environment, user acceptability).  

SOURCE: FIPS 201-2  

Audit Independent review and examination of records and activities to assess the 
adequacy of system controls and ensure compliance with established policies and 
operational procedures  

SOURCE: CNSSI 4009-2015  

Backdoor An undocumented way of gaining access to a computer system. A backdoor is a 
potential security risk.  

SOURCE: National Institute of Standards and Technology (NIST) Special Publication 
(SP) 800-82 Rev. 2  

Backup A copy of files and programs made to facilitate recovery if necessary  

SOURCE: NIST SP 800-34 Rev. 1  

Compromise Disclosure of information to unauthorized persons, or a violation of the security 
policy of a system in which unauthorized intentional or unintentional disclosure, 
modification, destruction, or loss of an object may have occurred  

SOURCE: NIST SP 800-32  
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Continuous 
Monitoring 

Maintaining ongoing awareness to support organizational risk decisions 

SOURCE: NIST SP 800-137  

Cybersecurity Prevention of damage to, protection of, and restoration of computers, electronic 
communications systems, electronic communications services, wire 
communication, and electronic communication, including information contained 
therein, to ensure its availability, integrity, authentication, confidentiality, and 
nonrepudiation  

SOURCE: CNSSI 4009-2015 (NSPD-54/HSPD-23)  

Data A subset of information in an electronic format that allows it to be retrieved or 
transmitted 

SOURCE: CNSSI-4009 

Data Integrity The property that data has not been changed, destroyed, or lost in an 
unauthorized or accidental manner 

SOURCE: CNSSI-4009 

Information 
Security 

The protection of information and information systems from unauthorized access, 
use, disclosure, disruption, modification, or destruction in order to provide 
confidentiality, integrity, and availability  

SOURCE: FIPS 199 (44 U.S.C., Sec. 3542)  

Information 
Security Risk 

The risk to organizational operations (including mission, functions, image, 
reputation), organizational assets, individuals, other organizations, and the Nation 
due to the potential for unauthorized access, use, disclosure, disruption, 
modification, or destruction of information and/or information systems  

SOURCE: CNSSI 4009-2015 (NIST SP 800-30 Rev. 1)  

Information 
System 

A discrete set of information resources organized for the collection, processing, 
maintenance, use, sharing, dissemination, or disposition of information  

SOURCE: FIPS 200 (44 U.S.C., Sec. 3502)  

Insider An entity inside the security perimeter that is authorized to access system 
resources but uses them in a way not approved by those who granted the 
authorization  
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SOURCE: NIST SP 800-82 Rev. 2 (RFC 4949)  

Kerberos An authentication system developed at the Massachusetts Institute of Technology 
(MIT). Kerberos is designed to enable two parties to exchange private information 
across a public network.  

SOURCE: NIST SP 800-47  

Log A record of the events occurring within an organization’s systems and networks  

SOURCE: NIST SP 800-92  

Malware A program that is inserted into a system, usually covertly, with the intent of 
compromising the confidentiality, integrity, or availability of the victim’s data, 
applications, or operating system  

SOURCE: NIST SP 800-111  

Privacy Assurance that the confidentiality of, and access to, certain information about an 
entity is protected  

SOURCE: NIST SP 800-130  

Risk The level of impact on organizational operations (including mission, functions, 
image, or reputation), organizational assets, or individuals resulting from the 
operation of an information system given the potential impact of a threat and the 
likelihood of that threat occurring  

SOURCE: FIPS 200  

Risk 
Assessment 

The process of identifying the risks to system security and determining the 
probability of occurrence, the resulting impact, and additional safeguards that 
would mitigate this impact. Part of Risk Management and synonymous with Risk 
Analysis  

SOURCE: NIST SP 800-63-2 

Risk 
Management 
Framework 

The Risk Management Framework (RMF), presented in NIST SP 800-37, provides a 
disciplined and structured process that integrates information security and risk 
management activities into the system development life cycle. 

 SOURCE: NIST SP 800-82 Rev. 2 (NIST SP 800-37)  
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Security 
Control 

A protection measure for a system  

SOURCE: NIST SP 800-123  

Virtual 
Machine 

Software that allows a single host to run one or more guest operating systems  

SOURCE: NIST SP 800-115  

Vulnerability Weakness in an information system, system security procedures, internal controls, 
or implementation that could be exploited or triggered by a threat 
source SOURCE: FIPS 200 (Adapted adapted from CNSSI 4009)  
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Appendix D Functional Evaluation 882 

A functional evaluation of the data integrity (DI) example implementation, as constructed in our 883 
laboratory, was conducted to verify that it meets its objective of identifying assets and vulnerabilities 884 
within the enterprise. Furthermore, the project aims to protect these assets prior to an attack. The 885 
evaluation verified that the example implementation could perform the following functions: 886 

 discover assets on the network 887 

 discover and mitigate vulnerabilities in assets on the network 888 

 protect data from modification prior to an attack 889 

 provide a baseline for daily activity and asset integrity 890 

Section D.1 describes the format and components of the functional test cases. Each functional test case 891 
is designed to assess the capability of the example implementation to perform the functions listed 892 
above and detailed in Section D.1. 893 

D.1 Data Integrity Functional Test Plan 894 

One aspect of our security evaluation involved assessing how well the reference design addresses the 895 
security characteristics it was intended to support. The Cybersecurity Framework Subcategories were 896 
used to provide structure to the security assessment by consulting the specific sections of each standard 897 
that are cited in reference to that Subcategory. The cited sections provide validation points that the 898 
example solution is expected to exhibit. Using the Cybersecurity Framework Subcategories as a basis for 899 
organizing our analysis allowed us to systematically consider how well the reference design supports the 900 
intended security characteristics. 901 

This plan includes the test cases necessary to conduct the functional evaluation of the DI example 902 
implementation, which is currently deployed in a lab at the National Cybersecurity Center of Excellence. 903 
The implementation tested is described in Section 4. 904 

Each test case consists of multiple fields that collectively identify the goal of the test, the specifics 905 
required to implement the test, and how to assess the results of the test. Table 6-1 describes each field 906 
in the test case. 907 

Table 6-1 Test Case Fields 908 

Test Case Field Description 

Parent Requirement Identifies the top-level requirement or the series of top-level require-
ments leading to the testable requirement 

Testable requirement Drives the definition of the remainder of the test case fields. Specifies the 
capability to be evaluated. 
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Test Case Field Description 

Description Describes the objective of the test case 

Associated Cybersecu-
rity Framework Subcate-
gories 

Lists the National Institute of Standards and Technology (NIST) Special 
Publication (SP) 800-53 Rev. 4 controls addressed by the test case 

Preconditions The starting state of the test case. Preconditions indicate various starting 
state items, such as a specific capability configuration required or specific 
protocol and content. 

Procedure The step-by-step actions required to implement the test case. A procedure 
may consist of a single sequence of steps or multiple sequences of steps 
(with delineation) to indicate variations in the test procedure. 

Expected results The expected results for each variation in the test procedure 

Actual results The observed results 

Overall result The overall result of the test as pass/fail. In some test cases, determina-
tion of the overall result may be more involved, such as determining 
pass/fail based on a percentage of errors identified. 

D.2 Data Integrity Use Case Requirements 909 

Table 6-2 identifies the DI functional requirements addressed in the test plan and associated test cases. 910 

Table 6-2 Capability Requirements 911 

Capability Re-
quirement (CR) 
ID 

Parent Requirement Sub requirement 1 Test Case 

CR 1 The DI example imple-
mentation shall identify 
and protect assets 
against malware that 
encrypts files and dis-
plays notice demanding 
payment. 

  

CR 1.a  Vulnerability in Ac-
tive Directory server 
is identified. 

Data Integrity IP-1 

CR 1.b  User is blocked from 
visiting malicious 
site. 

Data Integrity IP-1 
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Capability Re-
quirement (CR) 
ID 

Parent Requirement Sub requirement 1 Test Case 

CR 1.c  Downloads from 
site are blocked. 

Data Integrity IP-1 

CR 1.d  Vulnerability is 
patched. 

Data Integrity IP-1 

CR 1.e  Ransomware can-
not send infor-
mation to home 
server. 

Data Integrity IP-1 

CR 1.f  Backups are taken. Data Integrity IP-1 

CR 1.g  File integrity infor-
mation is baselined. 

Data Integrity IP-1 

CR 2 The DI example imple-
mentation shall identify 
and protect assets 
against malware in-
serted via Universal Se-
rial Bus (USB) that modi-
fies and deletes user 
data. 

 Data Integrity IP-2 

CR 2.a  Backups are taken. Data Integrity IP-2 

CR 2.b  File integrity infor-
mation is baselined. 

Data Integrity IP-2 

CR 3 The DI example shall 
identify and protect vir-
tual machines against 
deletion. 

 Data Integrity IP-3 

CR 3.a  Backups of virtual 
machines are taken. 

Data Integrity IP-3 

CR 4 The DI example imple-
mentation shall identify 
and protect assets 
against malware re-
ceived via phishing 
email. 

 Data Integrity IP-4 
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Capability Re-
quirement (CR) 
ID 

Parent Requirement Sub requirement 1 Test Case 

CR 4.a  Downloads from the 
spreadsheet are 
blocked. 

Data Integrity IP-4 

CR 4.b  Backups of configu-
rations are taken. 

Data Integrity IP-4 

CR 4.c  Configuration integ-
rity information is 
baselined. 

Data Integrity IP-4 

CR 5 The DI example imple-
mentation shall identify 
and protect the data-
base against changes 
made through a web 
server vulnerability in 
custom code. 

 Data Integrity IP-5 

CR 5.a  Vulnerability is iden-
tified. 

Data Integrity IP-5 

CR 5.b  Vulnerability is re-
solved. 

Data Integrity IP-5 

CR 5.c  Backups of database 
are taken. 

Data Integrity IP-5 

CR 5.d  Database integrity 
information is base-
lined. 

Data Integrity IP-5 

CR 6 The DI example imple-
mentation shall identify 
and protect assets 
against targeted modifi-
cation by malicious in-
siders with elevated 
privileges. 

 Data Integrity IP-6 

CR 6.a  Backups are taken. Data Integrity IP-6 

CR 6.b  File integrity infor-
mation is baselined. 

Data Integrity IP-6 
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Capability Re-
quirement (CR) 
ID 

Parent Requirement Sub requirement 1 Test Case 

CR 6.c  Backups are en-
crypted. 

Data Integrity IP-6 

CR 6.d  Backups are stored 
securely. 

Data Integrity IP-6 

CR 7 The DI example imple-
mentation shall identify 
and protect assets 
against an intrusion via 
compromised update 
server. 

 Data Integrity IP-7 

CR 7.a  Downloads from 
site are temporarily 
blocked. 

Data Integrity IP-7 

CR 7.b  Backups are taken. Data Integrity IP-7 

CR 7.c  Program integrity 
information is base-
lined. 

Data Integrity IP-7 

CR 7.d  File integrity infor-
mation is baselined. 

Data Integrity IP-7 

CR 8 The DI example imple-
mentation shall identify 
new and unmaintained 
assets on the network. 

 Data Integrity IP-8 

CR 8.a  Machines that are 
new to the network 
are identified. 

Data Integrity IP-8 

CR 8.b  Machines that are 
not up-to-date are 
identified. 

Data Integrity IP-8 
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D.3 Test Case: Data Integrity IP-1 912 

Table 6-3 Test Case ID: Data Integrity IP-1 913 

Parent requirement (CR 1) The DI example implementation shall identify and protect 
assets against malware that encrypts files and displays notice 
demanding payment. 

Testable requirement (CR 1.a) Vulnerability identification, (CR 1.b, 1.c, 1.e) Blacklisting, (CR 
1.d) Maintenance, (CR 1.f) Backups, (CR 1.g) Integrity Baselining 

Description Show that the DI solution can identify and resolve vulnerabilities 
and protect against ransomware. 

Associated Cybersecurity 
Framework Subcategories 

ID.AM-1, ID.AM-2, ID.RA-1, ID.RA-2, ID.RA-6, DE.CM-8, PR.IP-12, 
RS.MI-3, PR.IP-4, PR.DS-1, PR.DS-6, PR.PT-1, PR.MA-2 

Preconditions User navigates to a malicious website and clicks on an ad for a virus 
cleaner. The virus cleaner is actually ransomware, which propagates 
across the domain and encrypts user files. 

Procedure The Blacklisting capability is used to prevent access to and 
downloads from known malicious sites. 

The Inventory capability is used to identify organizational assets and 
devices. 

The Network Protection capability is used to prevent the 
propagation of ransomware across the enterprise. 

The Vulnerability Management capability is used to identify 
vulnerabilities that allow malware to propagate. 

The Integrity Monitoring and Logging collect integrity information 
and baseline the file system. 

The Backups capability is used to take backups of the file system. 

Expected Results (pass) The vulnerability that allows the ransomware to propagate is 
identified (CR 1.a). 

The user cannot access the site when it is blocked (CR 1.b). 
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The user cannot download the ransomware from the site when it is 
blocked (CR 1.c). 

The build can identify (and possibly execute) a fix for the 
vulnerability. When the fix is made, the ransomware is unable to 
propagate (CR 1.d). 

The ransomware is unable to communicate with its home server 
when the site is blocked (CR 1.e). 

The build can take backups of file systems (CR 1.f). 

The build can take and log integrity baselines of file systems (CR 
1.g).  

Actual Results Cisco WSA (Blacklisting) stops the user from accessing the site when 
it is blocked. 

Cisco ISE (Inventory) is used to identify devices on the network. 

Symantec DLP (Inventory) is used to identify organizational data 
assets on monitored machines. 

CryptoniteNXT (Network Protection) prevents propagation of 
ransomware through a white list of allowed communications in the 
enterprise. 

Tripwire IP360 (Vulnerability Management) detects vulnerabilities 
in Active Directory that allow ransomware to propagate. 

Tripwire Enterprise (Integrity Monitoring) and ArcSight ESM 
(Logging) baseline critical data assets across the enterprise. 

Duplicati and FileZilla (Backups) create backups of organizational 
data as a contingency, should ransomware be able to affect any 
systems. 
 

Overall Result Pass. All requirements for this use case are met. 

D.4 Test Case: Data Integrity IP-2 914 

Table 6-4 Test Case ID: Data Integrity IP-2 915 

Parent requirement (CR 2) The DI example implementation shall identify and protect 
assets against malware inserted via USB that modifies and deletes 
user data. 
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Testable requirement (CR 2.a) Backups, (CR 2.b) Integrity Baselining 

Description Show that the DI solution can preemptively protect against 
destructive malware. 

Associated Cybersecurity 
Framework Subcategories 

PR.IP-4, PR.DS-1, PR.DS-6, PR.PT-1 

Preconditions A user inserts an unidentified USB drive into their computer. They 
click on a file on the drive, which immediately destroys any files on 
their machine. 

Procedure Backups schedules and creates backups of the user’s documents. 

The Integrity Monitoring capability is used to take integrity 
baselines of the file system. 

Logging collects logs and baselines system activity.  

Expected Results (pass) The build can take backups of file systems (CR 2.a). 

The build can take and log integrity baselines of file systems (CR 
2.b). 

Actual Results Duplicati and FileZilla (Backups) are used to take and store backups 
of the user’s documents. 

Tripwire Enterprise (Integrity Monitoring) is used to take an 
integrity baseline of the user’s file system prior to the malicious USB 
drive being inserted into the computer. 

ArcSight ESM (Logging) takes a baseline of system activity prior to 
the USB drive being inserted into the computer.  

Overall Result Pass. All requirements for this use case are met. 

D.5 Test Case: Data Integrity IP-3 916 

Table 6-5 Test Case ID: Data Integrity IP-3 917 

Parent requirement (CR 3) The DI example implementation shall identify and protect 
virtual machines against deletion. 

Testable requirement (CR 3.a) Backups 

Description Show that the DI solution can preemptively protect against data 
integrity events that involve virtual machines (VMs). 
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Associated Cybersecurity 
Framework Subcategories 

PR.IP-4, PR.DS-1 

Preconditions A routine maintenance script contains an error that accidentally 
deletes a VM. 

Procedure The Backups capability is used to schedule and create backups of a 
VM. 

Expected Results (pass) The build can take backups of VMs (CR 3.a). 

Actual Results Duplicati and FileZilla (Backups) take and store backups of VMs. 

Overall Result Pass. All requirements for this use case are met. 

D.6 Test Case: Data Integrity IP-4 918 

Table 6-6 Test Case ID: Data Integrity IP-4 919 

Parent requirement (CR 4) The DI example implementation shall identify and protect 
against malware received via phishing email. 

Testable requirement (CR 4.a, CR 4.b) Blacklisting, (CR 4.c) Backups, (CR 4.d) Integrity 
Baselining 

Description Show that the DI solution can identify phishing emails and protect 
against configuration changes made by malicious attachments. 

Associated Cybersecurity 
Framework Subcategories 

ID.AM-2, ID.AM-3, ID. RA-1, ID.RA-2, ID.RA-5, DE.CM-8, PR.IP-4, 
PR.DS-1, PR.PT-1 

Preconditions The user receives a phishing email with a malicious attached 
spreadsheet. The spreadsheet is downloaded and opened, causing 
account changes in Active Directory. 

Procedure The Integrity Monitoring capability is used to baseline Active 
Directory activity.  

This information is forwarded to the Logging capability, along with 
other available Active Directory information.  

The Backups capability is used to take backups of the Active 
Directory configuration.  
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The malicious web server is added to the Blacklisting capability to 
prevent downloads. 

Expected Results (pass) The spreadsheet cannot download files (CR 4.a). 

The build can take backups of configurations (CR 4.c). 

The build can take and log integrity baselines of configurations (CR 
4.d). 

Actual Results Semperis DSP (Integrity Monitoring) successfully baselines Active 
Directory activity. 

ArcSight ESM (Logging) successfully logs activity from Active 
Directory, including log-ons and changes. 

When the external web server is added to the blacklist, Cisco WSA 
(Blacklisting) prevents the Excel sheet from downloading malicious 
files. 

Semperis ADFR (backups) is used to successfully take backups of the 
Active Directory configuration. 

Overall Result Pass. All requirements for this use case are met. 

D.7 Test Case: Data Integrity IP-5 920 

Table 6-7 Test Case ID: Data Integrity IP-5 921 

Parent requirement (CR 5) The DI example implementation shall identify and protect the 
database against changes made through a web server vulnerability 
in custom code. 

Testable requirement (CR 5.c) Backups, (CR 5.d) Integrity Baselining 

Description Show that the DI solution can protect the database against a 
vulnerability in the custom code of a web server. 

Associated Cybersecurity 
Framework Subcategories 

PR.IP-4, PR.DS-1, PR.PT-1, PR.DS-6 

Preconditions A vulnerability in the source code of an intranet webpage is 
discovered by a malicious insider. The insider exploits this 
vulnerability to delete significant portions of the database. 

Procedure The Backups capability is used to take backups of the database. 
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The Integrity Monitoring and Logging capabilities take baselines of 
the database, for comparison post-modification. 

Expected Results (pass) The build can take backups of the database (CR 5.c). 

The build can take and log integrity baselines of the database (CR 
5.d). 

Actual Results Duplicati and FileZilla (Backups) successfully backs up the database. 

Tripwire Enterprise (Integrity Monitoring) successfully detects 
changes in the database. 

ArcSight ESM (Logging) successfully logs changes to the database. 

Overall Result Pass. All requirements for this use case are met. 

D.8 Test Case: Data Integrity IP-6 922 

Table 6-8 Test Case ID: Data Integrity IP-6 923 

Parent requirement (CR 6) The DI example implementation shall identify and protect 
assets against targeted modification by malicious insiders with 
elevated privileges.  

Testable requirement (CR 6.a) Backups, (CR 6.b) Integrity Baselining, (CR 6.c) Encrypted 
backups, (CR 6.d) Secure Storage 

Description Show that the DI solution can protect assets and backups against 
targeted modification by malicious insiders. 

Associated Cybersecurity 
Framework Subcategories 

PR.IP-4, PR.DS-1, PR.PT-1, PR.DS-6 

Preconditions A malicious insider attempts to modify targeted information in both 
the enterprise systems and the backup systems, using elevated 
credentials obtained extraneously.  

Procedure The Inventory capability is used to identify data assets. 

The Backups capability provides encrypted backups.  

Secure Storage prevents modification or deletion of backups. 

Integrity Monitoring and Logging collect integrity information and 
baseline the file system. 
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Expected Results (pass) The build can take backups of the file system (CR 6.a). 

The build can take and log integrity baselines of the file system (CR 
6.b). 

Backups are encrypted (CR 6.c). 

Backups are stored securely and cannot be modified or deleted (CR 
6.d). 

Actual Results Symantec DLP (Inventory) identifies critical data assets across the 
enterprise. 

Duplicati and FileZilla (Backups) provide encrypted backups of the 
file system. 

GreenTec WORMdisks (Secure Storage) provide write-protection 
for backups, preventing them from being modified or deleted. 

Tripwire Enterprise (Integrity Monitoring) and ArcSight ESM 
(Logging) baseline critical data assets across the enterprise. 

Overall Result Pass. All requirements of this use case are met. 

D.9 Test Case: Data Integrity IP-7 924 

Table 6-9 Test Case ID: Data Integrity IP-7 925 

Parent requirement (CR 7) The DI example implementation shall identify and protect 
assets against an intrusion via compromised update server. 

Testable requirement (CR 7.a) Blacklisting, (CR 7.b) Backups, (CR 7.c, 7.d) Integrity 
Baselining 

Description Show that the DI solution can protect against compromised update 
server as well as intrusion made possible by vulnerable programs. 

Associated Cybersecurity 
Framework Subcategories 

ID.RA-1, ID.RA-2, ID.RA-5, DE.CM-8, PR.IP-12, RS.MI-3, PR.IP-4, 
PR.DS-1, PR.PT-1, PR.DS-6, PR.MA-2 

Preconditions An external update server has been compromised, and a user 
workstation attempts to update from this server. 

Procedure Integrity Monitoring capability is used to take baselines of the 
integrity of both the programs and the file systems. 

The Backups capability is used to back up the file system.  
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The Blacklisting capability is used to prevent communication 
between the update server and the machine. 

Expected Results (pass) Machines cannot update from this site while it is blacklisted (CR 7.a). 

The build can take backups of file systems (CR 7.b). 

The build can take integrity baselines of programs (CR 7.c). 

The build can take integrity baselines of file systems (CR 7.d). 

Actual Results Tripwire Enterprise (Integrity Monitoring) successfully takes an 
integrity baseline of both programs and files. 

Duplicati and FileZilla (Backups) successfully takes backups of the 
file system. 

Cisco WSA (Blacklisting) successfully prevents communication 
between the update server and workstations. 

Overall Result Pass. All requirements for this use case are met. 

D.10  Test Case: Data Integrity IP-8 926 

Table 6-10 Test Case ID: Data Integrity IP-8 927 

Parent requirement (CR 8) The DI example implementation shall identify new and 
unmaintained assets on the network.  

Testable requirement (CR 8.a) Asset Identification, (CR 8.b) Vulnerability Identification 

Description Show that the DI solution can identify machines new to the 
network, as well as unpatched machines. 

Associated Cybersecurity 
Framework Subcategories 

ID.AM-1, ID.AM-2, ID.RA-1, ID.RA-2, ID.RA-5, DE.CM-8 

 

Preconditions A new machine with several critical patches missing is connected to 
the network for the first time. 

Procedure The Inventory capability is used to identify various aspects about 
the machine. 
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The Policy Enforcement identifies the existence of security solutions 
on the machine and grants/denies access to the network, based on 
their presence. 

The Vulnerability Management capability is used to scan for 
vulnerabilities on the new machine.  

Expected Results (pass) New machine is identified on the network (CR 8.a). 

New machine is identified as unmaintained, and required fixes are 
identified (CR 8.b). 

Actual Results Cisco ISE (Inventory) successfully logs information about new 
connections, including the user, date, device, and network 
information. 

Cisco ISE (Policy Enforcement) successfully prevents the new 
machine without 50 security software from connecting to the 
network.  

Tripwire IP360 (Vulnerability Management) successfully identifies 
vulnerabilities on the new machine. 
 

Overall Result Pass. All requirements for this use case are met. 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 22 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 23 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 24 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 25 
public-private partnership enables the creation of practical cybersecurity solutions for specific 26 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 27 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 28 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 29 
NCCoE applies standards and best practices to develop modular, easily adaptable example cybersecurity 30 
solutions using commercially available technology. The NCCoE documents these example solutions in 31 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 32 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 33 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 34 
Maryland. 35 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 36 
https://www.nist.gov. 37 

NIST CYBERSECURITY PRACTICE GUIDES 38 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 39 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 40 
adoption of standards-based approaches to cybersecurity. They show members of the information 41 
security community how to implement example solutions that help them align more easily with relevant 42 
standards and best practices, and provide users with the materials lists, configuration files, and other 43 
information they need to implement a similar approach. 44 

The documents in this series describe example implementations of cybersecurity practices that 45 
businesses and other organizations may voluntarily adopt. These documents do not describe 46 
regulations or mandatory practices, nor do they carry statutory authority.  47 

ABSTRACT 48 

Ransomware, destructive malware, insider threats, and even honest user mistakes present ongoing 49 
threats to organizations. Organizations’ data, such as database records, system files, configurations, 50 
user files, applications, and customer data, are all potential targets of data corruption, modification, and 51 
destruction. Formulating a defense against these threats requires two things: a thorough knowledge of 52 
the assets within the enterprise, and the protection of these assets against the threat of data corruption 53 
and destruction. The NCCoE, in collaboration with members of the business community and vendors of 54 
cybersecurity solutions, has built an example solution to address these data integrity challenges. 55 
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Multiple systems need to work together to identify and protect an organization’s assets against the 56 
threat of corruption, modification, and destruction. This project explores methods to effectively identify 57 
assets (devices, data, and applications) that may become targets of data integrity attacks, as well as the 58 
vulnerabilities in the organization’s system that facilitate these attacks. It also explores methods to 59 
protect these assets against data integrity attacks using backups, secure storage, integrity checking 60 
mechanisms, audit logs, vulnerability management, maintenance, and other potential solutions 61 

KEYWORDS 62 
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1 Introduction 226 

The following volumes of this guide show information technology (IT) professionals and security 227 
engineers how we implemented this example solution. We cover all of the products employed in this 228 
reference design. We do not re-create the product manufacturers’ documentation, which is presumed 229 
to be widely available. Rather, these volumes show how we incorporated the products together in our 230 
environment. 231 

Note: These are not comprehensive tutorials. There are many possible service and security 232 
configurations for these products that are out of scope for this reference design. 233 

1.1 How to Use this Guide  234 

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide demonstrates a 235 
standards-based reference design and provides users with the information they need to replicate the 236 
data integrity identify-and protect-solution. This reference design is modular and can be deployed in 237 
whole or in part. 238 

This guide contains three volumes: 239 

 NIST SP 1800-25A: Executive Summary 240 

 NIST SP 1800-25B: Approach, Architecture, and Security Characteristics – what we built and why 241 

 NIST SP 1800-25C: How-To Guides – instructions for building the example solution (you are 242 
here) 243 

Depending on your role in your organization, you might use this guide in different ways: 244 

Business decision makers, including chief security and technology officers, will be interested in the 245 
Executive Summary (NIST SP 1800-25A), which describes the following topics: 246 

 challenges that enterprises face in identifying assets and protecting them from data integrity 247 
events 248 

 example solution built at the NCCoE 249 

 benefits of adopting the example solution 250 

Technology or security program managers who are concerned with how to identify, understand, assess, 251 
and mitigate risk will be interested in NIST SP 1800-25B, which describes what we did and why. The 252 
following sections will be of particular interest: 253 
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 Section 3.4.1, Assessing Risk Posture, provides a description of the risk analysis we performed. 254 

 Section 3.4.2, Security Control Map, maps the security characteristics of this example solution 255 
to cybersecurity standards and best practices. 256 

You might share the Executive Summary, NIST SP 1800-25A, with your leadership team members to help 257 
them understand the importance of adopting standards-based data integrity solutions. 258 

IT professionals who want to implement an approach like this will find the whole practice guide useful. 259 
You can use this How-To portion of the guide, NIST SP 1800-25C, to replicate all or parts of the build 260 
created in our lab. This How-To portion of the guide provides specific product installation, configuration, 261 
and integration instructions for implementing the example solution. We do not recreate the product 262 
manufacturers’ documentation, which is generally widely available. Rather, we show how we 263 
incorporated the products together in our environment to create an example solution. 264 

This guide assumes that IT professionals have experience implementing security products within the 265 
enterprise. While we have used a suite of commercial products to address this challenge, this guide 266 
does not endorse these particular products. Your organization can adopt this solution or one that 267 
adheres to these guidelines in whole, or you can use this guide as a starting point for tailoring and 268 
implementing parts of a data integrity identify-and-protect solution. Your organization’s security experts 269 
should identify the products that will best integrate with your existing tools and IT system 270 
infrastructure. We hope that you will seek products that are congruent with applicable standards and 271 
best practices. Section 3.5 of Volume B, Technologies, lists the products we used and maps them to the 272 
cybersecurity controls provided by this reference solution. 273 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 274 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 275 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to ds-276 
nccoe@nist.gov.  277 

1.2 Build Overview 278 

The National Cybersecurity Center of Excellence (NCCoE) built a hybrid virtual-physical laboratory 279 
environment to explore methods to effectively identify assets and protect them against a data 280 
corruption event in various IT enterprise environments. The NCCoE also explored identifying 281 
vulnerabilities in advance of an incident. The servers in the virtual environment were built to the 282 
hardware specifications of their specific software components. 283 

mailto:ds-nccoe@nist.gov
mailto:ds-nccoe@nist.gov
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The NCCoE worked with members of the Data Integrity Community of Interest to develop a diverse but 284 
noncomprehensive set of use case scenarios against which to test the reference implementation. These 285 
are detailed in Volume B, Section 5.2. For a detailed description of our architecture, see Volume B, 286 
Section 4. 287 

Typographic Conventions 288 

The following table presents typographic conventions used in this volume. 289 

Typeface/Symbol Meaning Example 

Italics file names and pathnames; 
references to documents 
that are not hyperlinks; new 
terms; and placeholders 

For language use and style guidance, 
see the NCCoE Style Guide. 

Bold names of menus, options, 
command buttons, and 
fields 

Choose File > Edit. 

Monospace command-line input, on-
screen computer output, 
sample code examples, and 
status codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://nccoe.nist.gov. 

2 Product Installation Guides 290 

This section of the practice guide contains detailed instructions for installing and configuring all of the 291 
products used to build an instance of the example solution. 292 

http://nccoe.nist.gov/
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2.1 Active Directory and Domain Name System (DNS Server) 293 

As part of our enterprise emulation, we included an Active Directory server that doubles as a DNS 294 
server. This section covers the installation and configuration process used to set up Active Directory and 295 
DNS on a Windows Server 2012 R2 machine. 296 

2.1.1 Installing Features 297 

1. Open Server Manager.  298 

 

2. Click the link Add roles and features. 299 
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3. Click Next.  300 
4. Select Role-based or feature-based installation. 301 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 6 

 
5. Click Next.  302 
6. Select Select a server from the server pool. 303 
7. Select the intended Active Directory server. 304 
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8. Click Next.  305 
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9. Check the box next to Active Directory Domain Services. 306 
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10. Click Add Features. 307 
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11. Click Next. 308 
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12. Click Next. 309 
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13. Click Next. 310 
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14. Click Install. 311 
15. Wait for the installation to complete. 312 
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16. Click Close. 313 

 
17. Click Promote this server to a domain controller. 314 
18. Select Add a new forest. 315 
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19. Enter a Root domain name.  316 

 
20. Click Next. 317 
21. Select Windows Server 2012 R2 for Forest functional level and Domain functional level. 318 
22. Check the box next to Domain Name System (DNS) server. 319 
23. Enter a password. 320 
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24. Click Next. 321 
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25. Click Next. 322 
26. Verify the domain name. 323 

 
27. Click Next. 324 
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28. Click Next. 325 
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29. Click Next. 326 

 
30. Click Install. 327 
31. Wait for the installation to complete. 328 
32. The server automatically reboots. 329 

2.1.2 Creating a Certificate Authority 330 

1. Open Server Manager. 331 
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2. Click Add roles and features. 332 

 
3. Click Next. 333 
4. Select Role-based or feature-based installation. 334 
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5. Click Next. 335 
6. Select Select a server from the server pool. 336 
7. Select the intended Active Directory server. 337 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 22 

 
8. Click Next. 338 

 
9. Check the box next to Active Directory Certificate Services. 339 
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10. Click Add Features. 340 

 
11. Click Next. 341 
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12. Click Next. 342 

 
13. Click Next. 343 
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14. Check the box next to Certification Authority. 344 

 
15. Click Next. 345 
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16. Click Install. 346 
17. Wait for the installation to complete. 347 

 
18. Click Close. 348 
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19. Click Configure Active Directory Certificate Services on the destination server. 349 

 

20. Click Next. 350 
21. Check the box next to Certification Authority. 351 
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22. Click Next. 352 
23. Select Enterprise CA. 353 
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24. Click Next. 354 
25. Select Root CA. 355 

 
26. Click Next. 356 
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27. Select Create a new private key. 357 

 
28. Click Next. 358 
29. Select RSA#Microsoft Software Key Storage Provider. 359 
30. Set the Key length to 2048. 360 
31. Select SHA512 from the list. 361 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 31 

 
32. Click Next. 362 
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33. Click Next. 363 
34. Set the time to 5 years. 364 

 
35. Click Next. 365 
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36. Click Next. 366 

 
37. Click Configure. 367 
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38. Click Close. 368 

2.1.3 Configure Account to Add Computers to Domain 369 

1. Open the Start menu. 370 
2. Enter dsa.msc and run the program. 371 
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3. Right-click on Users in the left panel. 372 

 
4. Click Delegate Control. 373 
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5. Click Next. 374 

 

6. Click Add to select users or groups. 375 
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7. Add users or groups. 376 

 
8. Click OK. 377 

 

9. Click Next. 378 
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10. Choose Create a custom task to delegate. 379 

 

11. Click Next. 380 
12. Choose Only the following objects in the folder. 381 
13. Check the box next to Computer objects. 382 
14. Check the box next to Create selected objects in this folder. 383 
15. Check the box next to Delete selected objects in this folder. 384 
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16. Click Next. 385 
17. Check the boxes next to Reset password, Read and write account restrictions, Validated write 386 

to DNS host name, and Validated write to service principal name. 387 
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18. Click Next. 388 

 
19. Click Finish. 389 
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2.1.4 Adding Machines to the Domain 390 

1. Right-click the network icon in the task bar on a computer that you wish to add to the domain. 391 
2. Click Open Network and Sharing Center. 392 

 
3. Click the name of the internet adapter. 393 
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4. Click Properties. 394 

 
5. Double-click Internet Protocol Version 4 (TCP/IPv4). 395 
6. Select Use the following DNS server addresses. 396 
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7. Enter the IP address of the DNS server. 397 

 398 
8. Click OK. 399 
9. Click OK. 400 

 401 
10. Click Close. 402 
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11. Navigate to This PC. 403 

 404 
12. Right-click in the window and click Properties. 405 

 406 
13. Click Change Settings. 407 
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 408 
14. Click Change. 409 
15. Select Domain. 410 
16. Enter the domain. 411 

 412 
17. Click OK. 413 
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18. Enter the username and password of an account with privileges to add computers to the 414 
domain. 415 

 416 
19. Click OK. 417 

 418 
20. Click OK when prompted to restart the computer. 419 

2.1.5 Configure Active Directory to Audit Account Activity 420 

1. Open the Start menu. 421 
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 422 
2. Enter “Local Security Policy” in the search bar and open the program. 423 
3. Navigate to Local Policies > Audit Policy. 424 
4. Right-click Audit account management. 425 

 426 
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5. Click Properties. 427 
6. Check the boxes next to Success and Failure. 428 

 429 
7. Click OK.  430 

2.1.6 Configure Reverse Lookup Zones 431 

1. Open DNS Manager by right-clicking the DNS server in Server Manager. 432 
2. Click Reverse Lookup Zones. 433 
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 434 
3. Click Action > New Zone. 435 

 436 

4. Click Next. 437 
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 438 
5. Click Next. 439 

 440 
6. Click Next. 441 
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 442 
7. Click Next. 443 
8. Enter the first three parts of the IP address of the Active Directory (AD)/DNS server (for 444 

example, 192.168.1). 445 

 446 
9. Click Next. 447 
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 448 
10. Click Next. 449 

 450 
11. Click Finish. 451 
12. Click on the newly created reverse lookup zone. 452 
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 453 

13. Right-click in the window and select New Pointer (PTR)…. 454 
14. Enter the IP address of the AD/DNS server. 455 
15. Enter the hostname of the AD/DNS server. 456 

 457 

16. Click OK. 458 
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 459 

2.2 Microsoft Exchange Server 460 

As part of our enterprise emulation, we include a Microsoft Exchange server. This section covers the 461 
installation and configuration process used to set up Microsoft Exchange on a Windows Server 2012 R2 462 
machine. 463 

2.2.1 Install Microsoft Exchange 464 

1. Run Exchange2016-x64.exe. 465 
2. Choose the directory for the extracted files. 466 

 467 
3. Click OK. 468 
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 469 

4. Enter the directory and run setup.exe.  470 
5. Select Connect to the Internet and check for updates. 471 
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 472 
6. Click Next. 473 
7. Wait for the check to finish. 474 
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 475 
8. Click Next. 476 
9. Wait for the copying to finish. 477 
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 478 
10. Click Next. 479 
11. Click I accept the terms in the license agreement. 480 
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 481 
12. Click Next.  482 
13. Click Use Recommended Settings. 483 
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 484 
14. Click Next.  485 
15. Check Mailbox role. 486 
16. Check Automatically install Windows Server roles and features that are required to install 487 

Exchange Server. 488 
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 489 
17. Click Next. 490 
18. Specify the installation path for MS Exchange. 491 
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 492 
19. Click Next.  493 
20. Specify the name for the Exchange organization, e.g., DI. 494 
21. Decide whether to apply split permissions based on the needs of the enterprise. 495 
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 496 
22. Click Next.  497 
23. Select No. 498 
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 499 
24. Click Next.  500 
25. Install any prerequisites listed. 501 
26. If necessary, restart the server and rerun setup.exe, following through steps 3–22 again. 502 
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 503 
27. Click Install.  504 

2.3 Windows Server Hyper-V Role 505 

As part of our simulated enterprise, we include a Windows Hyper-V server. This section covers the 506 
instructions for installing the Windows Server Hyper-V Role on a Windows Server 2012 R2 machine. 507 

The instructions for enabling the Windows Server Hyper-V Role are retrieved from 508 
https://technet.microsoft.com/en-us/library/hh846766(v=ws.11).aspx and are replicated below for 509 
preservation and ease of use. 510 

2.3.1 Production Installation 511 

1. In Server Manager on the Manage menu, click Add Roles and Features. 512 

https://technet.microsoft.com/en-us/library/hh846766(v=ws.11).aspx
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 513 
2. On the Before you begin page, verify that your destination server and network environment are 514 

prepared for the role and feature you want to install.  515 

 516 
3. Click Next. 517 
4. On the Select installation type page, select Role-based or feature-based installation. 518 
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 519 
5. Click Next. 520 
6. On the Select destination server page, select a server from the server pool. 521 

 522 
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7. Click Next. 523 
8. On the Select server roles page, select Hyper-V. 524 
9. To add the tools that you use to create and manage virtual machines, click Add Features. 525 

 526 
10. Click Next. 527 
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 528 
11. Click Next. 529 
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 530 
12. Click Next. 531 
13. On the Create Virtual Switches page, select the appropriate options. 532 
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 533 
14. Click Next.  534 
15. On the Virtual Machine Migration page, select the appropriate options. 535 

 536 
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16. Click Next. 537 
17. On the Default Stores page, select the appropriate options. 538 

 539 
18. Click Next.  540 
19. On the Confirm installation selections page, select Restart the destination server automati-541 

cally if required. 542 
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 543 

20. Click Install. 544 
21. When installation is finished, verify that Hyper-V installed correctly. Open the All Servers page 545 

in Server Manager, and select a server on which you installed Hyper-V. Check the Roles and 546 
Features tile on the page for the selected server. 547 

2.4 MS SQL Server 548 

As part of both our enterprise emulation and data integrity solution, we include a Microsoft SQL Server. 549 
This section covers the installation and configuration process used to set up Microsoft SQL Server on a 550 
Windows Server 2012 R2 machine. 551 

2.4.1 Install and Configure MS SQL 552 

1. Acquire SQL Server 2014 installation media. 553 
2. Locate the installation media in the machine and click on SQL2014_x64_ENU to launch SQL 554 

Server Installation Center. 555 
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 556 

3. On the left menu, select Installation. 557 

 558 
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4. Select New SQL Server stand-alone installation or add features to an existing installation. This 559 
will launch the SQL Server 2014 setup. 560 

5. In the Product Key section, enter your product key. 561 

 562 

6. Click Next. 563 
7. In the License Terms section, read and click I accept the license terms. 564 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 76 

 565 

8. Click Next.  566 
9. In the Install Rules section, note and resolve any further conflicts.  567 
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 568 

10. Click Next. 569 
11. In the Setup Role section, select SQL Server Feature Installation.  570 
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 571 

12. Click Next. 572 
13. In the Feature Selection section, select the following options: 573 

a. Database Engine Services 574 
b. Client Tools Connectivity 575 
c. Client Tools Backwards Compatibility 576 
d. Client Tools SDK 577 
e. Management Tools – Basic 578 
f. Management Tools – Complete 579 
g. SQL Client Connectivity SDK 580 
h. Any other desired features 581 
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 582 

14. Click Next. 583 
15. In the Instance Configuration section, select Default instance. 584 
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 585 

16. Click Next. 586 

 587 
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17. In the Server Configuration section, click Next. 588 
18. In the Database Engine Configuration section, make sure Mixed Mode is selected. 589 
19. Add all desired users as Administrators under Specify SQL Server Administrators by pressing 590 

Add Current User. 591 
a. For Domain accounts, simply type in $DOMAINNAME\$USERNAME into Enter the 592 

object names to select text box. 593 
b. Click OK. 594 
c. For local computer accounts, click on locations and select the computer’s name. 595 
d. Click OK. 596 
e. Type the username into the Enter the object names to select text box. 597 
f. Once you are finished adding users, click Next. 598 

 599 

20. In the Ready to install section, verify the installation and click Install. 600 
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 601 

21. Wait for the installation to finish.  602 

 603 
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22. Click Close. 604 

2.4.2 Open Port on Firewall 605 

1. Open Windows Firewall with Advanced Security. 606 

 607 
2. Click Inbound Rules. 608 
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 609 
3. Click New Rule. 610 
4. Select Port. 611 
5. Click Next.  612 
6. Select TCP and Specific local ports. 613 
7. Type 1433 into the text field. 614 
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 615 
8. Click Next. 616 
9. Select Allow the connection. 617 
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 618 
10. Click Next. 619 
11. Select all applicable locations. 620 
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 621 
12. Click Next.  622 
13. Name the rule Allow SQL Access. 623 
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 624 
14. Click Finish. 625 

2.4.3 Add a New Login to the Database 626 

1. Open SQL Server Management Studio. 627 
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 628 
2. Click Connect to connect to the database. 629 
3. In the Object Explorer window, expand the Security folder. 630 

 631 
4. Right-click on the Logins folder and click New Login…. 632 
5. Input the desired user. 633 
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 634 
6. Click OK. 635 

2.5 Microsoft IIS Server 636 

As part of our enterprise emulation, we include a Microsoft IIS server. This section covers the 637 
installation and configuration process used to set up Microsoft Exchange on a Windows Server 2012 R2 638 
machine. This was conducted on the same machine as in Section 2.4.  639 

2.5.1 Install IIS 640 

1. Open Server Manager. 641 
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 642 
2. Click Add Roles and Features.643 

 644 

3. Click Next. 645 
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4. Select Role-based or feature-based installation.646 

 647 
5. Click Next. 648 
6. Select MSSQL (or the correct Windows Server name) from the list.649 

 650 
7. Click Next. 651 
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 652 

8. Check the box next to Web Server (IIS).653 

 654 
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9. Click Add Features.655 

 656 
10. Click Next. 657 
11. Ensure that all desired features are selected.658 

 659 
12. Click Next. 660 
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 661 

13. Click Next.  662 
14. Ensure that Default Document, Directory Browsing, HTTP Errors, Static Content, HTTP Logging, 663 

and any other desired Role services are selected.664 

 665 
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15. Click Next. 666 

 667 

16. Click Install. 668 

 669 
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17. Wait for the installation to complete.670 

 671 
18. Click Close. 672 
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2.5.2 IIS Configuration 673 

1. Open Windows Explorer and click This PC.674 

 675 
2. Right-click and select Create Folder. 676 
3. Name the folder www.677 

 678 
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4. Open the Internet Information Services (IIS) Manager.679 

 680 
5. Click the arrow next to MSSQL (or the chosen name of the server). 681 
6. Click Sites. 682 

 683 

7. Click Add Website…. 684 
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 685 
8. Enter the desired site name. 686 

 687 
9. Click … under Physical path:. 688 
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 689 

10. Locate and select the folder created in step 3.690 

 691 

11. Click OK.  692 
12. Set Type to http and Port to 80. 693 
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13. Ensure that the IP address and Host name fields are filled in with the correct information for 694 
the machine. 695 

14. Ensure that Start Website immediately is selected.696 

 697 
15. Click OK. 698 

 699 

2.6 GreenTec WORMdisks 700 

See the Installation of GreenTec Command Line Utilities document, which should accompany the 701 
installation disk, for a detailed guide on how to install the GreenTec command line utilities. 702 
Furthermore, refer to the GT_WinStatus User Guide, which should also accompany the installation disk, 703 
for instructions on how to effectively use GreenTec WORMdisks to preserve data. Read these 704 
instructions carefully, as locking GreenTec WORMdisks can result in making some or all of the disk or 705 
the entire disk unusable. Having portions of the disk or the entire disk permanently locked is sometimes 706 
desirable, but it is dependent on the needs of your organization, e.g., if you want to store backup 707 
information or logs securely.  708 

The GT_WinStatus User Guide provides instructions for locking and temporarily locking disk sectors. In 709 
this practice guide, we will not include instructions on when to lock GreenTec WORMdisks. However, we 710 
will provide instructions detailing how to save data to these disks and various commands used in 711 
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manipulating the disks. Below, find descriptions of some commands useful for automation of GreenTec 712 
WORMdisks. Actual automation of these disks will vary per organization. 713 

2.6.1 Format GreenTec WORMdisks 714 

To format GreenTec WORMdisks for use, the following command can be used. 715 

> gt_format.exe <disk number> /parts:<number of parts> /label:<id> 716 

This command can be used to split a disk into a specified number of partitions, with each partition being 717 
labeled according to the label id specified. 718 

For example, this command will split drive 1 into four parts, labeled DI001, DI002, DI003, and DI004: 719 

> gt_format.exe 1 /parts:4 /label:DI 720 

Formatting drive 1 partition 1 file system NTFS label "DI001" 721 

Format successful 722 

Formatting drive 1 partition 2 file system NTFS label "DI002" 723 

Format successful 724 

Formatting drive 1 partition 3 file system NTFS label "DI003" 725 

Format successful 726 

Formatting drive 1 partition 4 file system NTFS label "DI004" 727 

Format successful 728 

2.6.2 Obtain Status Information About GreenTec WORMdisks 729 

To verify information about GreenTec WORMdisks, use the following command. 730 

> wvlist.exe <drive number> 731 

This command can be used to display basic information about a drive, such as the amount of space of 732 
each partition, whether it is a WORMdisk, whether they have been locked, and what drive letter to 733 
which they are mapped.  734 

For example, this command will list the characteristics of drive 1. 735 
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> wvlist.exe 1 736 

  WVLIST: List WORM Volume (WDV) Status on Physical WORMdisks(tm). 737 

    Copyright (C) 2015 GreenTec-USA, Inc. All rights reserved. 738 

          Drive#=1   Type=ATA    F/W=GT5G   Size=500{GB) 739 

              > IS WORM          > IS *NOT* Finalized 740 

             ****  WORMdisk Volume (WDV) Info  **** 741 
             WDV #   TB  ENFORCED  GREENTEC  TLOCKED 742 
             <---> <---> <------>  <------>  <-----> 743 
              001  0.125       NO       YES       NO G:\ 744 
              002  0.125       NO       YES       NO H:\ 745 
              003  0.125       NO       YES       NO I:\ 746 
              004  0.125       NO       YES       NO J:\ 747 

2.6.3 Map GreenTec WORMdisks to Drive Letters 748 

1. To unmap a partition from a drive letter, use the following command: 749 

> wvmap.exe <drive letter>: 750 

For example,  751 

> wvmap.exe H: 752 

will unmap H:, making it available for mapping to another partition. 753 

2. To map a partition to a drive letter, use the following command: 754 

> wvmap.exe <drive letter>: <drive number>.<partition number> 755 

For example,  756 

> wvmap.exe H: 1.2 757 

will map the second partition of drive 1 to H:, making files available through accessing that drive 758 
letter. 759 

3. To map the next partition to a drive letter, use the following command: 760 

> wvnext.exe <drive letter>: 761 
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For example, if H: is mapped to partition 2 of drive 1 (1.2) 762 

> wvnext.exe H: 763 

will attempt to map H: to partition 3 of drive 1 (1.3). 764 

2.6.4 Activate Write Protection in GreenTec WORMdisks 765 

1. Running GT_WinStatus.exe will open the Graphical User Interface (GUI), which displays various 766 
information such as drive mappings, partitions, total space, and space used, as well as a range 767 
of other options.  768 

 769 

2. More columns can be added by right-clicking anywhere in the Active window, opening the 770 
Settings window. 771 
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 772 

3. In the Settings window, User Field 1 and User Field 2 are for any metadata to be stored for a 773 
drive. Pre: runs a script prior to finalizing a drive, and Post: runs a script after finalizing a drive.  774 

4. Also, from the Settings window, right-clicking on Critical Threshold or Warning Threshold will 775 
allow the user to set up alert preferences for drives that are nearly full (at a configurable 776 
percent value). 777 
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 778 

5. To display the GUI with options to lock and enforce locks on drives, the following command 779 
must be used to start the GUI:  780 

> GT_WinStatus.exe /tlock /enf 781 
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6. This will add columns called TLock and Enforce (as well as the ability to use the Finalize 782 
column).783 

 784 
7. The TLock column temporarily locks/unlocks a partition of the drive. This is useful to prevent 785 

modification during times when modification should be disallowed. 786 

 787 

8. The Enforce column is a permanent incremental lock. This means that it permanently prevents 788 
modification for the selected volume of a drive as well as all volumes that come before that 789 
volume on the drive. Once these sections are enforced, they cannot be written to ever again. 790 
This functionality is particularly useful in protecting data or backups that must never be 791 
modified, but as the enforce function is permanent, it must be used carefully. 792 

9. The Finalize column permanently locks the entire drive. This is useful when a drive is full and no 793 
longer needs to be written to. Data can still be read and copied from this drive to other places, 794 
but no write actions will be possible after this is used, so it also must be used carefully. 795 

Important: The following functions in steps 8 and 9 will permanently lock portions of the 
drive, making them read-only. 

The Enforce function permanently locks all volumes up to the enforced volume. 

The Finalize function permanently locks the entire drive. 
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2.7 CryptoniteNXT 796 

See the CryptoniteNXT 2.6.2 Unified Installation Guide, which should accompany the device for a 797 
detailed guide on how to install CryptoniteNXT on the provided device. 798 

The CryptoniteNXT 2.6.2 Unified Installation Guide provides a full installation on both the 799 
CryptoniteNXT device and the management workstation. When finished, it should be possible to log in 800 
on the management workstation and interact with the CryptoniteNXT ACC GUI. Instructions are 801 
provided below for performing various useful functions, including adding new devices/users, as well as 802 
creating policy, but specific recommendations for policy are not provided, as those will be specific to the 803 
organization. Some integrations with other security products used in this guide will be provided, as 804 
exceptions for those products in CryptoniteNXT are often necessary for their functionality. 805 

2.7.1 Configure Cryptonite NXT  806 

2.7.1.1 Verify a New Device 807 

1. Open the CryptoniteNXT ACC GUI application. 808 

 809 
2. Click OK.  810 
3. Enter the password for the account created during the installation. 
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4. Click OK. 811 

 812 
5. Click Enable Editing at the top of the application.  813 
6. Click the Endpoints tab. 814 

 815 
7. Click the Unverified tab. Any new devices connected to the network should appear here, if 816 

configured to use Dynamic Host Configuration Protocol (DHCP). 817 
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 818 
8. Click the machine to verify. 819 
9. Enter a name.  820 
10. Enter a description of the machine. 821 
11. Select an owner if desired. If not selected, the owner will be the first user to log in to 822 

CryptoniteNXT on the machine. 823 
12. Leave Inbound gateway: as NOT SET to have it choose a default gateway. 824 
13. Leave External ingress (inbound) IPv4 Address: blank. 825 
14. Ensure the box next to Also use external ingress IP, if set, for egress (outbound) traffic is 826 

checked. 827 
15. Set Status: to Verified. 828 

 829 
16. Click Yes.  830 
17. Click Save. 831 
18. The machine should now appear in the Verified tab.  832 
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2.7.1.2 Create a New User 833 

1. Go to the Policy tab. 834 

 835 
2. Right-click in the Users window and select New User. 836 
3. Enter the username, and uncheck the box next to Auto-generate and distribute first user TOTP 837 

key to the portal. 838 
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 839 

4. Click OK. 840 

 841 
5. The new user should show up in the Users window. Click the key icon for the newly created user 842 

under Auth Type. 843 
6. Decide on an authentication method for the user. (Note: It is not recommended to use 844 

passwords, but as this authentication decision depends on the needs of the organization, 845 
passwords are used for the purposes of this practice guide.) 846 
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 847 
7. Click Save.   848 

 849 
8. On the client machine, the user should be required to sign in on the CryptoniteNXT portal to 850 

access the internet. Authenticate using the newly created user. 851 
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2.7.1.3 Create a New Policy 852 

Creating policy in CryptoniteNXT essentially requires specifying allowed types of traffic. To do this, 853 
source groups and destination groups are created.  854 

1. To create a source group, right-click in the Source Groups window and select New Source 855 
Group. 856 

2. Enter the name of the group.  857 

 858 

3. Click OK. 859 
4. The newly created group should appear in the Source Groups window. 860 
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5. In the Endpoints window, click the arrow button under the Source Groups column for any 861 
machines to be added to this Source Group. 862 

6. Select the newly created group (or groups). 863 
7. Click the >> button to add the endpoint to this group.  864 

 865 
8. Click Save. 866 
9. The group should show under the Source Groups column for those endpoints. 867 
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 868 

Destination groups are used to govern the allowed destinations of endpoints within certain source 869 
groups. While destination groups can be created according to organizational property, this example 870 
uses an existing group, all-traffic.  871 

1. To allow or prevent the use of ping, we add it to the all-traffic group. In the Access Control 872 
Policies window, right-click on the row labeled To: ‘all-traffic’ and select New Access 873 
Control Policy Entry. 874 

 875 
2. Click the arrow button under the Source Groups column. 876 
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3. Select the newly created source group. 877 
 878 

 879 
4. Click the >> button. 880 

 881 
5. Click Save. 882 
6. Select the Protocol. In this case, to prevent the machine from using ping, we choose ICMP.  883 
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 884 
7. Enter the port range that this traffic can operate on. 885 

 886 
8. Select INVISIBLE for the Action column. 887 
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 888 
9. This will prevent the members of this group from using ping. 889 
10. To allow the members of this group to use ping, delete this rule. Right-click the entry and 890 

select Delete Access Control Policy Entries. 891 

 892 
11. Add the newly created group to the existing policy entry by clicking the arrow for that entry 893 

under Source Groups.  894 
12. Select the newly created group. 895 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 121 

 896 
13. Click the >> button. 897 

 898 
14. Click Save. 899 
15. Click Stop Editing when finished. 900 
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 901 
16. Now, the new machine should be allowed to use ping. With these policies it is possible to 902 

manage all traffic through the specification of groups, ports, and protocols. 903 

2.7.2 Integrate CryptoniteNXT with Active Directory 904 

In this section, devices listed in Active Directory will be imported into CryptoniteNXT. For this to be 905 
successful, the DNS server must have reverse lookup zones configured for the AD server. Please see 906 
Section 2.1.6 for setting up reverse lookup zones on the AD/DNS server. 907 

2.7.2.1 Generate a Keytab File 908 

1. Open Active Directory Users and Computers. 909 
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 910 

2. Right-click the Users folder in the left pane and select New > User. 911 
3. Enter a name for this user, such as nxtadmin. 912 

 913 
4. Click Next. 914 
5. Enter a password for this user, and set the password policy. 915 
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 916 
6. Click Next. 917 

 918 
7. Click Finish. 919 
8. Right-click the newly created user and select Add to a group…. 920 
9. Enter DnsAdmins. 921 
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 922 

10. Click OK. 923 
11. Right-click the Users folder in the left pane and select New > Group. 924 
12. Enter NXTAdmins as the group name. 925 

 926 

13. Click OK. 927 
14. Right-click the Users folder in the left pane and select New > Group. 928 
15. Enter NXTNodes as the group name. 929 
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 930 

16. Click OK. 931 
17. Click Computers in the left pane. 932 
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 933 

18. Right-click Computers in the left pane and select New > Computer. 934 
19. Enter the name of the acc server for CryptoniteNXT (Node A).  935 
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 936 

20. Click OK. 937 
21. Right-click the newly created computer and select Add to a group…. 938 
22. Enter NXTAdmins in the box labeled Enter the object names to select (examples):.  939 

 940 
23. Click OK. 941 
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 942 
24. Click OK. 943 
25. Open a new Administrator PowerShell window. 944 
26. Enter the following command, using the newly created user in the DnsAdmins group: 945 

> ktpass -princ DNS/<user>.<domain>@<DOMAIN> -mapuser 946 
<user>@<domain> -pass <user password> -out .\<keytab filename> 947 
-ptype krb5_nt_principal -crypto all 948 
 949 
For example: 950 
> ktpass -princ DNS/nxtadmin.di.ipdr@DI.IPDR -mapuser 951 
nxtadmin@di.idpr -pass password123 -out .\keytab.out -ptype 952 
krb5_nt_principal -crypto all 953 
 954 

27. This will produce a keytab file. Copy this file to the CryptoniteNXT Management 955 
workstation. 956 

2.7.2.2 Import Keytab File to ACC 957 

1. On the management workstation, open the CryptoniteNXT ACC GUI. 958 

 959 
2. Click OK. 960 
3. Enter the password configured during installation. 961 
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 962 
4. Click OK. 963 

 964 
5. Click Enable Editing. 965 
6. Click the Integration tab. 966 
7. Check the box next to Use Keytab file (for LDAP and/or DDNS):.  967 
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 968 
8. Click Select New Keytab. 969 

 970 
9. Click OK. 971 
10. Navigate to the keytab file. 972 

 973 

11. Click Choose.  974 
12. Click Save. 975 
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13. Under LDAP, enter the Domain name (such as DI.IPDR) and the Server name (such as ad-976 
dns). 977 

14. Check the box next to Enable Dynamic DNS:. 978 
15. Enter the fully qualified domain name of the DNS server (such as ad-dns.di.ipdr). 979 
16. Enter the Kerberos realm (such as DI.IPDR). 980 
17. Enter the domain suffix (such as di.ipdr). 981 

 982 

18. Click Save. 983 
19. Click the Policies tab. 984 

 985 
20. Right-click in the Access Control Policies Window and select New Destination Group. 986 
21. Enter kerberos. 987 
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 988 
22. Click OK. 989 
23. Select TCP under Action. 990 
24. Enter 53:53 under Port Range. 991 
25. Select VISIBLE under Action. 992 
26. Click the arrow under Source Groups. 993 
27. Select $NXT$Admins. 994 
28. Click the >> button. 995 

 996 

29. Click Save. 997 
30. Right-click the To: ‘kerberos’ destination group, and select New Access Control Policy 998 

Entry. 999 
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 1000 
31. Repeat steps 21–29, but replace 53:53 with 88:88.  1001 
32. In the Gateway Nodes window, click the arrow under Egress (Dest) Groups. 1002 
33. Select “kerberos”. 1003 
34. Click the >> button. 1004 

 1005 
35. Click Save. 1006 
36. In the Endpoints window, click the arrow under Source Groups associated with the 1007 

Administration Control Center (ACC).  1008 
37. Select $NXT$Admins. 1009 
38. Click the >> button. 1010 
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 1011 
39. Click Save.  1012 

 1013 
40. Return to the Integration tab. 1014 
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 1015 
41. Click Sync. 1016 

2.8 Backups 1017 

For this capability we use an integration of two open-source tools: Duplicati and FileZilla. FileZilla acts 1018 
as a File Transfer Protocol (FTP) (over TLS) server component, while Duplicati acts as an encrypted 1019 
backup client. This section details the installation and integration of both tools, as well as the process 1020 
for creating a backup schedule, but does not provide specific recommendations on backup frequency or 1021 
backup targets as those are specific to the organization. 1022 

2.8.1 FileZilla FTPS Server Setup 1023 

1. Run FileZilla_Server-0_9_60_2.exe. 1024 
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 1025 
2. Click I Agree. 1026 
3. Select Standard from the drop-down menu. 1027 

 1028 
4. Click Next. 1029 
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 1030 
5. Click Next. 1031 
6. Select Install as service, started with Windows (default) from the drop-down. 1032 
7. Specify a port (for the administrator interface to run on) if desired (the default is 14147). 1033 
8. Ensure the box next to Start Server after setup completes is checked. 1034 

 1035 

9. Click Next. 1036 
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 1037 
10. Click Install. 1038 

 1039 
11. Click Close. 1040 

2.8.2 FileZilla Configuration 1041 

1. When the administrator interface comes up, ensure that the port is correct and click Connect. 1042 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 140 

2. Click Edit > Settings. 1043 

 1044 
3. Click FTP over TLS settings. 1045 

 1046 
4. Check the box next to Enable FTP over TLS support (FTPS). 1047 
5. Check the box next to Disallow plain unencrypted FTP. 1048 
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 1049 
6. Click Generate new certificate.  1050 

 1051 
7. Select 4096 bit for Key Size. 1052 
8. Enter the information for the certificate specific to your organization. 1053 
9. For the common name, enter the address of the server on which this is installed. 1054 
10. Click Browse and specify a file location for the certificate. 1055 
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 1056 

11. Click Generate certificate. (The file now contains both the private key and the certificate. These 1057 
can be separated, for ease of use, as long as the correct file locations are specified in the 1058 
settings.) 1059 

 1060 
12. Click OK. 1061 
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13. Enter a password for the key. 1062 
14. Ensure the box next to Force PROT P to encrypt file transfers when using FTP over TLS is 1063 

checked. 1064 
15. Ensure the box next to Require TLS session resumption on data connection when using PROT P 1065 

is checked. 1066 

 1067 
16. Click Passive mode settings. Check the box next to Use custom port range. (This is necessary in 1068 

cases of a local server behind Network Address Translation (NAT) or a firewall.) 1069 
17. Enter a range of ports for passive mode to use. Ensure that these ports are allowed through the 1070 

firewall. 1071 
18. Select Use the following IP. 1072 
19. Enter the server address. 1073 
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 1074 

20. Click OK. 1075 

2.8.3 Add a User to FileZilla 1076 

1. In the FileZilla administrator interface, click Edit > Users. 1077 

 1078 

2. Click Add. 1079 
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 1080 

3. Enter a name for the user. 1081 

 1082 

4. Click OK. 1083 
5. Check the box next to Password. 1084 
6. Enter a password for the user. 1085 

 1086 
7. Check the box next to Force TLS for user login. 1087 
8. Click Shared Folders. 1088 
9. Click Add, under Shared Folders. 1089 
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 1090 
10. Select a place for backups for this user to be stored. 1091 
11. Check the boxes next to Write and Append, under Files. 1092 
12. Check the box next to Create, under Directories. 1093 
13. Select this entry and click Set as home dir. 1094 

 1095 
14. Click OK. 1096 

2.8.4 Duplicati Client Installation (Windows) 1097 

1. On the client machine, run duplicati-2.0.3.3_beta_2018-04-02-x64.msi. 1098 
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 1099 
2. Click Next. 1100 
3. Check the box next to I accept the terms in the License Agreement. 1101 

 1102 
4. Click Next. 1103 
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 1104 
5. Click Next. 1105 

 1106 
6. Click Install. 1107 
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 1108 
7. Click Finish. 1109 
8. Start Duplicati by going to localhost:8200. 1110 

2.8.5 Duplicati Client Installation (Ubuntu) 1111 

1. Install mono by using the following command: 1112 
 1113 
> sudo apt install mono-runtime 1114 
 1115 

2. Download the Duplicati package by running the following command: 1116 
 1117 
> wget 1118 
https://github.com/duplicati/duplicati/releases/download/v2.0.3.91119 
-2.0.3.9_canary_2018-06-30/duplicati_2.0.3.9-1_all.deb 1120 
 1121 

3. Install Duplicati by using the following command: 1122 
 1123 
> sudo dpkg -i duplicati_2.0.3.9-1_all.deb 1124 
 1125 

4. Run Duplicati as a service by running the following command: 1126 
 1127 
> sudo systemctl enable duplicati 1128 

 1129 
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2.8.6 Configure Duplicati 1130 

1. When it first starts, Duplicati will have a First run setup. 1131 

 1132 
2. Click Yes. 1133 
3. Check the box next to Password. 1134 

 1135 
4. Enter a password. 1136 
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 1137 
5. Click OK. 1138 
6. On the home page, click Add backup. 1139 
7. Select Configure a new backup.  1140 

 1141 
8. Click Next. 1142 
9. Enter a name for the backup. 1143 
10. Select AES-256 encryption, built in from the drop-down menu. 1144 
11. Enter a password. 1145 
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 1146 
12. Click Next. 1147 
13. Select FTP for Storage Type. 1148 
14. Check the box next to Use SSL. 1149 
15. Enter the server name and port (default: 21) of the server running FileZilla. 1150 
16. Enter a path for the backup to be stored in (within the specified shared directory of the user). 1151 
17. Enter the username and password created for FileZilla. 1152 

 1153 
18. Click Test Connection (if the connection fails, ensure that the port is allowed in your server’s 1154 

firewall). 1155 
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19. If you receive an error about a certificate, you can go to Advanced Options, select accept-1156 
specified-ssl-hash, and enter the thumbprint from the server’s certificate. 1157 

 1158 
20. Click Next. 1159 
21. Select the folders on the local machine to be backed up to the server according to your 1160 

organization’s needs. 1161 

 1162 
22. Click Next. 1163 
23. Select a backup schedule according to your organization’s needs. 1164 
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 1165 

24. Click Next. 1166 
25. Select any other options according to your organization’s needs. 1167 

 1168 

26. Click Save. 1169 
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 1170 
27. When finished, you can choose to Run now to start a backup immediately.  1171 

2.9 Semperis Active Directory Forest Recovery 1172 

This section details the installation of Semperis Active Directory Forest Recovery (ADFR), a tool used 1173 
for backing up and restoring Active Directory forests. This installation requires both a copy of SQL Server 1174 
Express as well as the Semperis Wizard. See the Semperis ADFR v2.5 Technical Requirements 1175 
document for specifics on the requirements. For a Windows Server 2012 R2 installation, simply meet 1176 
the following requirements:  1177 

• .NET Framework Version 3.5 SP1 1178 
• .NET Framework Version 4.5.2 or later 1179 
• not joined to the Active Directory domain it is protecting 1180 
• SQL Express is not installed on the machine, but the installer SQLEXPR_x64_ENU.exe is 1181 

downloaded. 1182 

2.9.1 Install Semperis ADFR 1183 

1. Place the SQLEXPR_x64_ENU.exe installer in a directory called Setup, and ensure that the 1184 
Semperis Wizard is adjacent to the Setup folder (not inside it). 1185 
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 1186 
2. If prompted to restart the computer, do so. 1187 
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 1188 
3. Click I Agree. 1189 
4. Select Evaluation License. 1190 
5. Select Active Directory Forest Recovery. 1191 
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 1192 
6. Click the > button. 1193 

 1194 
7. Click OK. 1195 
8. Wait for the installation to complete. 1196 
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 1197 
9. Click the > button. 1198 
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 1199 

10. Click Finish. 1200 
11. There should now be a shortcut on the desktop linking to the web console for Semperis ADFR. 1201 
12. On the login page, enter the full domain as well as the NetBIOS name. 1202 
13. Enter the username and password of an administrator on the domain. 1203 
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 1204 

14. Click Login. 1205 
15. Check the box next to any domain controllers that should be backed up. 1206 

 1207 
16. Click Run Action. 1208 
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17. Enter the password in the prompt. 1209 

 1210 
18. Click OK. 1211 

 1212 

19. Click Close. 1213 
20. After the installation finishes, click Login at the top of the page. 1214 
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21. Enter the login credentials for the domain. 1215 

 1216 
22. Click Login. 1217 
23. Create a recovery password. (Note: In the event of a restoration, Active Directory will 1218 

potentially be unavailable, so a separate password that is not domain-associated is needed here 1219 
for restorations.) 1220 
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 1221 
24. Set recovery questions for the password. 1222 
25. Click Set. 1223 

2.9.2 Create a Backup Schedule for the Domain Controller 1224 

1. Click the Backup Settings tab.  1225 
2. Enter a name for the rule.  1226 
3. Select the days and times that the domain controller should be backed up. 1227 
4. Enter the maximum number of backups that should be kept. (Note: The oldest backup will be 1228 

deleted upon creation of a new backup, which would exceed this maximum.) 1229 
5. Ensure that Encrypt and Rule enabled are both turned on. 1230 
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 1231 
6. Click Add Backup Group.  1232 

 1233 

7. Click Create new Backup Group. 1234 
8. Enter a name for the backup group. 1235 
9. Select the domain controllers to be part of the backup group. 1236 
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 1237 

10. Click OK. 1238 
11. Select the newly created backup group. 1239 

 1240 
12. Click OK. 1241 
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 1242 
13. Click Create Rule. 1243 

2.9.3 Recover the Active Directory Forest from a Backup 1244 

1. Open the Semperis ADFR web console. 1245 
2. Select Recovery Panel from the drop-down. 1246 
3. Select the Domain that you wish to recover. 1247 
4. Enter the username and password. 1248 
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 1249 
5. Click Login.  1250 

 1251 
6. Select an action based on the recovery needs of the organization. In this example we select 1252 

Domain Controller Restore. 1253 
7. Provide the information for the restoration, namely the domain, the domain controller, and 1254 

which backup to use. 1255 
 1256 
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 1257 
8. Click Restore.  1258 

 1259 

9. Click Start Restore to begin the restoration process. 1260 
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 1261 
10. Click Next when the restoration finishes.  1262 

2.10  Semperis Directory Services Protector 1263 

This section details the installation of Semperis Directory Services Protector (DSP), a tool used for 1264 
monitoring Active Directory environments. This installation requires both a copy of SQL Server Express 1265 
as well as the Semperis Wizard. See the Semperis DS Protector v2.5 Technical Requirements document 1266 
for specifics on the requirements. For a Windows Server 2012 R2 installation, simply meet the following 1267 
requirements:  1268 

• .NET Framework Version 3.5 SP1 1269 
• .NET Framework Version 4.5.2 or later 1270 
• joined to the Active Directory domain it is protecting 1271 
• either the installer for SQL Express Advanced or connection information and credentials for a 1272 

full version of Microsoft SQL (MSSQL) 1273 

2.10.1  Configure Active Directory for Semperis DSP 1274 

1. Open Active Directory Users and Computers. 1275 
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 1276 
2. Right-click Users in the left pane and select New > User.  1277 
3. Enter the information for a new user for the DSP service.  1278 

 1279 
4. Click Next.  1280 
5. Enter a password twice for this user. 1281 
6. Set the password policy. 1282 
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 1283 
7. Click Next. 1284 
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 1285 
8. Click Finish. 1286 
9. Open Group Policy Management. 1287 
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 1288 
10. Right-click Domains > DI.IPDR > Domain Controllers > Default Domain Controllers Policy and 1289 

click Edit. 1290 
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 1291 
11. Navigate to Computer Configuration > Policies > Windows Settings > Security Settings > 1292 

Advanced Audit Policy Configuration > Audit Policies > Account Management. 1293 
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 1294 

12. Edit the Audit User Account Management field by double-clicking it. 1295 
13. Check the box next to Configure the following audit events. 1296 
14. Check the box next to Success. 1297 
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 1298 
15. Click OK. 1299 
16. Go to Audit Policies > DS Access.  1300 
17. Double-click Audit Directory Service Changes. 1301 
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 1302 
18. Check the box next to Configure the following audit events. 1303 
19. Check the box next to Success. 1304 
20. Click OK. 1305 
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 1306 
21. Open Active Directory Users and Computers. 1307 
22. Ensure that View > Advanced Features is enabled. 1308 
23. Right-click the domain (for example, DI.IPDR) created earlier and click Properties. 1309 

 1310 
24. Click the Security tab. 1311 
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 1312 
25. Click Advanced. 1313 

 1314 
26. Click the Auditing tab. 1315 
27. Click Add. 1316 
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28. Enter Everyone. 1317 

 1318 
29. Click OK. 1319 

 1320 
30. Double-click Everyone. 1321 
31. Check the boxes next to Write all properties, Delete, Delete subtree, Modify permissions, 1322 

Modify owner, All validated writes, All extended rights, Create all child objects, Delete all 1323 
child objects. 1324 
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 1325 

32. Click OK. 1326 

 1327 
33. Click OK. 1328 
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2.10.2  Install Semperis DSP 1329 

1. If you are using a local SQL Express Advanced server, place the SQLEXPRADV_x64_ENU.exe 1330 
installer in a directory called Setup, and ensure that the Semperis Wizard is adjacent to the 1331 
Setup folder (not inside it). If an SQL Express Advanced server is not being used, no Setup folder 1332 
is required. 1333 

 1334 
2. If prompted to restart the computer, do so. 1335 
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 1336 

3. Click I Agree. 1337 
4. Select Evaluation License. 1338 
5. Select Active Directory State Management. 1339 
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 1340 
6. Click the > button. 1341 
7. Enter the username and password of the account created earlier.  1342 
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 1343 
8. Click the > button. 1344 

 1345 
9. Click OK. 1346 
10. Check the box next to Create the following group. 1347 
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 1348 
11. Click OK. 1349 

 1350 
12. Click the > button. 1351 
13. Select the appropriate database option, and enter any required information. 1352 
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 1353 
14. Click the > button. 1354 

 1355 
15. Click OK. 1356 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 189 

 1357 

16. Click the > button after the installation completes. 1358 
17. There should now be a shortcut on the desktop linking to the web console for Semperis DS 1359 

Protector. 1360 
18. On the login page, enter the full domain as well as the NetBIOS name. 1361 
19. Enter the username and password of an administrator on the domain. 1362 
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 1363 
20. Click Login. 1364 
21. Check the box next to the domain controllers that should be monitored by DSP. 1365 

 1366 
22. Click Run Action. 1367 
23. Enter the password for the account. 1368 
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 1369 
24. Click OK. 1370 

 1371 
25. Click Close. 1372 
26. After the agent finishes deploying, click Login at the top of the page and log in. 1373 
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 1374 
27. Click Start Sync. 1375 
28. After this completes, click Settings at the top of the page. 1376 

 1377 
29. Click Audit. 1378 
30. Click Run. 1379 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 193 

 1380 
31. Click Next. 1381 

 1382 
32. Click Next. 1383 
33. Check the boxes next to any Domain Controllers that should be monitored. 1384 
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 1385 
34. Click Run Action. 1386 
35. Enter the password. 1387 

 1388 
36. Click OK. 1389 
37. Wait for the deployment to finish. 1390 
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 1391 
38. Click Next. 1392 

 1393 
39. Click Finish. 1394 

2.11 Micro Focus ArcSight Enterprise Security Manager 1395 

Micro Focus ArcSight Enterprise Security Manager is primarily a log collection/analysis tool with 1396 
features for sorting, filtering, correlating, and reporting information from logs. It is adaptable to logs 1397 
generated by various systems, applications, and security solutions.  1398 
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This installation guide assumes a preconfigured CentOS 7 machine with Enterprise Security Manager 1399 
(ESM) already installed and licensed. This section covers the installation and configuration process used 1400 
to set up ArcSight agents on various machines, as well as some analysis and reporting capabilities. 1401 

Installation instructions are included for both Windows and UNIX machines, as well as for collecting 1402 
from multiple machines. Furthermore, integrations with other products in the build are included in later 1403 
sections. 1404 

2.11.1 Install the ArcSight Console 1405 

1. Run ArcSight-7.0.0.2436.1-Console-Win.exe. 1406 

 1407 
2. Click Next.  1408 
3. Check the box next to I accept the License Agreement. 1409 
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 1410 
4. Click Next. 1411 
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 1412 
5. Click Next. 1413 
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 1414 
6. Click Next. 1415 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 200 

 1416 
7. Click Next. 1417 
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 1418 

8. Click Install. 1419 
9. Select No, I do not want to transfer the settings. 1420 
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 1421 
10. Click Next. 1422 
11. Select Run console in default mode. (This can be changed later according to your organization’s 1423 

compliance requirements.) 1424 

 1425 
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12. Click Next. 1426 

 1427 

13. Click Yes. 1428 
14. Select FIPS 140-2. 1429 

 1430 
15. Click Next. 1431 
16. Enter the hostname of the ESM server for Manager Host Name. 1432 
17. Enter the port that ESM is running on for Manager Port (default: 8443). 1433 
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 1434 
18. Click Next. 1435 
19. Select Use direct connection. 1436 

 1437 
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20. Click Next.  1438 

 1439 
21. Click Next.  1440 
22. Select your preferred browser.  1441 
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 1442 
23. Click Next. 1443 

 1444 
24. Click Next.  1445 
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25. Click Finish. 1446 

 1447 
26. Click Done. 1448 
27. Run ArcSight Console from the Start menu.  1449 
28. Enter the username and password.  1450 
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 1451 
29. Click Login. (If you are unable to connect, ensure that the hostname of the ESM server is 1452 

present in your DNS server.) 1453 
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 1454 
30. Click OK. 1455 

2.11.2  Install Individual ArcSight Windows Connectors 1456 

1. Run ArcSight-7.9.0.8084.0-Connector-Win64.exe. 1457 
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 1458 
2. Click Next. 1459 
3. Enter C:\Program Files\ArcSightSmartConnectors\Windows. 1460 
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 1461 
4. Click Next.  1462 
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 1463 
5. Click Next. 1464 
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 1465 
6. Click Install. 1466 
7. Select Add a Connector. 1467 
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 1468 
8. Click Next. 1469 
9. Select Microsoft Windows Event Log–Native.  1470 
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 1471 
10. Click Next. 1472 
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 1473 
11. Click Next. 1474 
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 1475 
12. Click Next.  1476 
13. Select ArcSight Manager (encrypted).  1477 
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 1478 
14. Click Next. 1479 
15. Enter the hostname, port, username, and password for the ArcSight ESM server.  1480 
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 1481 
16. Click Next. 1482 
17. Enter identifying details about the system (only Name is required). 1483 
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 1484 
18. Click Next.  1485 
19. Select Import the certificate to connector from destination. 1486 
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 1487 
20. Click Next.  1488 
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 1489 
21. Click Next.  1490 
22. Select Install as a service. 1491 
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 1492 
23. Click Next.  1493 
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 1494 
24. Click Next.  1495 
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 1496 
25. Click Next.  1497 
26. Select Exit. 1498 
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 1499 
27. Click Next.  1500 
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 1501 
28. Click Done.  1502 

2.11.3  Install Individual ArcSight Ubuntu Connectors 1503 

1. From the command line, run: 1504 
> sudo ./ArcSight-7.9.0.8084.0-Connector-Linux64.bin 1505 

2. Enter the password if prompted. 1506 
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 1507 
3. Click Next.  1508 
4. Enter /root/ArcSightSmartConnectors/Ubuntu. 1509 

 1510 
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5. Click Next.  1511 

 1512 

6. Click Next. 1513 

 1514 
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7. Click Install. 1515 
8. Select Add a Connector. 1516 

 1517 

9. Click Next.  1518 
10. Select Syslog File. 1519 
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 1520 

11. Click Next.  1521 
12. Enter /var/log/syslog for the File Absolute Path Name. 1522 
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 1523 
13. Click Next.  1524 
14. Select ArcSight Manager (encrypted). 1525 
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 1526 
15. Click Next.  1527 
16. Enter the hostname, port, username, and password for ArcSight ESM. 1528 
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 1529 
17. Click Next. 1530 
18. Enter identifying details about the system (only Name is required). 1531 
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 1532 
19. Click Next.  1533 
20. Select Import the certificate to connector from destination. 1534 
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 1535 
21. Click Next.  1536 
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 1537 
22. Click Next.  1538 
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 1539 
23. Click Next.  1540 
24. Select Exit. 1541 
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 1542 
25. Click Next.  1543 
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 1544 

26. Click Done.  1545 

2.11.4  Install a Connector Server for ESM on Windows 2012 R2 1546 

1. Run ArcSight-7.9.0.8084.0-Connector-Win64.exe. 1547 
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 1548 
2. Click Next. 1549 
3. Enter C:\Program Files\ArcSightSmartConnectors\Windows. 1550 

 1551 
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4. Click Next.  1552 

 1553 
5. Click Next. 1554 

 1555 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 243 

6. Click Install. 1556 
7. Select Add a Connector. 1557 

 1558 
8. Click Next. 1559 
9. Select Microsoft Windows Event Log–Native.  1560 
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 1561 
10. Click Next. 1562 
11. Check the box next to Use Active Directory. 1563 
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 1564 

12. Click Next. 1565 
13. Enter information about your Active Directory server. (It is recommended to create a new 1566 

administrator account for ArcSight to use.) 1567 
14. Set Use Active Directory host results for to Replace Hosts. 1568 
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 1569 

15. Click Next.  1570 
16. Check the boxes under any event types that should be forwarded to this connector, for each 1571 

individual host, e.g., Security, System, Application. 1572 
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 1573 
17. Click Next. 1574 

 1575 
18. Click Next.  1576 
19. Select ArcSight Manager (encrypted).  1577 
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 1578 
20. Click Next. 1579 
21. Enter the hostname, port, username, and password for the ArcSight ESM server.  1580 

 1581 
22. Click Next. 1582 
23. Enter identifying details about the system (only Name is required). 1583 
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 1584 
24. Click Next.  1585 
25. Select Import the certificate to connector from destination. 1586 

 1587 
26. Click Next.  1588 
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 1589 
27. Click Next.  1590 
28. Select Install as a service. 1591 

 1592 
29. Click Next.  1593 
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 1594 
30. Click Next.  1595 

 1596 
31. Click Next.  1597 
32. Select Exit. 1598 
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 1599 
33. Click Next.  1600 

 1601 
34. Click Done.  1602 
35. Note: Ensure that all machines selected do not block traffic from this device through their 1603 

firewalls.  1604 
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2.11.5  Install Preconfigured Filters for ArcSight 1605 

2.11.5.1  Install Activate Base 1606 

1. Go to the ArcSight Content Brain web application (https://arcsightcontentbrain.com/app/) and 1607 
log in. This page allows you to keep track of packages to be installed–what packages should be 1608 
installed depends on the needs of the organization, but the “Activate Base” is required for all 1609 
products.  1610 

 1611 
2. Click the Download link for the Activate Base. (Note: This package should be installed on the 1612 

ArcSight Console, not on the ESM.) 1613 
3. Copy the contents of the zip file to ARCSIGHT_HOME. The default for this is C:\arcsight\Con-1614 

sole\current, assuming a Windows Server. 1615 
4. In PowerShell, navigate to the ARCSIGHT_HOME directory (C:\arcsight\Console\current) and 1616 

run: 1617 
> .\ActivateBaseInstallAndUpdate2540.bat 1618 

https://arcsightcontentbrain.com/app/
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 1619 
5. Enter the hostname of the ArcSight machine, the port (default: 8443), and the username and 1620 

password used to connect to the ESM. 1621 
6. Delete Activate_Base_Updated_2.5.4.0.arb from the ARCSIGHT_HOME directory. 1622 
7. Log in to ArcSight Console.  1623 
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 1624 
8. Under Packages > Shared > All Packages > ArcSight Activate, right-click Activate Base Update 1625 

2.5.4.0, and select Delete Package.  1626 

2.11.5.2  Install Packages 1627 

Once the Activate Base is installed, packages can be installed to monitor for specific types of events. As 1628 
an example, find below instructions for the Malware Monitoring package. 1629 

1. Navigate to the ArcSight Content Brain web application. 1630 
2. Select the Level 1 box labeled Malware. 1631 

 1632 
3. In the Track Execution section, under Associated Packages, you can see the list of packages used 1633 

to address the challenge of Malware Monitoring. In this case, there is just one package, L1– 1634 
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Malware Monitoring–Indicators and Warnings. Click the link to be taken to a download page for 1635 
the package, and download it. (Note: This package should be installed on the ArcSight Console, 1636 
not on the ESM.) 1637 

4. Copy the contents of the zip file to ARCSIGHT_HOME. The default for this is C:\arcsight\Con-1638 
sole\current, assuming a Windows Server. 1639 

5. In PowerShell, navigate to the ARCSIGHT_HOME directory (C:\arcsight\Console\current) and 1640 
run: 1641 
> .\L1-Malware_Monitoring_1.1.0.1.bat 1642 

 1643 
6. Enter the hostname of the ArcSight machine, the port (default: 8443), and the username and 1644 

password used to connect to the ESM. 1645 

2.11.6  Apply Filters to a Channel 1646 

1. In the ArcSight Console, click File > New > Active Channel.  1647 
2. Enter a name for the channel. 1648 
3. Select a time frame.  1649 
4. For Filter, select one the filters that was imported from the packages you installed.  1650 
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 1651 
5. Click OK. All events that match the filter can be displayed in the newly created channel. Filters 1652 

from imported packages can be found under Filters > Shared > All Filters > ArcSight Activate > 1653 
Solutions. 1654 

2.12  Tripwire Enterprise 1655 

Notes: 1656 

This installation requires MSSQL to be installed on a remote server and configured according to the 1657 
instructions in the Tripwire Enterprise 8.6.2 Installation and Maintenance Guide. 1658 

2.12.1  Install Tripwire Enterprise 1659 

1. Ensure that you have an up-to-date version of Oracle Java. You must install both the Java 1660 
Runtime Environment (JRE) and the Java Cryptography Extension (JCE). 1661 

2. Download and run the JRE installer. 1662 
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 1663 
3. Click Install. 1664 
4. Download the JCE and extract the files. 1665 

 1666 
5. Copy the local_policy.jar and US_export_policy.jar files to /lib/security/Unlimited/ and 1667 

/lib/security/Limited in the Java installation directory. 1668 
6. Run install-server-windows-amd64. 1669 
7. Select the Java runtime that was just installed. 1670 

 1671 

8. Click OK. 1672 
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 1673 
9. Click Next.  1674 
10. Select I accept the agreement. 1675 

 1676 
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11. Click Next. 1677 

 1678 

12. Click Next. 1679 
13. The installer should automatically detect the hostname of the system on which Tripwire 1680 

Enterprise is being installed. If it does not, enter the hostname here. 1681 
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 1682 
14. Click Next.  1683 
15. Enter each port number to use for the HTTPS Web Services port, HTTP EMS Integration Port, 1684 

and Tripwire Enterprise RMI port. The RMI port is used for inbound communication from 1685 
Tripwire agents to the server, so ensure that it is allowed through the firewall. 1686 
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 1687 
16. Click Next.  1688 
17. Enter a passphrase to use. 1689 

 1690 
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18. Click Next.  1691 

 1692 

19. Click Next.  1693 
20. Check the box next to Install Real-time Monitoring.  1694 
21. Enter 1169 for Real-time Port. 1695 
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 1696 
22. Click Next.  1697 

 1698 
23. Click Next.  1699 
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24. Check the box next to Open a browser after clicking Finish to continue configuring Tripwire 1700 
Enterprise. 1701 

 1702 

25. Click Finish.  1703 
26. Once at the web address, enter the Services passphrase chosen earlier. 1704 

 1705 
27. Click Login. 1706 

 1707 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 266 

28. Select Microsoft SQL Server for Remote Database Type. 1708 
29. Select SQL Server for Authentication Type. 1709 
30. Enter login details for the account created during the MSSQL setup. 1710 
31. Enter the hostname or IP of the database server. 1711 
32. Enter the port on which the database is operating. 1712 
33. Enter the name of the database to be used for Tripwire Enterprise. 1713 
34. Select the appropriate setting for SSL according to your organization’s needs. 1714 

 1715 
35. Click Test Database Login to ensure the connection is functional. 1716 

 1717 

36. Click Save Configuration and Restart Console.  1718 
37. After the reboot, enter a new administrator password. 1719 
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 1720 
38. Click Confirm and Continue. 1721 

 1722 
39. Click Configure Tripwire Enterprise. 1723 
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 1724 
40. Click Choose File and select the Tripwire Enterprise license file, which should be a .cert file. 1725 
41. Check the boxes next to Change Auditing and Policy Management. 1726 

 1727 
42. Select any available policies desired. 1728 

 1729 
43. Select all the operating systems that you wish to monitor with Tripwire Enterprise.  1730 

 1731 
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44. Set up a schedule for running checks and reports according to your organization’s needs. Leave 1732 
the box next to Enable Checks and Reports unchecked for now. 1733 

 1734 

45. Select Set up the email server at another time. 1735 

 1736 
46. Enter a username and password for a new administrator account for Tripwire Enterprise 1737 

Console. 1738 

 1739 

47. Click Preview Configuration. 1740 

 1741 
48. Click Apply Configuration. 1742 
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 1743 
49. Click Continue to Tripwire Enterprise when the installation finishes. 1744 

2.12.2  Install the Axon Bridge 1745 

1. Ensure that TCP traffic on port 5670 is allowed through the firewall. 1746 
2. Navigate to the Tripwire Enterprise Console installation directory to the /server/data/config 1747 

folder. Copy bridge_sample.properties to bridge.properties. 1748 
3. In the bridge.properties file, find the line that says: 1749 

#tw.cap.bridge.registrationPreSharedKey= 1750 
Remove the “#” character. After the “=” character, enter a password. The password has some 1751 
restrictions, so ensure that it meets the requirements in case the connection fails later. 1752 

4. Restart the TE console by running the following command from an administrative command 1753 
prompt, where <te_root> is the TE installation directory: 1754 

> <te_root>/server/bin/twserver restart 1755 

2.12.3  Install the Axon Agent (Windows) 1756 

1. Download the Axon Agent zip file from the Tripwire customer website 1757 
(https://tripwireinc.force.com/customers), under the Product Downloads tab. 1758 

2. Unzip the file.  1759 
3. To begin the installation, double-click the .msi file in the extracted folder. Note: No installation 1760 

wizard will appear; the installation happens automatically. 1761 

https://tripwireinc.force.com/customers
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4. After the Axon Agent is installed, navigate to C:\ProgramData\Tripwire\agent\config, and copy 1762 
twagent_sample.conf to twagent.conf. 1763 

 1764 
5. Open twagent.conf and find the line that says bridge.host. Remove the “#” character, and 1765 

enter the hostname or IP address of the Axon Bridge server. 1766 
6. In a file called registration_pre_shared_key, enter the value of the preshared key that was set 1767 

in the Axon Bridge.  1768 
7. Restart the Axon Agent Service by opening a command prompt and running the following 1769 

commands: 1770 
> net stop TripwireAxonAgent 1771 
> net start TripwireAxonAgent 1772 

 1773 

2.12.4  Install the Axon Agent (Linux) 1774 

1. Download the Axon Agent .tgz file from the Tripwire customer website 1775 
(https://tripwireinc.force.com/customers), under the Product Downloads tab. 1776 

2. To install the software, run the following commands: 1777 

https://tripwireinc.force.com/customers
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RHEL or CentOS: > rpm -ivh <installer_file> 1778 
Debian or Ubuntu: > dpkg -i <installer_file> 1779 

3. Navigate to /etc/tripwire/ and copy twagent_sample.conf to twagent.conf. 1780 
4. Open twagent.conf and find the line that says bridge.host. Remove the “#” character and 1781 

enter the hostname or IP address of the Axon Bridge server. 1782 
5. In a file called registration_pre_shared_key.txt, enter the value of the preshared key that was 1783 

set in the Axon Bridge.  1784 
6. Restart the Axon Agent Service by opening a command prompt and running the following 1785 

commands: 1786 
RHEL or CentOS: 1787 
> /sbin/service tripwire-axon-agent stop 1788 
> /sbin/service tripwire-axon-agent start 1789 
 1790 
Debian or Ubuntu:  1791 
> /usr/sbin/service tripwire-axon-agent stop 1792 
> /usr/sbin/service tripwire-axon-agent start 1793 

2.12.5  Configure Tripwire Enterprise 1794 

2.12.5.1  Terminology 1795 

Node: a monitored system, such as a file system, directory, network device, database, or virtual 1796 
infrastructure component 1797 

Element: a monitored object, which is a component or property of a node being audited by TE  1798 

Element Version: a record of an element’s state at specific points in time. Multiple element versions 1799 
create a historical archive of changes made to the element.  1800 

Rule: A rule identifies one or more elements to the TE Console. 1801 

Action: an object that initiates a response to either changes detected by TE or by failures generated 1802 
from policy tests  1803 

Task: a TE operation that runs on a scheduled or manual basis 1804 

TE Policy: a measurement of the degree to which elements comply with a policy  1805 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 273 

Policy Test: a determination of whether elements comply with the requirements of a policy 1806 

Baseline: the act of creating an element that reflects the current state of a monitored object (also called 1807 
the current baseline). When a node’s baseline is promoted, TE saves the former baseline as a historic 1808 
baseline.  1809 

Version Check: a check on monitored objects/elements. It is a comparison of the current state of the 1810 
element against its already recorded baseline for changes. 1811 

2.12.5.2  Tags 1812 

In Tripwire Enterprise, tags can be used to label and target specific nodes. Tags are not required but 1813 
allow for targeting nodes more granularly than by the operating system. This section describes how to 1814 
create and assign tags. 1815 

1. Navigate to the TE Console in your browser.  1816 
2. Click Asset View.  1817 

 1818 
3. Click the Manage Tagging tab. 1819 
4. Enter the name of a tag set, or use one of the four existing ones (Location, Owner, Platform 1820 

Family, Primary Function). Click Add if adding your own tag set. 1821 

 1822 
5. Under the tag set to which you wish to add a tag, enter the name of the tag. 1823 
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 1824 

6. Click Add.  1825 
7. Navigate to Nodes > Asset View > Filter Assets. 1826 
8. Check the boxes next to the nodes to which you wish to add this tag. 1827 
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 1828 
9. Click Edit Tags. 1829 
10. Check the boxes next to any tags you wish to add to these nodes. 1830 

 1831 
11. Click Close.  1832 

2.12.5.3  Rules 1833 

This section describes how to create a rule. 1834 

1. Click Rules. 1835 
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 1836 
2. Select or create a rule group into which the new rule should be put.  1837 

 1838 
3. Click New Rule. 1839 
4. Select the type of rule. For monitoring Windows file systems, we choose Windows File System 1840 

Rule.  1841 
 1842 

 1843 
5. Click OK. 1844 
6. Enter a name and description for the rule. 1845 
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 1846 
7. Click Next. 1847 

 1848 
8. Click New Start Point. 1849 
9. For Path, enter a directory that represents the scope of the scan. It can be limited to the 1850 

documents folder or be wide enough to encompass all the files on a system. Note that the latter 1851 
will take much longer to scan. 1852 

10. Check the box next to Recurse directory if you also wish to scan all subfolders.  1853 
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 1854 
11. Click Next. 1855 
12. Select Windows Content and Permissions. 1856 

 1857 
13. Click Finish. 1858 
14. Click New Stop Point.  1859 
15. Enter the path of any folders or files that should not be included in the scan, and indicate 1860 

whether they should end the recursion. 1861 
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 1862 

16. Click Finish. 1863 
17. Click Next. 1864 
18. Click Next. 1865 
19. Click Finish. 1866 

2.12.5.4  Tasks 1867 

This section describes how to create a task on a schedule. These tasks can also be run manually if 1868 
necessary. 1869 

1. Click Tasks. 1870 

 1871 
2. Select a folder for a new task, or create one. 1872 
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 1873 
3. Click New Task. 1874 
4. Select Baseline Rule Task or Check Rule Task. (Note: Both are needed–baseline creates the 1875 

initial state of the monitored object, and check updates the state and reports any changes.) 1876 

 1877 
5. Click OK. 1878 
6. Enter a name and description for the task. 1879 
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 1880 
7. Click Next. 1881 
8. Select whether you want all baselines to be updated or to only create new baselines. 1882 

 1883 
9. Click Next. 1884 
10. Select the systems to be included in the task. You can use tags or select by operating system (or 1885 

other defaults). 1886 
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 1887 
11. Click Next. 1888 
12. Select the rule created earlier. 1889 

 1890 
13. Click Next. 1891 
14. Set the schedule of this task according to your organization’s needs. 1892 
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 1893 
15. Click Finish. 1894 

2.13  Tripwire Log Center 1895 

2.13.1  Install Tripwire Log Center Manager 1896 

See the Tripwire Log Center 7.3.1 Installation Guide, which should accompany the installation media, for 1897 
instructions on how to install Tripwire Log Center. Use the Tripwire Log Center Manager installer. 1898 

Notes: 1899 

a. It is recommended that you install Tripwire Log Center on a separate system from Tripwire 1900 
Enterprise. 1901 

b. You will need to install JRE8 and the Crypto library. Instructions are also in the Tripwire Log 1902 
Center 7.3.1 Installation Guide.  1903 

c. .NET Framework 3.5 is required for this installation–install this from the Server Manager. 1904 
d. You may need to unblock port 9898 on your firewall for the Tripwire Enterprise agents.  1905 
e. Do not install PostgreSQL if you wish to use a database on another system–this guide will use a 1906 

local PostgreSQL database, however. 1907 
f. When it finishes installing, there should be a configuration wizard (see below for configuration 1908 

steps). 1909 

2.13.2  Configure Tripwire Log Center Manager 1910 

1. The configuration wizard should start after the installation is complete. 1911 
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 1912 
2. Click Start. 1913 

 1914 
3. Click New Install. 1915 
4. Enter the registration details for your Tripwire Log Center license. 1916 
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 1917 
5. Click Register.  1918 
6. Enter details about the database that Tripwire Log Center should use. 1919 

 1920 
7. Click Next. 1921 
8. Select a directory in which to store log messages, such as C:\Program Files\Tripwire\Tripwire 1922 

Log Center Manager\Logs\AUDIT. 1923 
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 1924 
9. Click Next. 1925 
10. Enter a password and an email. 1926 
11. Change the IP to a hostname if preferred. 1927 

 1928 
12. Click Next.  1929 
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 1930 
13. Click Next. 1931 
14. Select any log sources that you expect to collect with Tripwire Log Center. Examples: Tripwire 1932 

Enterprise, Microsoft Windows 10, Tripwire IP360 VnE, Linux Debian, Ubuntu Linux, Microsoft 1933 
Exchange, Microsoft SQL Server. 1934 

 1935 
15. Click Next. 1936 
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 1937 
16. Click Start. 1938 

 1939 
17. Click Next. 1940 
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 1941 
18. Click Finish. 1942 

2.13.3  Install Tripwire Log Center Console 1943 

Chapter 4 of the Tripwire Log Center 7.3.1 Installation Guide details installation of the Tripwire Log 1944 
Center Console. Use the Tripwire Log Center Console installer. 1945 

You can install this on the same machine as the Tripwire Log Center Manager, if desired. 1946 

2.14  Cisco Web Security Appliance 1947 

This section details installation and some configurations for the Cisco Web Security Appliance (WSA). It 1948 
assumes the use of the WSA virtual machine. 1949 

2.14.1  Network Configuration 1950 

1. Log in to WSA by using the default username and password (admin/ironport). 1951 
2. Use the command sethostname to set the hostname of the machine. 1952 
3. Use the command dnsconfig to set the DNS server. Enter SETUP when prompted, and then 1953 

enter DNS information specific to your organization’s needs. 1954 
4. Use the command interfaceconfig to set the IP of the machine. Enter EDIT when 1955 

prompted, and then enter IP information specific to your organization’s needs. 1956 
5. Use the command passwd to change the default password of the machine. 1957 
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6. Use the command commit to commit all of these changes. 1958 
7. Use the command reboot to reboot the machine. 1959 
8. Use the command loadlicense to either paste the license file contents or select a license 1960 

file uploaded via FTP. You can enable FTP in the interfaceconfig command.  1961 
9. You should be prompted at the console to visit a web page in the browser, usually 1962 

http://<ip_address>:8080. The setup wizard will be here.  1963 

2.14.2  System Setup 1964 

1. In the web console, click System Administration > System Setup Wizard. 1965 
2. Verify that the hostname matches the desired hostname. 1966 
3. Enter the desired DNS servers. 1967 
4. Enter a time server if desired. 1968 
5. Select the time zone. 1969 
6. Select Standard for an on-premise setup. 1970 

 1971 
7. Click Next.  1972 
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 1973 
8. Click Next.  1974 
9. Verify that the interface is correctly configured. 1975 
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 1976 
10. Click Next. 1977 
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 1978 
11. Click Next.  1979 
12. Enter the default gateway and any additional gateways to use for routing.  1980 
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 1981 

13. Click Next.  1982 
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 1983 

14. Click Next. 1984 
15. Set a passphrase for the administrator. 1985 
16. Enter an email address to which alerts should be sent. 1986 
17. Enter the hostname of the email server. 1987 
18. Decide whether to forward alerts and reports to Cisco Customer Support, as well as whether to 1988 

share anonymous statistics based on the needs of your organization.  1989 
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 1990 

19. Click Next.  1991 
20. Select Monitor All Traffic. 1992 
21. Select Block for Action for Suspect Malware Addresses. 1993 
22. Select Block for Action for Detected Malware. 1994 
23. Configure the rest of the malware policy according to your organization’s needs.  1995 
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 1996 

24. Click Next. 1997 
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 1998 

25. Click Install This Configuration. 1999 

2.14.3  Using WSA to Proxy Traffic 2000 

Cisco WSA is intended to act as a proxy between clients and the internet, to prevent malicious traffic 2001 
and software from reaching the client systems before they can do any damage. The appliance must 2002 
have a way of intercepting traffic from the clients to the internet.  2003 

To achieve this, we used a Proxy Auto Config (PAC) file on our DNS server (Windows 2012 DNS), and this 2004 
section details how to set up a simple PAC file to forward all traffic to WSA. This may not be an ideal 2005 
setup for every environment, particularly in environments that use an external DNS server. 2006 
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2.14.3.1  Creating a PAC File 2007 

1. Create a new file named wpad.dat and enter the following JavaScript function: 2008 

 2009 

This is the most basic template for a proxy that directs all traffic to the host coeus.di.ipdr. The 2010 
return value of this function can take the form “PROXY <hostname1>; PROXY 2011 
<hostname2>” if you wish to have fail-over proxies, or “DIRECT” to not use any proxy. You can 2012 
also add rules to allow certain types of traffic through the proxy or direct them to other proxies. For 2013 
more information, see https://findproxyforurl.com. 2014 

For the purposes of our setup, we will simply direct all traffic to Cisco WSA, but be aware that PAC 2015 
files can be more complex and designed according to the needs of the organization. 2016 

2. In the web console, navigate to Security Services > Web Proxy.  2017 

 2018 

function FindProxyForURL(url, host) { 

 return “PROXY coeus.di.ipdr:3128”; 

} 

https://findproxyforurl.com/
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3. Click Edit Settings. 2019 
4. Remove port 80 from HTTP Ports to Proxy (ensure that 3128 is in this field). 2020 

 2021 
5. Click Submit. 2022 
6. Navigate to Security Services > PAC File Hosting. 2023 
7. Click Enable and Edit Settings. 2024 
8. Under PAC Files, click Choose File.  2025 
9. Select the wpad.dat file created earlier.  2026 
10. Click Open. 2027 
11. Click Upload. 2028 
12. Enter 80 for PAC Server Ports. 2029 
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 2030 
13. Click Submit. 2031 
14. Click Commit Changes. 2032 
15. Enter a comment if desired. 2033 
16. Click Commit Changes.  2034 

2.14.3.2  Setting Up Web Proxy Auto Discovery (WPAD) 2035 

1. On the DNS server, open regedit.exe. 2036 
2. Navigate to HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet > Services > DNS > 2037 

Parameters. 2038 
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 2039 
3. Double-click GlobalQueryBlockList. 2040 
4. Remove wpad from the list but leave isatap on the list. 2041 

 2042 
5. Click OK. 2043 
6. Open Task Manager. 2044 
7. Click Services. 2045 
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 2046 
8. Restart the DNS Server service. 2047 
9. Open DNS Manager.  2048 
10. Right-click on your enterprise’s domain, and click New Host (A or AAAA). 2049 
11. Enter wpad for Name. 2050 
12. Enter the IP address of WSA.  2051 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 304 

 2052 

13. Click Add Host.  2053 

This will set up the WPAD proxy file as the default proxy–so browsers that are using “Automatically 2054 
detect settings” for their proxy setting will find this file. Be aware that this is not sufficient for a 2055 
secure setup but will allow you to quickly test the proxy’s functionality.  2056 

2.14.3.3  Configure Group Policy to Use Explicit Proxy 2057 

Note that, at this point, WPAD is vulnerable to an attack where the server hosting WPAD is brought 2058 
down and the browser automatically attempts to find the next WPAD proxy, which may be 2059 
controlled by an attacker. 2060 

To mitigate this vulnerability, we explicitly point to this proxy file with any browsers used by clients. 2061 
For Internet Explorer and Google Chrome, it is sufficient to change group policy in Active Directory 2062 
to direct the change across all systems.  2063 

For Mozilla Firefox, see this link (https://support.mozilla.org/en-US/kb/connection-settings-firefox) 2064 
for configuration, including how to set it to “Use system proxy settings.” 2065 

1. In Group Policy Management, right-click the Default Domain Policy and click Edit. 2066 

https://support.mozilla.org/en-US/kb/connection-settings-firefox
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 2067 
2. In Group Policy Management Editor, navigate to User Configuration > Preferences > Control 2068 

Panel Settings > Internet Settings. 2069 
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 2070 
3. Right-click Internet Settings and select New > Internet Explorer 10. 2071 
4. Click the Connections tab. 2072 
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 2073 
5. Click LAN Settings. 2074 
6. Enter the address of the WPAD file for address. This will likely take the form 2075 

http://wpad.my.domain/wpad.dat if you followed these instructions for configuring the proxy 2076 
file. 2077 

7. Press the F8 key to disable all settings in this dialogue box. (Note: This should underline 2078 
everything in the box in red.) 2079 

http://wpad.my.domain/wpad.dat
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 2080 
8. Select the Address you just entered.  2081 
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 2082 
9. Press F6 to enable this setting. (Note: The explicit WPAD address should now be underlined in 2083 

green.) 2084 
10. Click OK. 2085 
11. Click OK. 2086 

This Group Policy Object will update across all Windows systems whenever gpupdate.exe runs. An 2087 
insider or technically capable user could manually disable this to avoid using the proxy, but benign 2088 
clients who do not attempt to circumvent it will be protected from external (internet-based) threats 2089 
by Cisco WSA. Protection from insiders and local threats on the network is provided by other 2090 
products in the architecture, such as the network protection component (CryptoniteNXT). 2091 

2.14.4  Blacklisting 2092 

1. Navigate to Web Security Manager > Custom and External URL Categories. 2093 
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 2094 
2. Click Add Category. 2095 
3. Enter a name for Category Name. 2096 
4. Select Local Custom Category. (The other option, External Live Feed Category, allows WSA to 2097 

use a list of websites hosted somewhere else, potentially externally. For this demonstration we 2098 
will simply enter websites in the Sites field, but note that this other option is available for 2099 
convenience.) 2100 

5. For Sites, enter any sites to blacklist. (Note: Entering .mysite.abc will include any subdomains of 2101 
mysite.abc.) 2102 
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 2103 
6. Click Submit. 2104 
7. Navigate to Web Security Manager > Access Policies. 2105 
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 2106 
8. Click the link under URL Filtering.  2107 
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 2108 
9. Click Select Custom Categories. 2109 
10. For the category just created, select Include in policy under Setting Selection. 2110 
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 2111 
11. Click Apply. 2112 
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 2113 

12. The category should now show under Custom and External URL Category Filtering. Put a 2114 
checkmark in the Block box. (Selecting Allow lets you white-list domains that are being 2115 
incorrectly classified as malicious.) 2116 

13. Click Submit. 2117 
14. Click Commit Changes. 2118 
15. Enter a comment if desired.  2119 
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 2120 
16. Click Commit Changes. 2121 

 2122 

2.15  Symantec Data Loss Prevention 2123 

2.15.1  Install Oracle 12c Enterprise 2124 

1. Unzip the Symantec DLP installation files.  2125 
2. Download the Oracle 12c installation files from https://www.oracle.com if they are not included 2126 

with the Symantec DLP installation files. 2127 
3. Move both sets of installation files to a temporary directory, such as C:\temp.  2128 
4. Copy the Symantec 12.2.0.1_64_bit_Installation_Tools folder to C:\temp\Oracle\tools. 2129 
5. From a command prompt, navigate to C:\temp\Oracle\database, assuming the Oracle 2130 

installation files were unzipped to C:\temp\Oracle. 2131 
6. Run the following command: 2132 

> C:\temp\Oracle\database\setup.exe -noconfig -responsefile 2133 
C:\temp\Oracle\tools\responsefiles\Oracle_12.2.0.1_Enterprise_Edi2134 
tion_Installation_WIN.rsp 2135 

7. Once the wizard opens, you will be asked to configure security updates. If you do not possess a 2136 
My Oracle Support account, leave the box unchecked and provide an email.  2137 

https://www.oracle.com/
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 2138 
8. Click Next. 2139 
9. Select Install database software only. 2140 
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 2141 
10. Click Next.  2142 
11. Select Single instance database installation. 2143 
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 2144 
12. Click Next.  2145 
13. Select Standard Edition. 2146 
14. Click Next.  2147 
15. Select Create New Windows User. 2148 
16. Enter the username and password of a new user for Active Directory. 2149 
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 2150 
17. Click Next.  2151 
18. Select a location to install the software, if desired. 2152 
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 2153 

19. Click Next.  2154 
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 2155 
20. Verify the information and click Install. The installation may take a long time. 2156 
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 2157 
21. Click Close when the installation is complete. 2158 

2.15.2  Create an Oracle Database for Symantec DLP 2159 

1. Set the ORACLE_HOME environment variable by running the following command. Adjust the 2160 
path accordingly if using a version other than 12.2.0. 2161 

> set 2162 
ORACLE_HOME=C:\app\Administrator\virtual\product\12.2.0\dbhome_1 2163 

2. Copy the Oracle database template named Oracle_12.2.0.1_Template_for_64_bit_WIN.dbt 2164 
from the Symantec DLP zip file into 2165 
C:\app\Administrator\virtual\product\12.2.0\dbhome_1\assistants\dbca\templates. 2166 

3. Ensure that the response file Oracle_12.2.0.1_DBCA_WIN.rsp is located in the folder 2167 
C:\temp\Oracle\database\tools\responsefiles. 2168 

4. Run the following command. 2169 

> %ORACLE_HOME%\bin\dbca -createDatabase -progressOnly -2170 
responseFile 2171 
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C:\temp\Oracle\database\tools\responsefiles\Oracle_12.2.0.1_DBCA_2172 
WIN.rsp 2173 

5. Enter a password for the SYS user. (Only the special characters _, #, or $ are allowed.) 2174 
6. Enter a password for the SYSTEM user. (Only the special characters _, #, or $ are allowed.) 2175 
7. Enter a password for the Oracle Home User.  2176 

2.15.3  Configuring the Oracle Listener 2177 

1. Ensure that the database services OracleServicePROTECT and 2178 
DistributedTransactionCoordinator are running. 2179 

2. In the file %ORACLE_HOME%\network\admin\sqlnet.ora, change the line 2180 
SQLNET.AUTHENTICATION_SERVICES=(NTS) to SQLNET.AUTHENTICATION_SERVICES=(none).  2181 

3. Navigate to Start > All Programs > Oracle 12.2.0 > Configuration and Migration Tools > Net 2182 
Configuration Assistant and run the program. 2183 

4. Select Listener configuration. 2184 

 2185 
5. Click Next.  2186 
6. Select Add. 2187 
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 2188 
7. Click Next.  2189 
8. Enter a name for the listener. 2190 
9. Enter a password. 2191 

 2192 
10. Click Next.  2193 
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11. Move the TCP protocol to the Selected Protocols column. 2194 

 2195 
12. Click Next.  2196 
13. Select Use the standard port number of 1521. 2197 

 2198 
14. Click Next. 2199 
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15. Select No. 2200 

 2201 
16. Click Next.  2202 

 2203 

17. Click Next.  2204 
18. Select Local Net Service Name configuration. 2205 
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 2206 

19. Click Next. 2207 
20. Select Add. 2208 

 2209 
21. Click Next. 2210 
22. Enter the word “protect” for the name. 2211 
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 2212 
23. Click Next.  2213 
24. Select TCP. 2214 

 2215 
25. Click Next.  2216 
26. Enter the IP address of the system hosting the Oracle Database. 2217 
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27. Select Use the standard port number of 1521. 2218 

 2219 
28. Click Next.  2220 
29. Select No, do not test. 2221 

 2222 

30. Click Next.  2223 
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 2224 

31. Click Next.  2225 
32. Select No. 2226 

 2227 
33. Click Next.  2228 
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 2229 
34. Click Next. 2230 

 2231 
35. Click Finish. 2232 
36. In an administrative command prompt, run the following command to stop the listener. 2233 
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> lsnrctl stop 2234 

37. Open the file %ORACLE_HOME%\network\admin\listener.ora.  2235 
38. Change (ADDRESS = (PROTOCOL = IPC)(KEY = <key_value>)) to (ADDRESS = (PROTOCOL = 2236 

IPC)(KEY = PROTECT)). 2237 
39. Add the line SECURE_REGISTER_LISTENER=(IPC) to the end of the file. 2238 

 2239 

40. Save the file and exit the editor. 2240 
41. Ensure that OracleServicePROTECT and OracleVssWriterPROTECT services are running in Task 2241 

Manager.  2242 
42. In an administrative command prompt, run the following command to start the listener. Re-2243 

place dilistener with the name given to your listener. 2244 

> lsnrctl start dilistener 2245 

43. Run the following commands to connect the listener to the database using SQL Plus. Replace 2246 
password with the password used for the SYS user. 2247 

> sqlplus /nolog 2248 

> conn sys/password as sysdba 2249 

44. Run the following commands in the SQL prompt. (Note: If errors occur relating to the SPFILE, try 2250 
replacing ORACLE_HOME or ORACLE_base values in %ORACLE_HOME%\dbs\init.ora with the 2251 
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absolute path. Then run CREATE SPFILE FROM PFILE=’%ORACLE_HOME%\dbs\init.ora’ and CRE-2252 
ATE PFILE FROM SPFILE=’%ORACLE_HOME%\dbs\init.ora’. Restart the database after doing 2253 
this.) 2254 

> ALTER SYSTEM SET local_listener = '(DESCRIPTION=(ADDRESS=(PRO-2255 
TOCOL=ipc)(KEY=PROTECT)))' SCOPE=both; 2256 

> ALTER SYSTEM REGISTER; 2257 

> exit 2258 

45. Run the following command to verify the status of the listeners: 2259 

> lsnrctl services 2260 

 2261 

46. Open a new administrative command window. 2262 
47. Navigate to C:\Temp\Oracle\database\tools. 2263 
48. Run the following command: 2264 

> sqlplus /nolog 2265 

> @oracle_create_user.sql 2266 

49. Enter the password for the SYS user. 2267 
50. For sid, enter “protect”. 2268 
51. For a username, enter “protect”. 2269 
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52. Enter a password for the “protect” user. (The special characters &, $, and # are not allowed.) 2270 
53. When this process is finished, open a new administrative command window and run the follow-2271 

ing command. 2272 

> sqlplus /nolog 2273 

54. Log in as the SYS user with the following command (replace “password” with the password for 2274 
the SYS user). 2275 

> connect sys/password@protect as sysda 2276 

55. Verify the version information with the following command. 2277 

> SELECT * FROM v$version; 2278 

 2279 
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2.15.4  Install Symantec DLP 2280 

1. In the folder DLP Installs\DLP 15.1\Symantec_DLP_15.1_Platform_Win-2281 
IN_15.1.0.25021\DLP\15.1\New_Installs\x64\Release, located in the download folder for the 2282 
DLP files, run ServerJRE.msi. 2283 

 2284 

2. Click Next. 2285 
3. Select I agree to the terms in the license agreement. 2286 

 2287 
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4. Click Next. 2288 

 2289 
5. Click Next. 2290 

 2291 
6. Click Install. 2292 
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 2293 
7. Click Finish. 2294 
8. Run SingleTierServer.msi (located in the same folder as ServerJRE.msi). 2295 

 2296 
9. Click Next. 2297 
10. Check the box to accept the license agreement. 2298 
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 2299 
11. Click Next. 2300 

 2301 

12. Click Next. 2302 
13. Select Enabled for FIPS 140-2 Compliant Algorithms. 2303 
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 2304 
14. Click Next. 2305 

 2306 

15. Click Next. 2307 
16. Click on New Users. 2308 
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 2309 
17. Click Next. 2310 
18. Enter a password and optionally a username. 2311 

 2312 
19. Click Next. 2313 
20. Enter a password and optionally a username. 2314 
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 2315 

21. Click Next. 2316 
22. Enter the password used for the “protect” user. 2317 

 2318 

23. Click Next. 2319 
24. Select Initialize Database. 2320 
25. Click Next. 2321 
26. Set the initial password for logging into the Enforce Administrator account. 2322 
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 2323 

27. Click Next. 2324 
28. Select Database. 2325 

 2326 

29. Click Next. 2327 
30. Select None. 2328 
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 2329 
31. Click Next. 2330 

 2331 
32. Click Next. 2332 
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 2333 

33. Click Install. 2334 

 2335 

34. Click Finish. 2336 
35. Ensure that the services are running in Task Manager: 2337 

a. SymantecDLPManager 2338 
b. SymantecDLPIncidentPersister 2339 
c. SymantecDLPNotifier 2340 
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d. SymantecDLPDetectionServer 2341 

2.15.5  Configure Symantec DLP 2342 

1. Navigate to https://127.0.0.1 in the browser to get to the Symantec DLP web console. 2343 
2. Navigate to System > Settings > General and click Configure. 2344 
3. In the Edit General Settings screen, upload your license file provided by Symantec.  2345 
4. Click Save.  2346 
5. In Task Manager, stop the SymantecDLPManager service. 2347 
6. Copy the classpath.txt file located in <DLP Download Home>\DLP\15.1\Solution_Packs\ and 2348 

overwrite the classpath.txt located at C:\Program Files\Symantec\Data Loss 2349 
Prevention\Enforce Server\15.1\Protect\Config\SolutionPackInstaller. 2350 

7. In an administrative command window, use the following commands to import the chosen 2351 
solution pack. For example, to import the financial solution pack, use: 2352 

> cd “C:\Program Files\Symantec\Data Loss Prevention\Enforce 2353 
Server\15.1\protect\bin” 2354 

> .\SolutionPackInstallerexe import “C:\Program 2355 
Files\Symantec\Data Loss Prevention\Financial_v15.1.vsp” 2356 

8. After this is installed, restart the SymantecDLPManager service. 2357 
9. Log on to the Enforce Web Console as Administrator. 2358 
10. Navigate to System > Servers > Overview. 2359 
11. Click Add Server. 2360 
12. Select the type of Detection Server to add. 2361 
13. Click Next. 2362 
14. Enter a name. 2363 
15. Enter the hostname of the DLP server. 2364 
16. Enter 8100 for the port. 2365 
17. Navigate to System > Settings > General. 2366 

 2367 

18. Check the box next to Advanced Process Control. 2368 
19. Specify any configuration options according to the needs of your organization. 2369 
20. Click Save. 2370 
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2.16  Cisco Identity Services Engine 2371 

This section details the installation and some configurations for the Cisco Identity Services Engine (ISE). 2372 
It assumes the use of the ISE virtual machine. 2373 

2.16.1  Initial Setup 2374 

1. When prompted to log in for the first time, enter setup. (You can use the command reset-2375 
config to change these values later.) 2376 

2. Enter the desired hostname for the machine. 2377 
3. Enter the desired IP address for the machine. (Ensure that the specified hostname is associated 2378 

with this IP address in your DNS.) 2379 
4. Enter the netmask for the machine.  2380 
5. Enter the default gateway. 2381 
6. Enter the default DNS domain (the name of your domain). 2382 
7. Enter the primary nameserver (the IP address of your DNS). 2383 
8. Enter a second nameserver if desired.  2384 
9. Enter a Network Time Protocol (NTP) time server. 2385 
10. Enter the timezone. 2386 
11. Enter Y for SSH service. 2387 
12. Enter an administrator username for the machine. 2388 
13. Enter a password twice. 2389 

2.16.2  Inventory: Configure SNMP on Routers/Network Devices 2390 

See the corresponding vendor documentation for the correct way to enable Simple Network 2391 
Management Protocol (SNMP) on your network device. Ensure that the community string you choose is 2392 
considered sensitive, like a password. 2393 

2.16.3  Inventory: Configure Device Detection 2394 

1. Log in to the web client by visiting https://hostname/admin but replace hostname with the 2395 
hostname of the ISE machine.  2396 
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 2397 
2. On the top right, use the small Play button to select Visibility Setup. 2398 

 2399 
3. Click Next.  2400 

 2401 
4. Enter the range of IP addresses to add to ISE’s inventory.  2402 
5. Ensure that Active Scanning is checked. 2403 
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 2404 

6. Click Next.  2405 
7. Click the Add Device Manually link. 2406 
8. Enter a name. 2407 
9. Enter the IP address of the network device you configured for SNMP. 2408 
10. Select 1 for SNMP version. 2409 
11. Enter the community string you created.  2410 

 2411 

12. Click OK. 2412 
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 2413 
13. Click Next. 2414 
14. Enter a display name. 2415 
15. Enter the domain name. 2416 
16. Enter the hostname of Cisco ISE. 2417 
17. Enter a username and password. 2418 
18. Click Test Connection to ensure that this works. 2419 

 2420 
19. Click Next.  2421 
20. Enter a username and password. 2422 
21. Check the box next to Enable Endpoint Logging. 2423 
22. Check the box next to Include Range. 2424 
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 2425 
23. Click Next.  2426 

 2427 
24. Verify the settings and click Done. (This should begin importing endpoints connected to the 2428 

network device, and they will be visible on the ISE dashboard.) 2429 

2.16.4  Policy Enforcement: Configure Active Directory Integration 2430 

1. Navigate to Administration > Identity Management > External Identity Sources > Active 2431 
Directory. 2432 
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 2433 
2. Click Add. 2434 
3. Enter a name.  2435 
4. Enter the domain. 2436 

 2437 
5. Click Submit. 2438 
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 2439 
6. Click Yes. 2440 
7. Enter a username and password to join ISE to the domain. 2441 

 2442 

8. Click OK. 2443 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 354 

 2444 

9. Click Close when the join is finished. 2445 

2.16.5 Policy Enforcement: Enable Passive Identity with AD 2446 

This configuration allows users to use Active Directory usernames/passwords as authentication for the 2447 
portal. The web portal will allow clients to download profiling software to ensure that clients have up to 2448 
date software and can be trusted on the network.  2449 

1. Navigate to Administration > System > Deployment. 2450 
2. Check the box next to ISE. 2451 

 2452 
3. Click Edit. 2453 
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4. Check the box next to Enable Passive Identity Service. 2454 

 2455 
5. Click Save. 2456 
6. Navigate to Administration > Identity Management > External Identity Sources > Active 2457 

Directory. 2458 
7. Click the name of the Active Directory machine. 2459 
8. Check the box next to the join point you just created.  2460 

 2461 
9. Click Edit.  2462 
10. Click the PassiveID tab. 2463 
11. Click Add DCs if there are no domain controllers listed. 2464 
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 2465 
12. Select the Active Directory domain controller. 2466 
13. Click OK. 2467 
14. Check the box next to the selected domain controller. 2468 
15. Click Edit. 2469 
16. Enter credentials for an administrator account. 2470 

 2471 
17. Click Save. 2472 
18. Click Config WMI. 2473 
19. Click OK. 2474 
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 2475 
20. Click OK when this configuration finishes. 2476 
21. Navigate to Administration > System > Settings > Client Provisioning. 2477 
22. Set Enable Automatic Download to Enable. 2478 

 2479 
23. Click Save. 2480 
24. Navigate to Administration > Identity Management > External Identity Sources > Active 2481 

Directory. 2482 
25. Click the Groups tab. 2483 
26. Click Add > Select Groups from Directory. 2484 
27. Click Retrieve Groups. (This should populate the window with the groups from Active 2485 

Directory.) 2486 
28. Select them all. 2487 
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 2488 
29. Click OK. (If you add more groups to Active Directory they can be imported in the same way in 2489 

the future.) 2490 
30. Click the Attributes tab.  2491 
31. Click Add > Select Attributes from Directory. 2492 
32. Enter a username.  2493 
33. Click Retrieve Attributes. (This will populate the window with Active Directory’s available 2494 

attributes, so they can be used for policy in Cisco ISE.) 2495 
34. Click OK. 2496 
35. Select any desired attributes. 2497 
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 2498 
36. Click OK. 2499 
37. Click Save. 2500 

2.16.6  Policy Enforcement: Developing Policy Conditions 2501 

1. Navigate to Policy > Policy Elements > Conditions > Posture. 2502 
2. Expand the Posture section. This will reveal a list of categories for conditions. (Note: These 2503 

conditions allow you to select or define requirements that endpoints should meet. In typical 2504 
enterprises, these conditions can be used as requirements to gain network access–however, 2505 
this strongly depends on the capabilities of your network device.) 2506 

3. As an example, we will require that Cisco AMP be installed on all Windows devices. If you are 2507 
using a different anti-malware software, locate that instead. Click Anti-Malware Condition.  2508 
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 2509 

4. Click Add. 2510 
5. Enter a name. 2511 
6. Enter a description if desired. 2512 
7. Select Windows All for Operating System. 2513 
8. Select Cisco Systems, Inc. for Vendor.  2514 
9. Under Products for Selected Vendor, check the box next to Cisco Advanced Malware 2515 

Protection with the version number you have installed. 2516 
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 2517 
10. Click Submit. 2518 

2.16.7  Policy Enforcement: Developing Policy Results 2519 

1. Navigate to Policy > Policy Elements > Results > Posture > Requirements. 2520 
2. Click one of the black arrows next to the Edit link, and select Insert New Requirement. 2521 
3. Enter a name.  2522 
4. Select Windows All for Operating Systems. 2523 
5. Select 4.x or later for Compliance Module. 2524 
6. Select Temporal Agent for Posture. 2525 
7. Select User Defined Conditions > Anti-Malware Condition > Cisco AMP (substitute Cisco AMP 2526 

with the name of the condition you just created).  2527 
8. Select Message Text Only for the Remediation Action. (Other remediation actions can be 2528 

defined by going to Policy > Policy Elements > Results > Posture > Remediation Actions, but 2529 
there is not an option for Cisco AMP to be installed, so we leave the default for now.) 2530 

9. Enter a Message to inform the user that they must install Cisco AMP.  2531 
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 2532 
10. Click Save.  2533 

2.16.8  Policy Enforcement: Enforcing a Requirement in Policy 2534 

1. Navigate to Policy > Posture. 2535 
2. Click one of the black arrows next to the Edit link, and select Insert New Policy. 2536 
3. Enter a name.  2537 
4. Select Windows All for Operating Systems. 2538 
5. Select 4.x or later for Compliance Module. 2539 
6. Select Temporal Agent for Posture Type. 2540 
7. Select Cisco AMP (substitute Cisco AMP with the name of the requirement you just created).  2541 
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 2542 
8. Click Done. 2543 
9. Ensure that the green checkboxes next to the rules you wish to apply are the only checkboxes 2544 

enabled, as anything enabled will be enforced.  2545 

2.16.9  Policy Enforcement: Configuring a Web Portal 2546 

1. Navigate to Administration > Device Portal Management > Client Provisioning.  2547 
2. Select the Client Provisioning Portal (default). 2548 

 2549 
3. Click Edit. 2550 
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4. Under Portal Settings, go to Configure authorized groups and select the groups that should 2551 
require a Cisco ISE client.  2552 

5. Enter a domain name for FQDN, and add it to your DNS.   2553 

 2554 
6. Click Save. 2555 

2.16.10 Configuring RADIUS with Your Network Device 2556 

Cisco ISE requires a Remote Authentication Dial-In User Service (RADIUS) session for posture to 2557 
function. Posture refers to ISE’s ability to check that a machine complies with a specified policy, which 2558 
may be based on the operating system (OS) and may contain requirements such as installation of 2559 
certain security applications or the presence of configuration files. Machines that are not in compliance 2560 
can be kept separated from the network. The process for setting this up varies widely among machines, 2561 
but the overall requirements have commonalities among systems.  2562 

• The Network Device (i.e., the router or switch) must support RADIUS functions, specifically 2563 
Authentication, Authorization, and Accounting. Furthermore, it must also support CoA, which 2564 
is Change of Authorization. To configure this, you must configure your network device to use 2565 
Cisco ISE as a RADIUS server. What this means is that your network device will forward 2566 
authentication requests to Cisco ISE, and Cisco ISE will respond with an “accept” or “reject.” 2567 

• The Network Device must support some form of 802.1x. Note that this is not supported on 2568 
certain routers, even if RADIUS is supported. 802.1x is a mechanism for authenticating the end 2569 
workstation to the network device, potentially over wireless or through Ethernet.  2570 
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a. This can take various forms, such as a captive web portal, MAC address authentication, 2571 
or user authentication. A captive web portal, if the device supports it, may be ideal for 2572 
configuration without the correct hardware.  2573 

b. There are also many switches that provide direct 802.1x username/password 2574 
authentication. Note that if you choose to use this mechanism, a client is still required, 2575 
and it will not be in the web browser. Windows has a built-in 802.1x client, which can be 2576 
configured on network adapters under the Authentication tab. To enable it, you must 2577 
first start the service Wired AutoConfig, and then the Authentication tab will become 2578 
available for configuration. 2579 

c. Whatever form of 802.1x is chosen, the request for authentication must be forwarded 2580 
to Cisco ISE. Cisco ISE will process the request for authentication.  2581 

• The two steps above detail the authentication phase. Once authenticated, the network device 2582 
must redirect the user to the client provisioning portal (or to a guest portal), depending on the 2583 
setup. The URL for this can be acquired from the active Authorization Profile in ISE.  2584 

• The user will then authenticate to the Guest Portal or Client Provisioning Portal (depending on 2585 
your setup). The portal will prompt the user to download an executable, which will run posture. 2586 

• The executable will first check for the existence of a RADIUS session in Cisco ISE for the user 2587 
who downloaded the executable. It will primarily check the MAC address that visited the ISE 2588 
web portal against the MAC addresses of existing sessions. If and only if a session exists, it will 2589 
run posture based on the policy you set up. You can verify that a session exists by navigating to 2590 
Operations > RADIUS > Live Sessions. 2591 

2.16.11 Configuring an Authentication Policy 2592 

1. Navigate to Policy > Policy Elements > Results > Authentication > Allowed Protocols. 2593 
2. Select the Default Network Access protocol or create your own.  2594 
3. Ensure that any protocols that need to be supported for your network setup are allowed. In 2595 

particular, if using 802.1x, it is likely that you should check the box next to Allow MS-CHAPv2. 2596 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 366 

 2597 
4. Click Save. 2598 
5. Navigate to Policy > Policy Sets. 2599 
6. Select the default policy. 2600 
7. Ensure that the Allowed Protocol selection matches the allowed protocol you just 2601 

created/edited. 2602 
8. Expand the Authentication Policy section, and select the ID stores from which to authenticate 2603 

users. For example, if you set up an Active Directory integration, it may be desirable to 2604 
authenticate users from there. 2605 
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 2606 
9. Click Save. 2607 

2.16.12 Configuring an Authorization Policy 2608 

1. The Authorization Profile is likely dependent on your network device, but it is possible that the 2609 
Cisco_Temporal_Onboard profile will work even for non-Cisco devices. You can edit the 2610 
authorization policy by navigating to Policy > Policy Elements > Results > Authorization > 2611 
Authorization Profiles.  2612 

2. The temporal onboard profile will attempt to redirect the user to a client-provisioning portal. 2613 
This redirection will most likely happen only automatically on compatible Cisco network devices. 2614 
If another device is used, the device may need to manually redirect the user to the client-2615 
provisioning portal after authentication. (We accomplished this in pfSense for our build by using 2616 
a “post-authentication redirection” feature in the Captive Portal.) 2617 

3. Once you are finished configuring the Authorization Profile, navigate to Policy > Policy Sets. 2618 
4. Select the default policy. 2619 
5. Expand the Authorization Policy section. 2620 
6. Note that you can configure this for as many groups and conditions as desired, potentially 2621 

specifying different authorization profiles for various user groups or levels of authentication, 2622 
including unauthenticated access. Under Results > Profiles, you can select the authorization 2623 
profiles you configured. 2624 
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 2625 

7. Click Save.  2626 

2.17  Tripwire IP360 2627 

This section details installation and configuration for Tripwire IP360. 2628 

2.17.1  Installation 2629 

1. Move or copy the Tripwire IP360 Virtual Machine into your virtual environment; start Virtual 2630 
Machine and observe its successful start-up. 2631 
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2. Log in using default admin credentials.2632 

 2633 
3. When prompted after initial login, set a new password and record it in a safe location.2634 

 2635 
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4. Use the command system hostname update <hostname> to update the system’s hostname in 2636 
accordance with your environment’s naming scheme.2637 

 2638 
5. Use command network interface update <interface> <IP>/<Broadcast IP> to update network 

interface information in accordance with your environment’s network.
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6. Use command network route_default create <gateway> to update the system’s default 
gateway information in accordance with your environment’s network.
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7. Use command system nameserver create <nameserver IP> to set up the DNS server.
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2.17.2  Web Portal 2639 

1. From a web browser that can access the newly installed machine’s IP address, navigate to the IP 2640 
address and log in using the updated credentials from the setup process.2641 

 2642 
2. Check the box next to I accept the above User License Agreement. 2643 

 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 374 

3. Click Next. 2644 
4. Browse to location of downloaded license file.2645 

 2646 
5. Click Install. 2647 
6. Tripwire IP360 should now be installed and running.2648 

  2649 

2.17.3  Scanning 2650 

This section details instructions for using Tripwire IP360 to run a scan on enterprise systems. The 2651 
specific details of the scan will vary based on each enterprise’s security needs. 2652 
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1. Navigate to the web interface and log in.2653 

 2654 
2. Navigate to the Scanning tab. 2655 

 2656 
3. Click Add. 2657 
4. Complete the information regarding the new scan according to the preferences of your 2658 

organization. 2659 
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 2660 
5. Observe successful scan activity. 2661 
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2.18 Integration: Tripwire Log Center and Tripwire Enterprise 2662 

1. Create a user account in Tripwire Log Center by logging into Tripwire Log Center Console. 2663 

 2664 
2. Click the Administration Manager button. 2665 
3. Click User Accounts. 2666 
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 2667 
4. Click the Add button. 2668 
5. Enter the details of the user.  2669 

 2670 
6. Click Add. 2671 
7. Double-click the user account. 2672 
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 2673 
8. Click the Permissions tab. 2674 

 2675 
9. Click Edit list of permissions. 2676 
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10. Select Databases. 2677 

 2678 
11. Check the box next to View System Database. 2679 
12. Select API. 2680 

 2681 
13. Check the box next to Allow REST API Logon. 2682 
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 2683 
14. Click OK. 2684 
15. Click OK. 2685 
16. Log in to the Tripwire Enterprise web console. 2686 
17. Click Settings. 2687 
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18. Go to System > Log Management. 2688 
19. Check the box next to Forward TE log messages to syslog. 2689 
20. Enter the hostname and port of the Tripwire Log Center server. The default port is 1468. 2690 
21. Check the box next to Allow TE to use information from Tripwire Log Center. 2691 
22. Enter the service address like this: https://arcsight-cons.di.ipdr:8091/tlc. Replace the hostname 2692 

with the hostname of your Tripwire Log Center server. 2693 
23. Enter the account information of the account just created for Tripwire Log Center. 2694 
24. You can use Test Connection to verify that the connection is working. 2695 

 2696 
25. Click Apply when finished. 2697 
26. Go back to the Tripwire Log Center Console. 2698 

https://arcsight-cons.di.ipdr:8091/tlc
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 2699 
27. Click Configuration Manager. 2700 
28. Click Resources > Tripwire Enterprise Servers. 2701 

 2702 
29. Click Add. 2703 
30. Enter a name for the server. 2704 
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31. Enter the URL of the Tripwire Enterprise server. 2705 
32. Enter the name of a user account on the Tripwire Enterprise server. The account must have the 2706 

following permissions: create, delete, link, load, update, view. 2707 

 2708 
33. Click Save. 2709 

2.19  Integration: Tripwire Log Center and Tripwire IP360 2710 

2.19.1  Configure IP360 and Log Center 2711 

1. On the Tripwire Log Center Manager machine, navigate to C:\Program Files\Tripwire\Tripwire 2712 
Log Center Manager\Agent Services\config. 2713 

2. Copy bridge_sample.properties to bridge.properties. 2714 
3. Modify the Pre-Shared Key to use a password by changing the following line (be sure to remove the “#” 2715 

sign): 2716 
tw.cap.bridge.registrationPreSharedKey=newpasswordhere 2717 

4. Save the file. 2718 
5. From the command line, run the following two commands: 2719 

> net stop TripwireBridge 2720 
> net start TripwireBridge 2721 

6. On the Tripwire IP360 machine, from the command line, enter the following command to 2722 
specify the hostname of the Tripwire Log Center (TLC) machine: 2723 
> tlc config bridge host update <hostname> 2724 
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7. Enter the following command using the preshared key specified earlier: 2725 
> tlc config bridge password update <password> 2726 

8. Enter the following command to start the TLC service on the IP360 machine (this will use port 2727 
5670 on the TLC machine by default): 2728 
> system service tlc enable 2729 

9. Download the “Content update–June 2018” package from the Tripwire Customer Center. 2730 
10. Open the Tripwire Log Center Console. 2731 
11. Enter the username and password. 2732 

 2733 
12. Click Login. 2734 
13. Click Options > Import TLC Content > Content. 2735 
14. Select Use a custom file. 2736 
15. Click Browse, and locate the zip file downloaded from the Tripwire Customer Center. 2737 
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 2738 
16. Expand the Normalization Rules section. 2739 
17. Check the box next to Tripwire IP360 VnE. 2740 
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 2741 
18. Click Import. 2742 

2.19.2  Collect Tripwire IP360 Operational Logs 2743 

1. Click Configuration Manager. 2744 
2. Click Resources > Managers. 2745 
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 2746 
3. Double-click the Primary Manager. 2747 
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 2748 
4. Click the Installed Modules tab. 2749 
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 2750 
5. Ensure that there is an Advanced File Collector. If not, click the Create new module button, and 2751 

specify a name. Set the type to Advanced File Collector. If there is an Advanced File Collector, 2752 
skip this step. 2753 

6. Click OK. 2754 
7. Click Resources > Asset Groups. 2755 
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 2756 
8. Click Add. 2757 
9. Enter Tripwire VnE Managers in the Name field. 2758 
10. Click the Normalization Rules tab. 2759 

 2760 
11. Click Add. 2761 
12. Expand the Tripwire IP360 VnE group. 2762 
13. Click the Check selected rows button at the top to check the box next to everything in this 2763 

section. 2764 
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 2765 
14. Click OK. 2766 

 2767 
15. Click OK. 2768 
16. Click Resources > Monitored Assets.  2769 
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 2770 

17. Click Add Monitored Asset. 2771 
18. Enter a name. 2772 
19. Select Advanced File Collector for Collector. 2773 
20. Select the IP360 server from the Hostname drop-down. It may appear as an IP address. 2774 
21. Enter the IP address of the server. 2775 
22. Select ips for Asset type. 2776 
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 2777 
23. Click the Asset Groups tab. 2778 
24. Click Add.  2779 
25. Select Tripwire VnE Managers.  2780 

 2781 
26. Click Add. 2782 
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 2783 
27. Click the Output Destinations tab. 2784 
28. Click Add. 2785 
29. Select File–Text File for Input Type. 2786 
30. Select Correlation Engine for Output Destination. 2787 

 2788 
31. Click Add. 2789 
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 2790 
32. Click the Log Sources tab. 2791 
33. Click Add. 2792 
34. Enter a name for the log.  2793 
35. Enter /data/log/ironwood.log for Log file path. 2794 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 397 

 2795 
36. Click OK. 2796 
37. Click Add. 2797 
38. Enter a name for the log. 2798 
39. Enter /data/log/upgrade.log for Log file path.  2799 

 2800 
40. Click OK. 2801 
41. Click Add. 2802 
42. Enter a name for the log. 2803 
43. Enter /var/log/messages for Log file path. 2804 
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 2805 
44. Click OK. 2806 

 2807 
45. Click OK. 2808 
46. Click Resources > Managers. 2809 
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 2810 
47. Select the Primary Manager and click Push Updates to Manager.  2811 

2.19.3  Configure Tripwire IP360 Scan Results Forwarding 2812 

1. Click Configuration Manager. 2813 
2. Click Resources > Manager. 2814 
3. Double-click the Primary Manager. 2815 
4. Click the Advanced Settings tab. 2816 
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 2817 
5. Click Add. 2818 
6. Select Vulnerabilities–IP360 High Value Host Threshold for the Advanced Option.  2819 
7. Enter a number between 0 and 999,999,999 for the Value. This number corresponds to the 2820 

priority level of the host system being scanned. The value entered will be the minimum value 2821 
for a host machine to be considered high priority. Half of this value will be the minimum value 2822 
for a host machine to be considered medium priority. 2823 
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 2824 
8. Click Add. 2825 
9. Select Vulnerabilities–IP360 High Risk Score Threshold for the Advanced Option. 2826 
10. Enter a number between 0 and 999,999,999 for the Value. This number corresponds to the risk 2827 

level of a vulnerability event. The value entered will be the minimum value for an event to be 2828 
considered high risk. Half of this value will be the minimum value for an event to be considered 2829 
medium risk. 2830 
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 2831 
11. Click Apply. 2832 
12. Click OK. 2833 
13. Click Resources > Monitored Assets. 2834 
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 2835 
14. Click Add Asset.  2836 
15. Select TLC File Collector for Collector. 2837 
16. Enter the IP address of the IP360 machine. 2838 
17. Select ips for Asset type. 2839 
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 2840 
18. Click the Asset Groups tab. 2841 
19. Click Add. 2842 
20. Select Tripwire VnE Managers for Host Group. 2843 
21. Click Add. 2844 
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 2845 
22. Click the Output Destinations tab. 2846 
23. Select File–IP360 for Input Type. 2847 
24. Select Events for Output Destination. 2848 

 2849 
25. Click Add. 2850 
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 2851 
26. Click OK. 2852 
27. Click Resources > Managers. 2853 
28. Select the Primary Manager. 2854 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 407 

 2855 
29. Click Push Update to Manager. 2856 
30. Log in to the Tripwire IP360 Web Console. 2857 
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 2858 

31. Click Legacy UI at the top. 2859 
32. On the left, click Administer > System > VnE Manager > Automated Export. 2860 

 2861 
33. Click the Export to File tab.  2862 
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 2863 

34. Click Modify. 2864 
35. Enter the username of a TLC user account for User. 2865 
36. Enter the IP address of the TLC Manager for Host. 2866 
37. Enter “/” for the directory. 2867 
38. Select Active. 2868 
39. Select SSH2 DSA (sftp) for Protocol. 2869 
40. Select XML2 for Format. 2870 

 2871 
41. Click Submit. 2872 
42. Download the generated key by clicking [Inline].  2873 
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43. In TLC Console, click Configuration Manager. 2874 
44. Click Resources > Managers. 2875 

 2876 
45. Double-click the Primary Manager. 2877 
46. Click the File Collector tab. 2878 
47. Ensure that the Collect log messages via FTP and SSH option is enabled. 2879 
48. Enter 22 for the port. (Note: The IP360 Integration Guide says to use a different port, but the 2880 

IP360 system appears to be unable to use a port other than 22.) 2881 
49. Click Add. 2882 
50. Under Users, select the user for whom the key was generated. 2883 
51. Under Key Path, enter the path to the downloaded key. 2884 
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 2885 

52. Click OK. 2886 
53. Select the Primary Manager. 2887 
54. Click Push Updates to Manager. 2888 
55. On the IP360 web console, click Test to ensure that the connection is successful. 2889 

 2890 
56. Any recurring scans will now forward the scan results to Tripwire Log Center. To ensure that a 2891 

scan is recurring, select a scan in Scan Profiles on the main dashboard of the IP360 web console. 2892 
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  2893 
57. Click Edit. 2894 
58. Click Next until the Scan Schedule page. 2895 
59. Select Recurring, and set a schedule for the scan according to the needs of the organization. 2896 

 2897 
60. Click Finish.  2898 

2.20  Integration: Tripwire Enterprise and Backups 2899 

This section details how to back up Tripwire Enterprise configuration data. 2900 

To back up Tripwire Enterprise integrity information, refer to the database vendor’s documentation for 2901 
backing up data. 2902 
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2.20.1  Export Configuration from Tripwire Enterprise 2903 

1. On the Tripwire Enterprise server, navigate to C:\Program Files\Tripwire\TE\Server\bin. 2904 
2. Run the following command to stop Tripwire Services. 2905 

> twservices stop 2906 
3. Run the following command to export the configuration files to a backup (replace config.bak 2907 

with the desired name of the backup). 2908 
> tetool backup config.bak 2909 

4. Run the following command to restart Tripwire Services. 2910 
> twservices start 2911 

2.20.2  Back Up the Tripwire Enterprise Configuration 2912 

The configuration backup will be stored in the file specified in step 3 of the previous section. To back 2913 
this up to the enterprise backup server through a Duplicati client, see the documentation in Section 2914 
2.8.4 for how to set up a Duplicati instance on the Tripwire Enterprise server, and then simply select 2915 
the configuration file.   2916 

2.21  Integration: Cisco ISE and CryptoniteNXT 2917 

This section details an integration between Cisco ISE and CryptoniteNXT, allowing ISE to dictate the 2918 
Cryptonite registration process based on the posture of the client machine. Please see the 2919 
CryptoniteNXT Generic RADIUS Integration Guide for more details about the integration. 2920 

2.21.1  Requirements for Integrating Cisco ISE and CryptoniteNXT 2921 

As described in the ISE installation section, ISE requires RADIUS to be configured to perform posture. As 2922 
such, this guide assumes the use of some sort of switch to provide RADIUS functionality. 2923 

CryptoniteNXT requires the switch to use L2 technologies for the RADIUS server, which means a captive 2924 
portal will not work for this scenario. The feasibility of this depends on your networking setup.  2925 

This integration requires the following: 2926 

1. The switch is bridged to CryptoniteNXT. 2927 
2. Cryptonite is configured to accept RADIUS packets from the switch (detailed below). 2928 
3. Clients on the switch’s Local Area Network (LAN) authenticate to the switch via 802.1x (see your 2929 

switch’s documentation). 2930 
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4. The switch is configured to accept CoA packets from ISE (see ISE installation). 2931 
5. The switch sends RADIUS accounting and authentication packets to Cisco ISE (see ISE 2932 

installation). 2933 
6. ISE sends an authentication response to the switch and then later uses CoA to modify the 2934 

authorization based on posture (see ISE installation). 2935 
7. If the authorization is successful, the switch tells the client and forwards the accounting packets 2936 

to the CryptoniteNXT ACC node (see your switch’s documentation). 2937 

2.21.2  Configuring CryptoniteNXT for RADIUS 2938 

1. Open the CryptoniteNXT GUI and log in. 2939 
2. Navigate to the CryptoniteNXT Nodes tab.  2940 
3. Click Enable Editing. 2941 
4. Select the Endpoint node, which will have your switch attached to it. 2942 
5. Under Endpoint Node-Specific Configuration, select Strict Access for Access Control. 2943 
6. Select After Delay for the Portal/Whitelist Mode. 2944 
7. Enter -1 for Captive Portal delay. 2945 
8. Enter 5 for the Registration delay.  2946 
9. Select the Gateway node. 2947 

 2948 
10. Click Save. 2949 
11. Navigate to the Integration tab.  2950 
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12. Under Built-In RADIUS Configuration, check the box next to Enable Built-In RADIUS Accounting 2951 
Server. 2952 

 
13. Click the plus button to add the IP of the switch as well as a shared secret. You can use 0.0.0.0/0 2953 

as the IP to accept RADIUS Accounting packets from all IPs, however this is not recommended in 2954 
production. 2955 

2.22  Integration: Backups and GreenTec 2956 

This section details integration between the backup capability and GreenTec WORMdisks. Because 2957 
GreenTec WORMdisks provide write protection for files on the disk, they are an ideal place to store 2958 
important backups. There are a couple options for this integration, but before these backups can be 2959 
replicated onto secure storage, it is important to be able to identify the location of backups to be 2960 
replicated. 2961 

2.22.1  Locate Backups with FileZilla and Duplicati 2962 

1. To locate backups in FileZilla, open the FileZilla Server console. 2963 
2. Click Edit > Users. 2964 
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3. Click Shared folders in the left pane. 2965 

 
4. Under Directories is a list of directories in which the selected user can store backups. The one 2966 

marked H is the default home directory.  2967 
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5. The path to the backups from the home directory is specified in the Path on server field in 2968 
Duplicati (see Section 2.8.6).  2969 

 
6. Each backup should have three associated files. An easy way to determine what files belong 2970 

together is to check the Date Modified field. These files are encrypted. 2971 

2.22.2  Back Up to a GreenTec Disk 2972 

The first, most flexible option involves backing up the backup server to a separate server with GreenTec 2973 
WORMdisks. Simply set up a FileZilla server on the GreenTec storage server and a Duplicati client on 2974 
the backup server (see Section 2.8 for these installation processes). When choosing where to store files 2975 
on FileZilla, indicate a folder on the GreenTec WORMdisk. Sectors of the disk can be locked using the 2976 
mechanism in Section 2.6.4, providing firmware-level write security for any backups in the locked 2977 
sectors.  2978 

There are some considerations when doing this. First, if this is done on a schedule and permanent locks 2979 
are used, space will be consumed quickly and the WORMdisks will need replacements as the space 2980 
cannot be reused. The trade-off between space and backup frequency must be considered–a lower 2981 
backup frequency inevitably means more data loss in the event of a restoration, while higher backup 2982 
frequency increases the cost of maintaining secure storage.  2983 

Alternatively, secure storage can be used for specific types of backups, such as “golden disks”–which 2984 
would contain backups of the basic level of functionality required for the enterprise without necessarily 2985 
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utilizing a backup schedule. This would afford protection for some basic functionality but would forfeit 2986 
the secure storage capability for day-to-day data. 2987 

 2988 

In addition to the options above, there are other ways to minimize wasted space on a GreenTec disk. 2989 
Temporary Locks, or TLocks, can be employed after the data is backed up to a GreenTec disk to protect 2990 
data integrity while making less space unavailable for future use. After the drive is full, a permanent lock 2991 
should still be executed. Wasted space can also be minimized with the use of dynamic partitions, or 2992 
with the Force-Field Write-Once File System, which can also reduce the overhead administration of the 2993 
GreenTec disk. 2994 

2.22.3  Configure Network-Accessible GreenTec Disk 2995 

Another option for GreenTec disks is to make them network accessible. This allows them to be used 2996 
specifically in situations where secure storage protection is desired, and it makes them options for 2997 
backup locations even on servers to which they are not necessarily physically connected.  2998 

1. To configure a GreenTec disk to be network accessible, right-click the disk on the GreenTec 2999 
server.  3000 

 
2. Click Share With > Advanced Sharing.  3001 
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3. Click Advanced Sharing.  3002 
4. Check the box next to Share this folder. 3003 
5. Enter a name for the drive if desired. 3004 
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6. Click OK.  3005 
7. Click Close. 3006 
8. The drive should now be accessible at //SERVER-NAME/X. 3007 

2.22.4  Secure Storage for Semperis ADFR 3008 

1. On the Semperis ADFR server, the default backup location is C:\Semperis. 3009 
2. In this folder there is metadata for the backups (C:\Semperis\ADFR) as well as the backups 3010 

themselves (C:\Semperis\BackupStore). 3011 
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It is important to consider the limitations of the backup software when considering whether to replicate 3012 
backups to secure storage. Ideally, the replication of backups ensures that they can be used on a 3013 
separate server when the original server is affected by an incident. The replication of backups in this 3014 
case can offer some write protection for these specific backup files, but if the entire server is lost, it is 3015 
not guaranteed that the backups will be usable on a new instance of ADFR. This risk can be mitigated by 3016 
exporting the configuration of the ADFR server for the purpose of building a failover ADFR server. 3017 

Though these backups can be replicated to WORMdisks, this is currently not supported by Semperis 3018 
ADFR. Instead, Semperis ADFR offers a different type of “secure storage” by not joining to the domain, 3019 
allowing the machine to be taken offline and brought online only during creation/application of a 3020 
backup. 3021 

2.23  Integration: Micro Focus ArcSight and FileZilla 3022 

In this section an integration between ArcSight and FileZilla is detailed so that logs from FileZilla are 3023 
forwarded to ArcSight by using an ArcSight syslog file connector.  3024 

2.23.1  Enable Logs in FileZilla 3025 

1. On the server with FileZilla installed, open FileZilla Server. 3026 

 
2. Click Edit > Settings. 3027 
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3. Click Logging.  3028 

 
4. Check the box next to Enable logging to file.  3029 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 423 

 
5. Click OK. 3030 

2.23.2  Install Micro Focus ArcSight  3031 

1. Run ArcSight-7.9.0.8084.0-Connector-Win64.exe. 3032 
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2. Click Next. 3033 
3. Enter C:\Program Files\ArcSightSmartConnectors\Windows. 3034 
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4. Click Next.  3035 

 
5. Click Next. 3036 
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6. Click Install. 3037 
7. Select Add a Connector. 3038 

 

8. Click Next. 3039 
9. Select Syslog File.  3040 
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10. Click Next. 3041 
11. Enter C:\Program Files (x86)\FileZilla Server\Logs\FileZilla Server.log for File Absolute Path 3042 

Name. 3043 
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12. Click Next. 3044 
13. Select ArcSight Manager (encrypted).  3045 
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14. Click Next. 3046 
15. Enter the hostname, port, username, and password for the ArcSight ESM server.  3047 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 430 

 
16. Click Next. 3048 
17. Enter identifying details about the system (only Name is required). 3049 
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18. Click Next.  3050 
19. Select Import the certificate to connector from destination. 3051 
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20. Click Next.  3052 
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21. Click Next.  3053 
22. Select Install as a service. 3054 
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23. Click Next.  3055 
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24. Click Next.  3056 
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25. Click Next.  3057 
26. Select Exit. 3058 
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27. Click Next.  3059 
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28. Click Done.  3060 

2.24  Integration: Micro Focus ArcSight and Tripwire 3061 

This section details forwarding logs from Tripwire Log Center to Micro Focus ArcSight. This will forward 3062 
Tripwire IP360 and Tripwire Enterprise logs to ArcSight, assuming those logs are being collected by 3063 
Tripwire Log Center.  3064 

2.24.1  Install Micro Focus ArcSight  3065 

1. Run ArcSight-7.9.0.8084.0-Connector-Win64.exe on any server except the one running Tripwire 3066 
Log Center. 3067 
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2. Click Next. 3068 

 
3. Enter C:\Program Files\ArcSightSmartConnectors\Tripwire. 3069 
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4. Click Next. 3070 

 

5. Click Install. 3071 
6. Select Add a Connector. 3072 
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7. Click Next. 3073 
8. Select Syslog Daemon.  3074 
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9. Click Next. 3075 
10. Enter a port for the daemon to run on. 3076 
11. Select Raw TCP for Protocol. 3077 

 
12. Click Next. 3078 
13. Select ArcSight Manager (encrypted).  3079 
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14. Click Next. 3080 
15. Enter the hostname, port, username, and password for the ArcSight ESM server.  3081 
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16. Click Next. 3082 
17. Enter identifying details about the system (only Name is required). 3083 

 
18. Click Next.  3084 
19. Select Import the certificate to connector from destination. 3085 
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20. Click Next.  3086 

 
21. Click Next.  3087 
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22. Select Install as a service. 3088 

 
23. Click Next.  3089 
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24. Click Next.  3090 

 
25. Click Next.  3091 
26. Select Exit.  3092 
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27. Click Next.  3093 

 

28. Click Done. 3094 
29. Open the Tripwire Log Center Console. 3095 
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30. Go to the Configuration Manager. 3096 

 
31. Select Resources > Managers. 3097 
32. Double-click the Primary Manager. 3098 
33. Click the Advanced Settings tab. 
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34. Click the Add button. 3099 
35. In the Advanced Option box select Log Message Forwarding–Destinations. 3100 
36. In the Value box next to it, type <ip_address>:<port>:tcp with the IP address and port of the 3101 

syslog daemon just created.  3102 

 

37. Click OK. 3103 

 
38. Click OK.  3104 
39. Restart the Tripwire Log Center Manager.  3105 
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2.25  Integration: Micro Focus ArcSight and Cisco WSA 3106 

This integration briefly details how to send logs to an ArcSight syslog collector from Cisco WSA. Please 3107 
see Section 2.24 for instructions for setting up an ArcSight syslog collector. If a server is already 3108 
configured, you do not need to install a new one– simply forward logs to the address of that server. 3109 

2.25.1  Configure Cisco WSA to Forward Logs 3110 

1. In the Cisco WSA web client, navigate to System Administration > Log Subscriptions. 3111 

 
2. Click Add Log Subscription. 3112 
3. Select Access Logs for Log Type. (These are the logs of client web requests that have gone 3113 

through the proxy.) 3114 
4. Enter a name for Log Name. 3115 
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5. Select Syslog Push. 3116 
6. Enter the hostname of the ArcSight syslog collector server. 3117 
7. Select TCP. (Ensure that your syslog collector server is configured to use TCP.) 3118 
8. Enter 8192 or a custom message-size limit. 3119 
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9. Click Submit. 3120 
10. Click Commit Changes. 3121 
11. Enter a comment if desired. 3122 
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12. Click Commit Changes. The server will restart, so the web page connection will be temporarily 3123 

lost. 3124 

2.26  Integration: Micro Focus ArcSight and Cisco ISE 3125 

This integration briefly details how to send logs to an ArcSight syslog collector from Cisco ISE. Please see 3126 
Section 2.24 for instructions for setting up an ArcSight syslog collector. If a server is already configured, 3127 
you do not need to install a new one–simply forward logs to the address of that server. 3128 

2.26.1  Configure Cisco ISE to Forward Logs 3129 

1. In the Cisco ISE web client, navigate to Administration > System > Logging > Remote Logging 3130 
Targets. 3131 
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2. Click Add. 3132 
3. Enter a Name. 3133 
4. Enter the hostname of the ArcSight syslog collector server for Host/IP Address. 3134 
5. Select TCP SysLog for Target Type. (Ensure that your syslog collector server is configured to use 3135 

TCP.) 3136 
6. Enter 514 or the port used on the syslog server. 3137 
7. Enter 8192 or a custom message-size limit for Maximum Length. 3138 
8. Ensure that Status is set to Enabled. 3139 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 456 

 

9. Click Submit. 3140 

 

10. Click Yes. 3141 
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2.26.2  Select Logs for Forwarding 3142 

1. Navigate to System > Logging > Logging Categories. 3143 

 

2. Select a log file to forward to ArcSight. 3144 
3. Click Edit. 3145 

 
4. Move the ArcSight logging target you just created to the Selected box. 3146 
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5. Click Save. 3147 
6. Repeat steps 1–5 for any log files you wish to forward to ArcSight. 3148 

2.27  Integration: Micro Focus ArcSight and Symantec DLP 3149 

This integration briefly details how to send logs to an ArcSight syslog collector from Symantec DLP. If a 3150 
server is already configured, you do not need to install a new one–simply forward logs to the address of 3151 
that server. It is important to note that DLP requires a UDP server, so a TCP syslog server will not work.  3152 

2.27.1  Install Micro Focus ArcSight  3153 

1. Run ArcSight-7.9.0.8084.0-Connector-Win64.exe on any server except the one running Cisco 3154 
Stealthwatch. 3155 
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2. Click Next. 3156 
3. Enter C:\Program Files\ArcSightSmartConnectors\WindowsUDP. 3157 

 
4. Click Next. 3158 
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5. Click Next. 3159 

 
6. Click Install. 3160 
7. Select Add a Connector. 3161 
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8. Click Next. 3162 
9. Select Syslog Daemon.  3163 

 
10. Click Next. 3164 
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11. Enter an unused port on which the daemon can run. (Ensure that this port is allowed through 3165 
the firewall.) 3166 

12. Select UDP for Protocol. 3167 

 
13. Click Next. 3168 
14. Select ArcSight Manager (encrypted).  3169 
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15. Click Next. 3170 
16. Enter the hostname, port, username, and password for the ArcSight ESM server.  3171 

 
17. Click Next. 3172 
18. Enter identifying details about the system (only Name is required). 3173 
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19. Click Next.  3174 
20. Select Import the certificate to connector from destination. 3175 
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21. Click Next.  3176 

 

22. Click Next.  3177 
23. Select Install as a service. 3178 
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24. Click Next.  3179 
25. Enter a service name and display name. 3180 
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26. Click Next.  3181 

 

27. Click Next.  3182 
28. Select Exit.  3183 
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29. Click Next.  3184 

 
30. Click Done. 3185 

2.27.2  Configure Symantec DLP to Forward Logs 3186 

1. Log in to the Symantec DLP web console. 3187 

 
2. Navigate to Manage > Policies > Response Rules. 3188 
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3. Click Add Response Rule. 3189 
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4. Click Next. 3190 
5. Enter a name for the rule. 3191 
6. Set any conditions for sending syslog messages. If you do not add conditions, all incidents will 3192 

be forwarded. 3193 
7. Select Log to a Syslog Server for Actions. 3194 
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8. Click Add Action. 3195 
9. Enter the IP address of the ArcSight syslog server. 3196 
10. Enter the port of the ArcSight syslog UDP server. 3197 
11. Select variables and format a log message to include all the information desired to be sent to 3198 

the ArcSight server. Below is a sample format for the syslog message, which can potentially be 3199 
parsed according to the needs of your organization. 3200 
 3201 
CEF:0|Symantec|DLP|12.0.1|ruleID|$POLICY$|5|BLOCKED=$BLOCKED$ 3202 
DATAOWNER_NAME=$DATAOWNER_NAME$ DATAOWNER_EMAIL=$DATAOWNER_EMAIL$ 3203 
ENDPOINT_DEVICE_ID=$ENDPOINT_DEVICE_ID$ 3204 
ENDPOINT_MACHINE=$ENDPOINT_MACHINE$ PATH=$PATH$ 3205 
FILE_NAME=$FILE_NAME$ PARENT_PATH=$PARENT_PATH$ 3206 
INCIDENT_ID=$INCIDENT_ID$ INCIDENT_SNAPSHOT=$INCIDENT_SNAPSHOT$ 3207 
MATCH_COUNT=$MATCH_COUNT$ RULES=$RULES$ PROTOCOL=$PROTOCOL$ 3208 
QUARANTINE_PARENT_PATH=$QUARANTINE_PARENT_PATH$ 3209 
RECIPIENTS=$RECIPIENTS$ SCAN=$SCAN$ SENDER=$SENDER$ 3210 
SEVERITY=$SEVERITY$ SUBJECT=$SUBJECT$ TARGET=$TARGET$ 3211 
FNAME=$ATTACHMENT_NAME$ 3212 
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12. Click Save. 3213 

2.28  Integration: Micro Focus ArcSight and CryptoniteNXT 3214 

This integration briefly details how to send logs to an ArcSight syslog collector from CryptoniteNXT. 3215 
Please see Section 2.24 for instructions for setting up an ArcSight syslog collector. If a server is already 3216 
configured, you do not need to install a new one– simply forward logs to the address of that server. 3217 
Ensure that you are using a TCP syslog collector. This section assumes that the collector is already under 3218 
CryponiteNXT’s network protection. 3219 

2.28.1  Configure CryptoniteNXT to Forward Logs to ArcSight 3220 

1. Navigate to the Enclave tab in the CryptoniteNXT ACC GUI. 3221 
2. Under SIEM Configuration, check the box next to SIEM is an internal endpoint. 3222 
3. Select the endpoint running the TCP syslog collector. 3223 
4. Enter the port used. 3224 
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5. Click Save. 3225 

2.29  Integration: Micro Focus ArcSight and Semperis DSP 3226 

This integration briefly details how to send logs to an ArcSight syslog collector from Semperis DSP. 3227 
Please see Section 2.24 for instructions for setting up an ArcSight syslog collector. If a server is already 3228 
configured, you do not need to install a new one–simply forward logs to the address of that server. 3229 

Note: This integration requires Semperis DSP version 2.6.  3230 

2.29.1  Configure Semperis DSP to Forward Logs 3231 

1. In Semperis DSP, navigate to Settings > SIEM Integration. 3232 
2. Check the box next to Enable SysLog. 3233 
3. Under Syslog Server, enter the hostname for the ArcSight syslog collector, as well as the port. 3234 
4. Select TCP. 3235 
5. Enter a value for Change Event Polling Frequency based on the needs of your organization– this 3236 

is how often it will poll for new logs to forward.  3237 
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6. Under Change Event Filtering, select AD Changed Items, and Send Operation Log to SysLog. 3238 
Ensure that All is selected for Partitions. 3239 

7. You can also select any specific operations, classes, and attributes to be forwarded or simply 3240 
leave as All. 3241 

 

8. Click Save.  3242 

 
9. Click Close.  3243 

2.30  Integrations: CryptoniteNXT 3244 

For the architecture, it is necessary to create the following source groups. If your organization’s desired 3245 
architecture is different from the one described in this document, it is necessary to adapt the following 3246 
instructions to avoid loss of network or security function. This section will describe the creation of 3247 
source groups and destination groups used in this enterprise. 3248 
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Create the following destination groups and source groups and apply them to the correct endpoints to 3249 
allow these products and integrations to communicate under CryptoniteNXT. 3250 

2.30.1  Active Directory and DNS 3251 

This guide assumes the use of Active Directory and DNS on the same Windows 2012 server. The 3252 
following ports may vary for other products. 3253 

Destination 
Group Name 

Source Group 
Name 

Protocol Port Range 

ad-dns ad-dns-clients TCP 389 
ad-dns ad-dns-clients UDP 389 
ad-dns ad-dns-clients UDP 53 
ad-dns ad-dns-clients TCP 88 
ad-dns ad-dns-clients UDP 88 
ad-dns ad-dns-clients TCP 25 
ad-dns ad-dns-clients TCP 42 
ad-dns ad-dns-clients TCP 137 
ad-dns ad-dns-clients TCP 139 
ad-dns ad-dns-clients TCP 53 
ad-dns ad-dns-clients TCP 636 
ad-dns ad-dns-clients TCP 3268:3269 
ad-dns ad-dns-clients TCP 445 
ad-dns ad-dns-clients UDP 445 
ad-dns ad-dns-clients TCP 9389 
ad-dns ad-dns-clients TCP 5722 
ad-dns ad-dns-clients TCP 464 
ad-dns ad-dns-clients UDP 464 
ad-dns ad-dns-clients UDP 123 
ad-dns ad-dns-clients UDP 137:138 
ad-dns ad-dns-clients UDP 67 
ad-dns ad-dns-clients UDP 2535 
ad-dns ad-dns-clients UDP 49152:65535 
ad-dns ad-dns-clients TCP 49152:65535 
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Endpoint  Source Groups Destination Groups 
(all endpoints that need access 
to AD/DNS) 

ad-dns-clients  

AD/DNS server  ad-dns 
 

2.30.2  Microsoft Exchange 3254 

This guide assumes the use of Microsoft Exchange. The following ports may vary for other products. 3255 

Destination 
Group Name 

Source Group 
Name 

Protocol Port Range 

exchange exchange-clients TCP 443 
exchange exchange-clients TCP 80 
exchange exchange-clients TCP 25 
exchange exchange-clients TCP 379 
exchange exchange-clients TCP 3268:3269 
exchange exchange-clients TCP 636 
exchange exchange-clients TCP 143 
exchange exchange-clients TCP 993 
exchange exchange-clients TCP 110 
exchange exchange-clients TCP 995 
exchange exchange-clients TCP 119 
exchange exchange-clients TCP 563 
exchange exchange-clients TCP 465 
exchange exchange-clients TCP 443691 
exchange exchange-clients TCP 102 
exchange exchange-clients TCP 135 
exchange exchange-clients TCP 389:390 
exchange exchange-clients TCP 53 
exchange exchange-clients UDP 53 
exchange exchange-clients TCP 2525 
exchange exchange-clients TCP 475 
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Endpoint  Source Groups Destination Groups 
MS Exchange exchange-clients exchange 
(all email clients) exchange-clients  
AD/DNS server exchange-clients  

 

2.30.3  FileZilla  3256 

The default port for FileZilla is 21. 3257 

1. To determine the ports being used for your instance, open the FileZilla console. 3258 
2. Navigate to Edit > Settings > General Settings > Listen on these ports, and allow any ports listed 3259 

here. 3260 
3. If your server listens in passive mode, navigate to Edit > Settings > Passive mode settings > Use 3261 

custom port range, and allow any ports listed here. 3262 
Destination 
Group Name 

Source Group 
Name 

Protocol Port Range 

FileZilla BackupClients TCP 21 (default–see instructions) 
FileZilla BackupClients TCP 51120-511230 (passive mode–see instructions) 

 

Endpoint  Source Groups Destination Groups 
(any endpoints that need to 
perform backups) 

BackupClients  

FileZilla server  FileZilla 
 

2.30.4  GreenTec 3263 

If GreenTec is configured to use a FileZilla server, refer to the above section. If GreenTec is configured to 3264 
use Windows Network Share, see below for ports required. 3265 

Destination 
Group Name 

Source Group 
Name 

Protocol Port Range 

NetworkShare GreenTecClients TCP 80 
NetworkShare GreenTecClients TCP 135-139 
NetworkShare GreenTecClients TCP 445 
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Endpoint  Source Groups Destination Groups 
(any endpoints that need access 
to GreenTec disks) 

GreenTecClients  

GreenTec server  NetworkShare 
 

2.30.5  Tripwire Enterprise 3266 

In Tripwire, the Axon Bridge is used for Tripwire Enterprise to contact endpoints. Therefore, the port 3267 
5670 must be allowed on endpoints to allow TE to initiate communications. Furthermore, TE requires 3268 
MSSQL to function, so it must be granted access to that as well. 3269 

Destination Group 
Name 

Source Group 
Name 

Protocol Port Range 

TripwireEnterprise TEClients TCP 443 
TripwireEnterprise TEClients TCP 8080 
TripwireEnterprise TEClients TCP 9898 
TripwireEnterprise TEClients TCP 1169 
TEAxon TripwireE TCP 5670 
MSSQL MSSQLClients TCP 1433 

 

Endpoint  Source Groups Destination Groups 
(any endpoints that need to be 
monitored by Tripwire 
Enterprise) 

TEClients TEAxon 

Tripwire Enterprise server TripwireE, MSSQLClients TripwireEnterprise 
MSSQL server  MSSQL 

 

2.30.6  ArcSight ESM 3270 

Destination 
Group Name 

Source Group 
Name 

Protocol Port Range 

ArcSight ArcSightConnectors TCP 8443 
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Endpoint  Source Groups Destination Groups 
(any endpoints with an ArcSight 
Connector installed) 

ArcSightConnectors  

ArcSight ESM server  ArcSight 
 

2.30.7  Cisco ISE 3271 

Please see the CryptoniteNXT Generic RADIUS Integration Guide for instructions on how ISE should be 3272 
integrated with CryptoniteNXT. 3273 

To access the web console for ISE, allow port 443 for any machines that should be able to access the ISE 3274 
administrative console.  3275 

To access the portal for ISE, allow port 8443 (default) for any machines that will need to access the 3276 
portal. You can find this value by looking at your portal configuration in ISE. 3277 

Furthermore, if RADIUS is configured for the posture integration, you will need to add any ports used in 3278 
RADIUS for both ISE and the internal switch. The default for these is 1812 (Authentication), 1813 3279 
(Accounting), and 1700 (CoA). RADIUS can be TCP or UDP, so you can restrict this to your organization’s 3280 
configuration. 3281 

Destination 
Group Name 

Source Group Name Protocol Port Range 

ISE ISEConsole TCP 443 
ISE ISEClients TCP 8443 
radius ISESwitch, ISEServer TCP 1812 
radius ISESwitch, ISEServer UDP 1812 
radius ISESwitch, ISEServer TCP 1813 
radius ISESwitch, ISEServer UDP 1813 
radius ISESwitch, ISEServer TCP 1700 
radius ISESwitch, ISEServer UDP 1700 

 

Endpoint  Source Groups Destination Groups 
(any endpoints that need to do 
posture under ISE) 

ISEClients  



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 480 

(any endpoints that need to 
access the ISE web console) 

ISEConsole  

ISE server ISEServer ISE, radius 
(internal switches or RADIUS 
servers used for ISE Posture) 

ISESwitch, ISEClients radius 

Cryptonite ACC Node  radius 

2.30.8  Semperis DSP 3282 

Semperis DSP recommends allowing full network access during the initial database sync. After that, the 3283 
following ports should be left open for communication. 3284 

Destination 
Group Name 

Source Group 
Name 

Protocol Port Range 

dsp dsp-admin TCP 443 
dsp dsp-agents TCP 8903 
dsp dsp-agents TCP 135 
dsp dsp-agents TCP 445 
dsp dsp-agents TCP 1024:1034 
ad-dsp dsp-client TCP 8772 
ad-dsp dsp-client TCP 8750 
ad-dsp dsp-client ICMP 0:255 

 

Endpoint  Source Groups Destination Groups 
(any endpoints that need admin 
access to DSP) 

dsp-admin  

Semperis DSP ad-dns-clients, dsp-client, 
exchange-clients 

dsp 

Active Directory server dsp-agents ad-dsp 
 

2.30.9  Symantec DLP 3285 

This largely depends on how distributed the setup of DLP is. See here for a list of ports required by 3286 
Symantec DLP: https://support.symantec.com/us/en/article.tech220846.html. 3287 

https://support.symantec.com/us/en/article.tech220846.html
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For this build, we used a single server that contained the database, so only the agents and 3288 
administrative clients needed to be allowed to communicate through Cryptonite.  3289 

Destination 
Group Name 

Source Group 
Name 

Protocol Port Range 

dlp dlp-admin TCP 443 
dlp dlp-clients TCP 10443 

 

2.30.10 Cisco WSA 3290 

WSA uses a proprietary command line, which means it does not have a way of authenticating to the 3291 
CryptoniteNXT portal. For devices such as this, there are two options.  3292 

1. The device can be left outside CryptoniteNXT. 3293 

2. The device can be placed under CryptoniteNXT on a CryptoniteNXT Endpoint Node with the 3294 
portal disabled.  3295 

To prevent MAC spoofing, by default Cryptonite pins MAC addresses to the port + VLAN (Virtual LAN) to 3296 
which a device is connected, so a malicious device connecting to the end-point node with the same 3297 
MAC as an already connected IP360 would still be required to authenticate. Physical security for the 3298 
end-point node can further mitigate concerns about MAC spoofing. 3299 

If you can find a way to authenticate WSA to CryptoniteNXT or decide to use the disabled portal option 3300 
with strong physical security, we provide the ports below for integration. 3301 

To access the web console for WSA, allow port 8080 for any machines that should be able to access the 3302 
ISE administrative console.  3303 

To access the proxy, allow port 80 and port 3128 for any machines that will need to go through the 3304 
proxy, which will likely be most clients in the enterprise. Port 80 is for the wpad.dat file, and port 3128 3305 
is for the proxy itself. 3306 

Destination 
Group Name 

Source Group Name Protocol Port Range 

wsa wsa-clients TCP 80 
wsa wsa-clients TCP 3128 
wsa wsa-admin TCP 8080 
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Endpoint  Source Groups Destination Groups 
(any endpoints that need to use 
the proxy to connect to the 
internet) 

wsa-clients  

(any endpoints that need to 
access the WSA web console) 

wsa-admin  

Cisco WSA  wsa 
 

2.30.11 Tripwire IP360 3307 

IP360 uses a proprietary command line, which means it does not have a way of authenticating to the 3308 
CryptoniteNXT portal. For devices such as this, there are two options.  3309 

3. The device can be left outside CryptoniteNXT. 3310 
4. The device can be placed under CryptoniteNXT on a CryptoniteNXT Endpoint Node with the 3311 

portal disabled.  3312 
To prevent MAC spoofing, by default Cryptonite pins MAC addresses to the port+VLAN to which a 3313 
device is connected, so a malicious device connecting to the end-point node with the same MAC as an 3314 
already connected IP360 would still be required to authenticate. Physical security for the end-point 3315 
node can further mitigate concerns about MAC spoofing. 3316 

If you can find a way to authenticate IP360 to CryptoniteNXT or decide to use the disabled portal option 3317 
with strong physical security, we provide the ports below for integration. 3318 

To access the web console for IP360, allow port 443 for any machines that should be able to access the 3319 
IP360 administrative console. 3320 

IP360 should have access to all ports of the client machines it needs to scan. Another option is to simply 3321 
add IP360 to all the source groups present in your enterprise, and it will give an overview of the 3322 
vulnerabilities of clients on ports that CryptoniteNXT is not actively protecting. Alternatively, you can 3323 
disable policy enforcement temporarily on the CryptoniteNXT Endpoint Node to which IP360 is 3324 
connected, but you should do this only during scans.  3325 

Destination 
Group Name 

Source Group Name Protocol Port Range 

ip360 ip360admin TCP 443 
scantarget ip360scanner TCP 1:65535 



DRAFT 

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 483 

scantarget ip360scanner UDP 1:65535 
scantarget ip360scsanner ICMP 0:255 

 

Endpoint  Source Groups Destination Groups 
(any endpoints need to access 
the IP360 web console) 

ip360admin  

(any endpoints to be fully 
scanned by IP360) 

 scantarget 

IP360 ip360scanner ip360 
 

2.30.12 Tripwire Log Center, Tripwire IP360, Tripwire Enterprise, and ArcSight ESM 3326 

The guide details an integration among Tripwire IP360, Tripwire Enterprise, Tripwire Log Center, and 3327 
ArcSight ESM. This section describes the ports needed to allow the integrations through Cryptonite. 3328 

First, traffic must be allowed from Tripwire Log Center to the MSSQL server. To do this, ensure that 3329 
Tripwire Log Center can access 1433 on the MSSQL server. (Note: Tripwire Enterprise also has access to 3330 
this port, as described above in the Tripwire Enterprise section.) 3331 

Then traffic from Tripwire Enterprise to Tripwire Log Center should be allowed on ports 8091 and 1468. 3332 

Traffic from IP360 to Tripwire Log Center should be allowed on port 22 for the SFTP (Secure FTP) 3333 
transfer. Also, traffic from Tripwire Log Center to 5670 on Tripwire IP360 should be allowed. If you 3334 
chose to leave IP360 out of the Cryptonite NXT enclave, Tripwire Log Center will need to be able to 3335 
reach it externally. 3336 

Traffic from Tripwire Log Center to the machine containing the ArcSight TCP syslog container should be 3337 
allowed on the port configured (in the guide, we use port 514). As a last note, the server running the 3338 
ArcSight syslog connector requires an IP and not a hostname for its integration with Tripwire Log 3339 
Center–you must set a static IP for the connector server in Cryptonite and enter this IP in the 3340 
appropriate place in Tripwire Log Center’s configuration. 3341 

Destination Group 
Name 

Source Group Name Protocol Port Range 

MSSQL MSSQLClients TCP 1443 
TLC TLCClients TCP 8091 
TLC TLCClients TCP 1468 
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TLC TLCClients TCP 22 
ArcSightTCPSysConn TCPSysClients TCP 514 
ip360 ip360admin TCP 5670 

 

Endpoint  Source Groups Destination Groups 
Tripwire Log Center TCPSysClients, MSSQLClients, 

ip360admin 
TLC 

Tripwire Enterprise TLCClients  
(server running ArcSight TCP 
syslog connector) 

 ArcSightTCPSysConn 

MSSQL  MSSQL 
IP360 TLCClients ip360 

 

2.30.13 FileZilla and ArcSight 3342 

The guide details an integration between FileZilla and ArcSight ESM to forward logs from FileZilla to 3343 
ArcSight. This section describes the ports needed to allow the integrations through Cryptonite. 3344 

Because this integration involves the use of an ArcSight Connector directly on the FileZilla server, only 3345 
one port is needed. The FileZilla server should be able to directly communicate with 8443 on the 3346 
ArcSight ESM server. 3347 

Destination 
Group Name 

Source Group Name Protocol Port Range 

ArcSight ArcSightConnectors TCP 8443 
 

Endpoint  Source Groups Destination Groups 
FileZilla ArcSightConnectors  
ArcSight ESM  ArcSight 

 

2.30.14 Cisco ISE and ArcSight 3348 

The guide details an integration between Cisco ISE and ArcSight ESM to forward logs from ISE to 3349 
ArcSight. This section describes the ports needed to allow the integrations through Cryptonite.  3350 
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Traffic from Cisco ISE to the machine containing the ArcSight TCP syslog container should be allowed on 3351 
the port configured (in the guide, we use port 514).  3352 

Destination Group 
Name 

Source Group Name Protocol Port Range 

ArcSightTCPSysConn TCPSysClients TCP 514 
 3353 

Endpoint  Source Groups Destination Groups 
Cisco ISE TCPSysClients  
(server running ArcSight TCP 
syslog connector) 

 ArcSightTCPSysConn 

 3354 

2.30.15 Cisco WSA and ArcSight 3355 

The guide details an integration between Cisco WSA and ArcSight ESM to forward logs from WSA to 3356 
ArcSight. This section describes the ports needed to allow the integrations through Cryptonite.  3357 

Traffic from Cisco WSA to the machine containing the ArcSight TCP syslog container should be allowed 3358 
on the port configured (in the guide, we use port 514).  3359 

Destination Group 
Name 

Source Group Name Protocol Port Range 

ArcSightTCPSysConn TCPSysClients TCP 514 
 3360 

Endpoint  Source Groups Destination Groups 
Cisco WSA TCPSysClients  
(server running ArcSight TCP 
syslog connector) 

 ArcSightTCPSysConn 

 3361 

2.30.16 Semperis DSP and ArcSight 3362 

The guide details an integration between Semperis DSP and ArcSight ESM to forward logs from DSP to 3363 
ArcSight. This section describes the ports needed to allow the integrations through Cryptonite.  3364 
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Traffic from Semperis DSP to the machine containing the ArcSight TCP syslog container should be 3365 
allowed on the port configured (in the guide, we use port 514).  3366 

Destination Group 
Name 

Source Group Name Protocol Port Range 

ArcSightTCPSysConn TCPSysClients TCP 514 
 3367 

Endpoint  Source Groups Destination Groups 
Semperis DSP TCPSysClients  
(server running ArcSight TCP 
syslog connector) 

 ArcSightTCPSysConn 

 3368 

2.30.17 Symantec DLP and ArcSight 3369 

The guide details an integration between Symantec DLP and ArcSight ESM to forward logs from DLP to 3370 
ArcSight. This section describes the ports needed to allow the integrations through Cryptonite.  3371 

Traffic from Symantec DLP to the machine containing the ArcSight UDP syslog container should be 3372 
allowed on the port configured (in the guide, we use UDP and port 6514).  3373 

Destination Group 
Name 

Source Group Name Protocol Port Range 

ArcSightTCPSysConn TCPSysClients UDP 6514 
 3374 

Endpoint  Source Groups Destination Groups 
Symantec DLP TCPSysClients  
(server running ArcSight TCP 
syslog connector) 

 ArcSightTCPSysConn 
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Appendix A–List of Acronyms 3375 

ACC Administration Control Center 
AD Active Directory 
ADFR Active Directory Forest Recovery 
CoA Change of Authorization 
DHCP Dynamic Host Configuration Protocol 
DNS  Domain Name System 
DSP Directory Services Protector 
ESM Enterprise Security Manager 
FTP File Transfer Protocol 
FTPS File Transfer Protocol over TLS 
GUI Graphical User Interface 
IIS Internet Information Services 
ISE Identity Services Engine 
IT Information Technology 
JCE Java Cryptography Extension 
JRE Java Runtime Environment 
LAN Local Area Network 
MSSQL Microsoft SQL 
NAT Network Address Translation 
NCCoE National Cybersecurity Center of Excellence 
NIST National Institute of Standards and Technology 
OS Operating System 
PAC Proxy Auto Config 
RADIUS Remote Authentication Dial-In User Service 
SFTP Secure FTP 
SNMP Simple Network Management Protocol 
TE Tripwire Enterprise 
TLC Tripwire Log Center 
VLAN Virtual LAN 
WDV WORM Disk Volume 
WORM Write Once Read Many 
WPAD Web Proxy Auto Discovery 
WSA Web Security Appliance 
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